Data Analysis Software
for VISION™, BioCAD® 700E, SPRINT™, and INTEGRAL® Workstations
Version 3 Series Software

User Guide
# Table of Contents

## How to Use This Guide

## Chapter 1  Overview of Applied Biosystems Data Analysis

1.1 Applied Biosystems Data Analysis Software ........................................... 1-2  
1.2 File Structure and Contents ...................................................................... 1-4  
   1.2.1 Contents of a Method File (.MET) .................................................. 1-6  
   1.2.2 Contents of a Data File (.B*) ...................................................... 1-7  
   1.2.3 File Naming Conventions .............................................................. 1-8  
   1.2.4 Guidelines for Accessing Files in the Data Analysis Module ....... 1-9  
1.3 Software Overview .................................................................................. 1-10  
1.4 Changes to Version 3.0 Software .......................................................... 1-13  
1.5 Differences from Turbochrom Software ................................................. 1-16  

## Chapter 2  Viewing and Comparing Chromatograms

2.1 Overview of Group Analysis ...................................................................... 2-2  
2.2 Opening, Creating, and Editing a Group File ........................................ 2-6  
2.3 Comparing Chromatograms .................................................................... 2-14  
   2.3.1 Tiled Mode .................................................................................. 2-14  
   2.3.2 Overlay Mode ............................................................................. 2-16  
   2.3.3 Stacked Mode ............................................................................. 2-18  
2.4 Using the Group Analysis Window ........................................................... 2-20  
2.5 Printing Chromatograms and Reports ..................................................... 2-24  
2.6 Viewing the Method ............................................................................... 2-25  
2.7 Viewing the Event Log for Data Files .................................................... 2-27  
2.8 Using Group Subtract ............................................................................ 2-28
# Table of Contents

## Chapter 3  Viewing Results of Automated Analysis

3.1 Overview ......................................................................................... 3-2  
3.2 Data Files Generated by Automated Analysis ................................. 3-2  
3.3 Viewing the Results of an Automated Analysis ............................... 3-5  
   3.3.1 Viewing Preparative Method Results ....................................... 3-5  
   3.3.2 Viewing Analytical Method Results ....................................... 3-7

## Chapter 4  Analyzing Data

4.1 Overview of Analyzing................................................................. 4-2  
4.2 Before You Analyze ..................................................................... 4-3  
4.3 Background Analyzing .............................................................. 4-8  
   4.3.1 Specifying Automatic Analyzing and Printing in the Method Editor 4-9  
   4.3.2 Analyzing Data Files in Group Analysis ................................ 4-11  
   4.3.3 Analyzing and Printing in the Control Panel.......................... 4-14  
4.4 Interactive Viewing and Analyzing .............................................. 4-16  
4.5 Generating Calibration Curves and Quantitating Unknowns ............. 4-21  
   4.5.1 General Procedure............................................................... 4-22  
   4.5.2 Adjusting Processing Parameters ........................................ 4-24  
   4.5.3 Entering Component Information........................................ 4-25  
   4.5.4 Analyzing Standards and Generating Result Files (.RST) ......... 4-27  
   4.5.5 Adjusting Global Calibration Parameters .............................. 4-28  
   4.5.6 Entering Calibration Levels and Component Amounts .......... 4-30  
   4.5.7 Associating Areas With Levels and Generating Calibration Curves ............................................. 4-32  
   4.5.8 Adjusting Report Format to Include Calibration Information .. 4-37  
   4.5.9 Creating a Method File (.MET) to Acquire Unknowns .......... 4-40  
   4.5.10 Running and Quantitating Unknowns ................................... 4-42
### Table of Contents

7.5.3 Reference Components .......................................................... 7-21  
7.5.4 Internal Standard Components .............................................. 7-23  
7.5.5 Response Options ...................................................................... 7-23  
7.5.6 Calibration Types ........................................................................ 7-24  
7.5.7 Selecting Fit Parameters .......................................................... 7-25  

7.6 Setting Component Defaults .......................................................... 7-28  
7.7 Adding and Editing Components .................................................. 7-39  
7.7.1 Adding a Component .............................................................. 7-42  
7.7.2 Editing a Component .............................................................. 7-53  

7.8 Loading and Merging Components From Files ............................. 7-54  
7.9 Deleting Components ..................................................................... 7-57  
7.10 Changing Parameters for Multiple Components Simultaneously .... 7-58  
7.11 Performing a Manual Calibration ............................................... 7-61

### Chapter 8 Adjusting Report Format Parameters

8.1 Overview of Report Format Parameters ........................................ 8-2  
8.2 Adjusting Report Format Parameters ........................................... 8-4  
8.3 Creating Title, Header, and Footer Text ........................................ 8-10  
8.4 Setting Up Report Columns ....................................................... 8-12  
8.4.1 Adding and Deleting Columns ................................................. 8-12  
8.4.2 Editing Column Information .................................................. 8-16  
8.4.3 Moving Columns ..................................................................... 8-17  
8.4.4 Creating a Custom Expression Data Column............................ 8-18  

8.5 Editing Report Format Options ..................................................... 8-23  
8.6 Printing Report Format Files ....................................................... 8-28

### Chapter 9 Adjusting Analysis Parameters Graphically

9.1 Overview of Analysis Parameters and Graphic Editing ..................... 9-2  
9.2 Adjusting Analysis (Processing and Calibration) Parameters  
Graphically ........................................................................ 9-3  
9.3 Understanding the Graphic Method Editor Window ....................... 9-10
Table of Contents

9.4 Changing Display Options ........................................................ 9-12
  9.4.1 Changing the Plot Display .................................................. 9-13
  9.4.2 Changing the Plot Scale ................................................... 9-15
  9.4.3 Expanding Chromatograms .............................................. 9-16
  9.4.4 Manipulating the Reference Chromatogram ......................... 9-22
  9.4.5 Hiding or Showing the Reference Chromatogram ................. 9-23

9.5 Adjusting Processing Parameters .............................................. 9-24
  9.5.1 Setting Baseline Timed Events ....................................... 9-24
  9.5.2 Setting Noise and Area Thresholds .................................. 9-29
  9.5.3 Setting a New Bunching Factor ...................................... 9-31
  9.5.4 Changing Peak Separation and Exponential Skim Criteria ... 9-34
  9.5.5 Drawing the Baseline Manually ...................................... 9-37

9.6 Working with Components ........................................................ 9-39
  9.6.1 Creating a Component List From a Peak List ....................... 9-40
  9.6.2 Editing Component Information ....................................... 9-43
  9.6.3 Adding and Editing Single Peak Components ....................... 9-45
  9.6.4 Re-Identifying Peaks .................................................... 9-49
  9.6.5 Creating and Editing Named And Timed Groups ................... 9-50
  9.6.6 Displaying Search Windows ........................................... 9-57
  9.6.7 Updating Calibration Information .................................. 9-60

9.7 Displaying and Printing Information ........................................ 9-61
  9.7.1 Printing a Report or Replot .......................................... 9-64
  9.7.2 Printing Method Information ......................................... 9-66
  9.7.3 Copying Information to the Clipboard ............................. 9-67

Chapter 10 Performing a Fit Analysis

  10.1 What is Fit Analysis? ....................................................... 10-2
  10.2 The Fit Analysis Window .................................................. 10-3
  10.3 Viewing the Calibration Curve .......................................... 10-9
Table of Contents

10.4 Changing the Calibration Curve Display ........................................ 10-11
  10.4.1 Setting Limits for the Calibration Curve .......................... 10-11
  10.4.2 Changing Calibration Curve Labels ............................... 10-12

10.5 Changing Fit Parameters ............................................................ 10-14
  10.5.1 Changing the Scaling Factor ............................................. 10-14
  10.5.2 Fitting and Weighting the Calibration Curve ................. 10-16
  10.5.3 Displaying Curve Information ........................................... 10-19

10.6 Solving For New Amounts and Responses ................................. 10-20

10.7 Using the Data List Spreadsheet ............................................. 10-22
  10.7.1 Editing Calibration Data in the Data List Dialog Box ........ 10-24
  10.7.2 Inserting a Row in the Spreadsheet .............................. 10-24
  10.7.3 Appending a Row to the Spreadsheet ............................ 10-24
  10.7.4 Copying Rows in a Spreadsheet .................................. 10-25
  10.7.5 Deleting Rows from a Spreadsheet .............................. 10-25
  10.7.6 Entering Repeating Values ........................................ 10-26
  10.7.7 Closing the Data List Dialog Box .................................. 10-26

10.8 Printing and Plotting Calibration Data .................................... 10-27

10.9 Saving Calibration Data to the Clipboard ............................. 10-28

Appendix A Discussion of Data Analysis

A.1 What is Data Analysis? ................................................................. A-2
A.2 Overview of the Steps in Data Analysis .................................. A-3
A.3 Peak Detection ........................................................................ A-5
  A.3.1 Peak Detection Parameters ........................................... A-5
  A.3.2 The Stages in Peak Detection ......................................... A-10
  A.3.3 How Timed Events Affect Peak Detection ..................... A-16
    A.3.3.1 The Bunching Factor, Noise Threshold, and Area
    Threshold Events ......................................................... A-16
    A.3.3.2 Bunching Factor Event ....................................... A-17
    A.3.3.3 Noise Threshold Event ..................................... A-17
    A.3.3.4 Area Threshold Event ...................................... A-18
# Table of Contents

A.3.3.5 Disable/Enable Peak Detection (–P/+P) ............ A-18  
A.3.3.6 Enable/Disable Negative Peak Detection (+N/−N) .......................................................... A-20  
A.3.3.7 Inhibit/Allow End-of-Peak Detection (+I/−I) .... A-23  
A.3.3.8 Locate Maximum Event .................................. A-24  
A.3.3.9 Retention Time and User Forced Peak Events .. A-25  
A.3.3.10 Smooth Peak Ends Event................................. A-26  

A.4 Integration .................................................................................................... A-28  
A.4.1 Baselines Within Clusters ................................................................. A-28  
A.4.2 Adjustment of Preliminary Baselines ............................................... A-28  
A.4.2.1 Baseline Penetration by Chromatogram Valleys ......................................... A-29  
A.4.2.2 Baseline Penetration at the Start or End of a Cluster ................................. A-30  

A.4.3 Peak Areas .......................................................................................... A-31  
A.4.4 Area Adjustment .................................................................................. A-32  
A.4.5 How Timed Events Affect Integration.................................................. A-38  
A.4.5.1 Force/Discontinue Common Baseline (+CB/−CB)........................................ A-38  
A.4.5.2 Force/Discontinue Valley-to-Valley Baselines (+V/−V).................................. A-40  
A.4.5.3 Force Baseline to Point (BL).......................................................... A-42  
A.4.5.4 Force/Discontinue Horizontal Baseline Forward (+HF/−HF) .......................... A-45  
A.4.5.5 Force Horizontal Baseline Backward (HR) ................ A-49  
A.4.5.6 End Peak Now (E) ........................................................................ A-51  
A.4.5.7 Start Peak (S)............................................................................. A-53  
A.4.5.8 Start Manual Integration/End Manual Integration (+M/−M) ......................... A-55  
A.4.5.9 Force Exponential Skim (+X).................................................. A-55  
A.4.5.10 Prevent Exponential Skim (−X)............................................. A-56  
A.4.5.11 Tangential Skim (T) ..................................................................... A-56
Table of Contents

A.4.6 Calculation of Peak Height and Retention Times ................. A-58
A.5 Component Identification .......................................................... A-59
A.5.1 Overlapping Search Windows ............................................. A-59
A.5.2 Optimizing Component Identification ................................. A-60
A.6 Calibration .................................................................................. A-61
A.6.1 Calibration Levels ............................................................... A-62
A.6.2 Calibration Curves .............................................................. A-63
    A.6.3.1 External Standard Method .......................................... A-67
    A.6.3.2 Internal Standard Method ........................................ A-69
A.6.4 Retention Time Data ............................................................ A-71
A.6.5 Computation of the Calibration Curve ................................. A-72
A.7 Quantitation .............................................................................. A-76
A.7.1 Calculation of Initial Component Amounts ......................... A-78
A.7.2 Reversal of Scaling Options ................................................ A-85
A.7.3 Conversion of Amount Ratios to Raw Amounts ................... A-86
A.7.4 Computation of Adjusted Amounts ................................. A-87
A.7.5 Quantitation of Unidentified Peaks .................................... A-87

Appendix B Technical Support and Training

B.1 Contacting Technical Support .................................................... B-2
B.2 Obtaining Technical Documents ................................................ B-8
B.3 Obtaining Customer Training Information ............................. B-10

Glossary

Index
How to Use This Guide

**Purpose**  
*Applied Biosystems Data Analysis User’s Guide* details the procedures for using the Applied Biosystems Data Analysis software provided with your VISION™, BioCAD® 700E, SPRINT™, or INTEGRAL® 100Q Workstation.

**Audience**  
This guide is intended for novice and experienced users who are analyzing and reporting data collected on a VISION, BioCAD 700E, SPRINT, or INTEGRAL 100Q Workstation.

**Structure**  
*Applied Biosystems Data Analysis User’s Guide* is divided into ten chapters and one appendix. Each chapter page is marked with a tab and a header to help you locate information within the chapter.

The table below describes the material covered in each chapter.

<table>
<thead>
<tr>
<th>Chapter 1, Overview of Applied Biosystems Data Analysis</th>
<th>Describes Applied Biosystems Data Analysis software and the associated file structure and contents.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 2, Viewing and Comparing Chromatograms</td>
<td>Describes how to use the Group Analysis module to view and compare multiple chromatograms, print chromatograms, and view method and event information associated with the data.</td>
</tr>
<tr>
<td>Chapter 3, Viewing Results of Automated Analysis</td>
<td>Describes the types of files generated by the Automated Analysis feature, and how to view results.</td>
</tr>
</tbody>
</table>

*Continued*
### How to Use This Guide

<table>
<thead>
<tr>
<th>Chapter 4, Analyzing Data</th>
<th>Describes how to analyze data files and groups of data files. Describes how to create calibration curves and quantitate unknowns.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 5, Exporting Data</td>
<td>Describes how to use the Group Analysis module to export data to Microsoft® Excel.</td>
</tr>
<tr>
<td>Chapter 6, Adjusting Processing Parameters</td>
<td>Describes how to use the Text Method Editor to change processing parameters.</td>
</tr>
<tr>
<td>Chapter 7, Adjusting Calibration Parameters</td>
<td>Describes how to use the Text Method Editor to change calibration parameters.</td>
</tr>
<tr>
<td>Chapter 8, Adjusting Report Format Parameters</td>
<td>Describes how to use the Report Format Editor to change report format parameters.</td>
</tr>
<tr>
<td>Chapter 9, Adjusting Analysis Parameters Graphically</td>
<td>Describes how to use the Graphic Method Editor to change analysis parameters (processing and calibration) by manipulating a chromatogram interactively.</td>
</tr>
<tr>
<td>Chapter 10, Performing a Fit Analysis</td>
<td>Describes how to plot the calibration curve for any component that has amount and response data.</td>
</tr>
<tr>
<td>Appendix A, Discussion of Data Analysis</td>
<td>Explains how the Data Analysis software uses the analysis parameters to analyze raw data.</td>
</tr>
<tr>
<td>Appendix B, Technical Support and Training</td>
<td>Provides information on how to contact Technical Support, obtain Technical Documents and obtain customer training information</td>
</tr>
</tbody>
</table>
Conventions

This guide uses the following conventions to make text easier to understand.

General conventions

The following general conventions are used:

- **Bold** text indicates user action:
  
  “Type 0 and press Enter for the remaining fields.”

- **Italic** text denotes new or important words, and is also used for emphasis:
  
  “Prior to operation, *always* check for eluent miscibility.”

Notes, Hints, Cautions, and Warnings

Notes, Hints, Cautions, and Warnings are used as follows:

- A note calls out important information to the user:

  **NOTE:** Record your result before proceeding with the next step.

- A hint provides helpful suggestions not essential to the use of the product:

  **Hint:** Use Heat/Mix segments after Dilute segments to produce a uniform mixture.

- A caution calls out information to avoid damage to the system or equipment:

  **CAUTION**

  *Do not touch the flow cell window. This may damage the flow cell.*

- A warning calls out information essential to the safety of the user:

  **WARNING**

  *Always observe safe laboratory practices when operating your system.*
How to Use This Guide

Related documentation

Use the Data Analysis User’s Guide in conjunction with the appropriate documents provided with your system:

- **Applied Biosystems VISION Workstation User’s Guide and Getting Started Guide**—Use these guides to learn how to set up, and configure your system, prepare your system for operation, create methods and templates, and acquire data.

- **Applied Biosystems BioCAD 700E Workstation User’s Guide and Getting Started Guide**—Use these guides to learn how to set up, and configure your system, prepare your system for operation, create methods and templates, and acquire data.

- **Applied Biosystems SPRINT System User’s Guide and Getting Started Guide**—Use these guides to learn how to set up, and configure your system, prepare your system for operation, create methods and templates, and acquire data.

- **Applied Biosystems INTEGRAL 100Q System User’s Guide and Getting Started Guide**—Use these guides to learn how to set up, and configure your system, prepare your system for operation, create methods and templates, and acquire data.

- **Applied Biosystems COBRA™ Robotic Sample Handling Device User’s Guide**—Use this guide to learn how to connect, configure, and use your COBRA Robotic Sample Handling Device.

- **Microsoft® Excel User’s Guide** and related documents—Use these documents to learn how to use the Microsoft Excel software after you export data from the Data Analysis software.

Send us your comments

We welcome your comments and suggestions for improving our manuals. You can email us your comments at:

TechPubs@appliedbiosystems.com
Overview of Applied Biosystems Data Analysis

This chapter includes the following sections:

1.1 Applied Biosystems Data Analysis Software ................................................ 1-2
1.2 File Structure and Contents .............................. 1-4
1.3 Software Overview ................................... 1-10
1.4 Changes to Version 3.0 Software .............. 1-13
1.5 Differences from Turbochrom Software.... 1-16
1.1 Applied Biosystems Data Analysis Software

**Overview**

Applied Biosystems Data Analysis software is part of your VISION™, BioCAD®️, or INTEGRAL®️ software version 3.0 or later.

Applied Biosystems Data Analysis software includes two modules:

- **Group Analysis**—Allows you to view, compare, and export chromatograms.

- **Data Analysis**—Allows you to process, calibrate, and report data that you acquire on your VISION, BioCAD 700E, SPRINT™️, or INTEGRAL Workstation.

**Group Analysis module**

The Group Analysis module allows you to:

- View and compare chromatograms

- Analyze a group of chromatograms

- Export data files to a Microsoft Excel spreadsheet or export chromatograms as a text file (.T*) for use in Microsoft Excel

- Access the Data Analysis module to adjust parameters
Data Analysis module

The Data Analysis module incorporates the basic data analysis features of PE Nelson™ Turbochrom software, but does not include instrument control features.

NOTE: Turbochrom is not available from Applied Biosystems as stand-alone software.

Data Analysis functions

The Data Analysis module allows you to set the following parameters in a VISION, BioCAD, or INTEGRAL method file (.MET):

- **Analysis parameters (.MTH)**—Include:
  - **Processing parameters**—Control peak detection, integration, and report/replot printing
  - **Calibration parameters**—Identify and calibrate components analyzed
- **Report format parameters (.RPT)**—Determine parameters included in a printed report

Data Analysis editors and windows

The Data Analysis module includes:

- **Text Method Editor**— Allows you to create or change analysis parameters (processing and calibration). Changes are saved to the analysis section of a method file (.MET), data file (.B*), or group file (.GRO).
- **Report Format Editor**— Allows you to create or change reporting parameters. Changes are saved to the report format section of a method file (.MET), data file (.B*), or group file (.GRO).
- **Graphic Method Editor**— Allows you to analyze a data file and view its chromatogram.

Allows you to change the analysis parameters (processing and calibration) by graphically manipulating a chromatogram. Changes are saved to the analysis section of a method file (.MET), data file (.B*), or group file (.GRO).

- **Fit Analysis Window**—Allows you to plot the calibration curve for any component that has amount and response data in the analysis section of the associated method file.
1.2 File Structure and Contents

Software file structure and contents

Figure 1-1 on page 1-5 illustrates the file structure and contents of the BioCAD, VISION, and INTEGRAL software.

NOTE: For more information on method files (.MET), data files (.B##), group files (.GRO), and configuration files (.CFG), see the User’s Guide provided with your workstation.

The following sections describe:

- Method file (.MET) contents
- Data file (.B*) contents
- File naming conventions
- Guidelines for accessing files in the Data Analysis module
Data File (*.BIO or *.B##)

- System Configuration
- Chromatographic Method
- Chromatographic Data
- Event Log
  - Analysis Section
  - Report Format Section
  - Results Section

Data File (*.BIO or *.B##) from Preparative Run of Automated Analysis

- System Configuration
- Preparative Chromatographic Method
- Chromatographic Data
- Event Log
  - Group Directory of Analytical Data Files
    - Analysis Section
    - Report Format Section
    - Results Section

Method File (*.MET or *.G##)

- System Configuration
- Chromatographic Analysis Method File
  - Analysis Section
  - Report Format Section

Group File (*.GRO)

- Group Directory of Data Files
  - Analysis Section
  - Report Format Section

Config (*.CFG)

- System Configuration
  - Analysis Section
  - Report Format Section
  - Multi-Method (*.GMM)
    - Method Directory

Temporary Files

- Analysis Method File (.MTH)
- Report Format File (.RPT)
- Results File (.RST)
- Raw Data File (.RAW)

*Figure 1-1  File Structure of VISION, BioCAD, and INTEGRAL Software*
1.2.1 Contents of a Method File (.MET)

In addition to configuration information (created in the Control Panel) and instrument control information (created in the Method Editor), a method file (.MET) contains the following information:

- **Analysis parameters (.MTH)**—Contains analysis parameters (processing and calibration)
- **Report format parameters (.RPT)**—Contains report format parameters

NOTE: You can adjust the above parameters in the Data Analysis module.

Each method file (.MET) contains three copies of the two file types listed above, one for each data channel (UV #1, UV #2, Auxiliary) (Figure 1-2).
1.2.2 Contents of a Data File (.B*)

In addition to configuration information, instrument control information, and chromatographic data, data files (.B*) contain the following information:

- **Analysis parameters (.MTH)**—Contains analysis parameters (processing and calibration)
- **Report format parameters (.RPT)**—Contains report format parameters
- **Results (.RST)**—Contains analyzed data

**NOTE:** You can adjust the above information in the Data Analysis module.

Each data file (.B*) contains three copies of the three files listed above, one for each data channel (UV #1, UV #2, Auxiliary) (Figure 1-3).
1.2.3 File Naming Conventions

After you open a method file (.MET), data file (.B*), or group file (.GRO) and access the Data Analysis module, the following information is used to construct a temporary file name:

- **File name**—XXX_MET, XXX_B*, or XXX_GRO
- **Data Channel**—UV1, UV2, or AUX
- **Extension**—Type of information you are viewing:
  - **.MTH**—Analysis parameters
  - **.RPT**—Report format parameters
  - **.RAW**—Raw data
  - **.RST**—Results

The temporary files are used in the Data Analysis module only.

**Example**

For example:

- **SAMPLE_BIO_UV2.RST** indicates you are viewing results (RST) for the UV #2 data channel of the data file SAMPLE.BIO.

- **TEST_MET_UV1.MTH** indicates you are viewing analysis parameters (MTH) for the UV #1 data channel of the method file TEST.MET.

**NOTE:** Temporary file names appear in the title bar and status bar of the Data Analysis module (Graphic Method Editor, Text Method Editor, Report Format Editor).
1.2.4 Guidelines for Accessing Files in the Data Analysis Module

Before using the Data Analysis module, note the following:

- You always open or select either a method file (.MET), data file (.B*), or group file (.GRO) in the Method Editor, Group Analysis window, or Control Panel before accessing the Data Analysis module.

- You cannot open method files (.MET), data files (.B*), or group files (.GRO) directly within the Data Analysis module.

- To access a different method file or data file, you must return to the Group Analysis window or the Method Editor, then select another file and data channel to re-access the Data Analysis module.

- You can view only one data channel (UV #1, UV #2, or Auxiliary) at a time in the Data Analysis module. You select the data channel to view when you open a file.

- You can access analysis parameters (.MTH), report format parameters (.RPT), raw data (.RAW), or results (.RST) sections of a selected method file (.MET) or data file (.B*) from within the Data Analysis module.

- Once in the Data Analysis module, do not save files as .MTH, .RPT, or .RST files. These file types cannot be used by the BioCAD, VISION, or INTEGRAL software.

**NOTE:** Analysis parameters (.MTH), report format parameters (.RPT), and raw data (.RAW) are not stored as separate, permanent files. You can access these sections of a method file or data file only through the Data Analysis module.

Results (.RST) can be stored as separate files for the purpose of creating a calibration curve. Report formats (.RPT) can be stored as separate files for the purpose of selecting optional reports in analysis parameters.
1.3 Software Overview

Figure 1-4, Figure 1-5, and Figure 1-6 show an overview of Applied Biosystems Data Analysis software.

![Diagram of accessing data analysis functions from control panel]

**Figure 1-4 Accessing Data Analysis Functions from Control Panel**
Figure 1-5  Accessing Data Analysis Functions from Method Editor
Figure 1-6 Accessing Data Analysis Functions from Group Analysis
1.4 Changes to Version 3.0 Software

If you have been using a version of BioCAD, VISION, or INTEGRAL software earlier than 3.0, there are several changes to the software file structure and Applied Biosystems Data Analysis software:

- **Windows 95**—The software runs on Windows 95, not Windows 3.1.

- **No Analysis Parameters file (.ANP)**—The software no longer uses Analysis Parameter files (.ANP). Instead, each method file (.MET), data file (.B*), and group file (.GRO) includes three Analysis sections (.MTH) and three Report Format sections (.RPT), one for each data channel. Each analysis section (.MTH) contains processing and calibration parameters.

- **Data channel references**—The data channels are now referred to as UV #1, UV #2, and Auxiliary, not as channels A, B, and C.

- **Single data channel**—You can view and change parameters for one data channel at a time. You can set parameters independently for all three data channels because there are three analysis sections (.MTH) and three report format sections (.RPT) within a method file (.MET), data file (.B*), or group file (.GRO).

- **Temporary files**—During data analysis, several temporary files are created in the Data Analysis module:
  - Analysis Method file (.MTH)
  - Report Format file (.RPT)
  - Results file (.RST)

Do not open or save these sections as stand-alone files, except when instructed to do so.
Chapter 1  Overview of Applied Biosystems Data Analysis

- **Control Panel**—The Control Panel in software version 3.0 has the same basic functionality as earlier software versions. However, new commands are available under the Analysis menu that let you analyze and print data and access the Group Analysis and Data Analysis modules.

- **Group Analysis module**—The Group Analysis module in software version 3.0 has the same basic functionality as earlier software versions. However, new commands are available under the Analysis menu that allow you to access the Data Analysis module.

- **Method Editor**—The Method Editor has the same basic functionality as before. However, new commands are available under the File menu that allow you to access the Data Analysis module.

- **Opening data files**—You must open data files from the Group Analysis window, Method Editor, or Control Panel of the BioCAD, VISION, or INTEGRAL software. Then you can access the Data Analysis module. You cannot open data files directly within the Data Analysis module.

- **Accessing the Data Analysis module**—The Data Analysis command is removed from the Window menu. You can access the Data Analysis module by selecting the appropriate commands from the Control Panel, Group Analysis window, or Method Editor.

- **Opening data files acquired using earlier versions of software**—You can open data files acquired using software earlier than version 3.0. However, when you analyze these data files in version 3.0 software, the files are updated using version 3.0 Data Analysis and cannot be opened again in the previous version of software. The data files inherit the default analysis (.MTH) and report format (.RPT) parameters. You will have to adjust these parameters to make them consistent with the original .ANP file.
Hint: You may want to backup data files that you acquired using an earlier software version. You can use the backup data files with the earlier software version.

- Differences in results between version 3.0 and earlier software versions—When you analyze data files acquired using software earlier than version 3.0, the results may be slightly different. This difference is due to different integration algorithms in version 3.0 software.
1.5 Differences from Turbochrom Software

If you are familiar with PE Nelson's Turbochrom software, the following list explains the differences between Turbochrom software and Applied Biosystems Data Analysis software, which incorporates basic Turbochrom features:

- **No instrument control**—You control the instrument from the BioCAD, VISION, or INTEGRAL software.
- **No Navigator window**—You access the Data Analysis module from the BioCAD, VISION, or INTEGRAL software.
- **No Batch Reprocess window**—Although this feature is used by the Data Analysis module for background analysis, the window is not available for direct control of batch reprocessing.
- **Reprocess Results window**—This window is not available in the Data Analysis module.
- **No Sequence Editor**—This window is not available in the Data Analysis module.
- **Opening data files**—You cannot open data files within the Data Analysis module. You must open these files in the BioCAD, VISION, or INTEGRAL software before accessing the Data Analysis module.
- **Working with .MTH, .RPT, and .RST files**—Adjustments and processing affects the following sections of a method file, data file, or group file:
  - .MTH (analysis section)
  - .RPT (report format section)
  - .RST (analyzed data)

You cannot adjust or process individual .MTH, .RPT, or .RST files.
Differences from Turbochrom Software

- **Unavailable functions**—Some Turbochrom functions are unavailable or not supported, for example:
  - Audit Trail
  - LIMS
  - LINK
  - Connect2

**NOTE:** If a function is not available or not supported, it is noted in the appropriate section of this user’s guide.
Chapter 1  Overview of Applied Biosystems Data Analysis
2 Viewing and Comparing Chromatograms

This chapter includes the following sections:

2.1 Overview of Group Analysis ....................... 2-2
2.2 Opening, Creating, and Editing a Group File ......................................................... 2-6
2.3 Comparing Chromatograms ...................... 2-14
2.4 Using the Group Analysis Window ............ 2-20
2.5 Printing Chromatograms and Reports ...... 2-24
2.6 Viewing the Method ................................ 2-25
2.7 Viewing the Event Log for Data Files ...... 2-27
2.8 Using Group Subtract .............................. 2-28
2.1 Overview of Group Analysis

NOTE: The Group Analysis module in software version 3.0 has the same basic functionality as earlier software versions. New commands are available under the Analysis menu that allow you to access the Data Analysis module. The Open Group Parameters command is no longer available.

This section describes:
- Overview
- Group files
- Sample group files and data files
- Using Group Analysis and templates
- Using Group Analysis and multi-methods

Overview

The Group Analysis module allows you to view and compare up to nine chromatograms in tiled, overlay, or stacked mode. For more information, see Section 2.3, Comparing Chromatograms.

The Group Analysis module also allows you to:
- Analyze an individual data file or group of data files, using analysis parameters from individual data files or from a group file. For more information, see Section 4.3.2, Analyzing Data Files in Group Analysis.
- Interactively view a chromatogram and re-analyze the data from a single run. For more information, see Section 4.4, Interactive Viewing and Analyzing.
- Export data files or chromatograms. For more information, see Chapter 5, Exporting Data.
**Overview of Group Analysis**

**Group files** A group file (*.GRO) is a file that lists and points to each data file in the group. There are two ways group files are created:

- **Automatically**—When you run a template or multi-method from the Method Editor window, a group file is automatically created. The group file name is the same as the data file names, but with a .GRO extension.
  
  If you run more than one template with the same data file name, all data files are added to the same group. New files are added to the end of the group.

- **Manually**—You can create a group file and add data files to it from the Group Analysis window.

**Sample group files and data files** Your workstation includes sample group and data files that you can use in the Group Analysis window.

The following table lists the sample group files.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Sample Group Files</th>
<th>Storage Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>BioCAD SPRINT</td>
<td>SAMPLE.GRO</td>
<td>C:\BIOCAD\GROUP</td>
</tr>
<tr>
<td>BioCAD 700E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VISION</td>
<td>ANION.GRO</td>
<td>C:\VISION\GROUP</td>
</tr>
<tr>
<td></td>
<td>CATPH.GRO</td>
<td></td>
</tr>
<tr>
<td>INTEGRAL 100Q</td>
<td>SAMPLE.GRO</td>
<td>C:\INTEGRAL\GROUP</td>
</tr>
</tbody>
</table>

The following table lists the sample data files.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Sample Data Files</th>
<th>Storage Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>BioCAD SPRINT</td>
<td>SAMPLE.B00–SAMPLE.B09</td>
<td>C:\BIOCAD\DATA</td>
</tr>
<tr>
<td>BioCAD 700E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VISION</td>
<td>ANION.B00–ANION.B04</td>
<td>C:\VISION\DATA</td>
</tr>
<tr>
<td></td>
<td>CATPH.B02–CATPH.B07</td>
<td></td>
</tr>
<tr>
<td></td>
<td>09231919.B00–09231919.B10</td>
<td></td>
</tr>
<tr>
<td>INTEGRAL 100Q</td>
<td>SAMPLE.B00–SAMPLE.B09</td>
<td>C:\INTEGRAL\DATA</td>
</tr>
</tbody>
</table>

*Data Analysis Software User Guide* 2-3
Template and Group Analysis features make systematic methods development easy and efficient.

To use Group Analysis and templates:
1. Create and run a method as described in the user's guide for your system.
2. Create and run the template as described in the user's guide for your system.
3. When the template is complete, examine the data files from the template using Group Analysis. See Section 2.2, Opening, Creating, and Editing a Group File.
4. Select the optimized separation, then click the Open Method button. The method displayed contains the optimized conditions that generated the separation.
5. Set up the next template of interest, run the template, and examine the data in Group Analysis. Select the optimized separation, open the method, and continue with the next template.
**Using Group Analysis and multi-methods**

Multi-method and Group Analysis features make it easy and efficient to observe the effect of different variables on a separation.

To use Group Analysis and multi-methods:

1. Create a method as described in the user’s guide for your system.
2. Create and run the multi-method as described in the user’s guide for your system.
3. When the multi-method is complete, examine the data files from the multi-method using Group Analysis. See Section 2.2, Opening, Creating, and Editing a Group File.
4. Select the optimized separation, then click the **Open Method** button. The method displayed contains the optimized conditions that generated the separation.
5. Set up the next multi-method of interest, run the multi-method, and examine the data in Group Analysis. Select the optimized separation, open the method, and continue with the next multi-method.
2.2 Opening, Creating, and Editing a Group File

This section describes:

- Opening a group file
- Selecting data files in a group file
- Creating a group file
- Editing a group file

**Opening a group file**

To open a group file:

1. From any window, select **Group Analysis** from the Window menu.

The Group Analysis window is displayed (Figure 2-3).
2. From the File menu, select **Open Group**.

   The Open a Group to Analyze dialog box appears (Figure 2-4).

![Open Group to Analyze Dialog Box](image)

**Figure 2-4 Open Group to Analyze Dialog Box**

3. Select a **group file** (.GRO) from the list box.

   All data files contained in the group file are listed in the Group contents list box.
4. Click OK.

The Group Analysis window displays chromatograms in one of three modes:

- **Tiled mode**—Displays the *last* nine selected data files in the group. Each file is displayed in a data window. For more information, see Section 2.3.1, Tiled Mode.

- **Overlay mode**—Displays the *first* ten selected data files in the group, all in one window. For more information, see Section 2.3.2, Overlay Mode.

- **Stacked mode**—Displays the *first* ten selected data files in the group, all in one window. For more information, see Section 2.3.3, Stacked Mode.
Figure 2-5  Group Analysis Window in Tiled Mode

NOTE: If you run more than one template or multi-method with the same data file name, all data files are added to the same group file. New data files are added to the end of the group file. Therefore, all data files in the group file may not belong to the same “logical” group.
Chapter 2  Viewing and Comparing Chromatograms

Selecting data files in a group file

You select data files in a group for two reasons:
- To select them for subsequent analysis
- To display their chromatograms in the Group Analysis window

NOTE: Although a group can contain up to 100 data files, only nine selected files (in Tiled mode) or ten selected files (in Stacked or Overlay mode) can be displayed at one time.

To select data files in a group file:

1. In Group Analysis, open a group file by selecting Open Group from the File menu, or create a group file by selecting New Group from the File menu.
2. Select Select Files from the File menu.

The Select Data Files to Analyze dialog box appears (Figure 2-6). All data files included in the group file are listed in the bottom list box.

Figure 2-6  Select Data Files to Analyze Dialog Box
3. Click a data file to select it.
4. Click the Select button.
   A > appears to the left of the data file.
5. To unselect a selected data file, select the data file from the list box and click the Un-Select button.

   **Hint:** Double-click a data file to select or deselect it.

**Creating a group file**

To create a group file:
1. In the Group Analysis window, select New Group from the File menu.
2. Select Select Files from the File menu.

   The Select Data Files to Analyze dialog box appears (Figure 2-7).

   ![Figure 2-7 Creating a Group](image)

   **Figure 2-7 Creating a Group**
3. Locate and add data files using the following commands:

   - To Filter the data files displayed in the Files list at the top of the dialog box, type wildcards in the File Name text box. Click Enter.

     For example, to display only data files with names starting with A, type A*.B*.

   - To add one data file to the group, select a file in the Files list at the top of the dialog box. Click Add, or you can double-click the data file name to add it.

     The data file appears in the list box at the bottom of the dialog box.

   - To add a group of data files to the group, type wildcards in the File Name box. Click Add.

     For example, to add all .BIO data files, type *.BIO.

4. Select files for analyzing and display. For more information, see “Selecting data files in a group file” on page 2-10.

   You can add up to 100 files to a group. However, only nine or ten are displayed in the Group Analysis window at one time. Files selected in the group file list are marked with a “>” and displayed in the Group Analysis window. You can select more than nine files, but only the last nine (Tiled mode) or first ten (Overlay or Stacked mode) are displayed.

5. When all files are added and selected, click OK. The Group Analysis window is displayed containing data windows for all selected files.

6. Select Save Group from the File menu. Type a name for the group and click OK.
To change the data files in a group file:

1. Open a group file by selecting **Open Group** from the File menu.

2. In Group Analysis, select **Select Files** from the File menu.

   The Select Data Files to Analyze dialog box appears (Figure 2-7). All data files included in the group file are listed in the bottom list box.

3. Edit the group file as needed:
   - To add a data file to the group, select a data file from the list box at the top of the window and click **Add**.
   - To delete a data file from the group, select a data file from the list box at the bottom of the window and click **Delete**.
   - To temporarily remove a file from the display without deleting it from the group, select a data file from the list box at the bottom of the window and click **Un-Select**.

   **Hint:** Double-click a data file to select or deselect it.

   **NOTE:** If you deselect a data file, it will not be analyzed.

   - To move a file in the group, select it, delete it, then add it in a new position. Order of chromatograms can be important when displaying in the stacked mode.
   - Click **Clear** to clear all files from the group.
2.3 Comparing Chromatograms

In the Group Analysis window, you can view up to nine or ten chromatograms in three different modes:

- Tiled
- Overlay
- Stacked

2.3.1 Tiled Mode

To display chromatograms in tiled mode, select the Display menu, then select Tiled Mode.

Tiled mode does the following:

- Displays the chromatograms for the last nine selected data files in a group

**NOTE:** The last selected data files are displayed to easily examine the most recently acquired data files using a template or multi-method.

- Displays each chromatogram in an individual window
- Displays the data file name as the default title in the title bar of each chromatogram window
- Can display UV, auxiliary, pH, conductivity, pressure traces, and events in each window.

**NOTE:** To display different traces, or to change the colors of the traces, select Options from the Display menu.
Changing titles  To change the names displayed in the title bar of each window, see “Changing chromatogram titles” on page 2-23.
2.3.2 Overlay Mode

To display chromatograms in overlay mode, select the Display menu, then select **Overlay Mode**.

Overlay mode does the following:

- Displays the chromatograms for the first ten selected data files in a group
- Displays all chromatograms laid on top of each other in one window

**NOTE:** Overlay mode is useful for making precise comparisons.

- Displays data file names in the top-left corner of the window
- Displays only one signal for each data file

**NOTE:** To select the signal displayed, select **Options** from the Display menu. The first signal selected in the Display Settings dialog is displayed in Overlay mode. You cannot change the display colors set by the software.
FIGURE 2-9 OVERLAY MODE DISPLAY

**Hint:** You can use the Overlay mode to monitor fluctuations in conditions from run to run. Deselect UV channels, and display pressure, pH, or conductivity (to monitor gradient reproducibility) signals.

**Changing titles** To change the names displayed in the window, see “Changing chromatogram titles” on page 2-23.
2.3.3 Stacked Mode

To display chromatograms in stacked mode, select the Display menu, then select Stacked Mode.

Stacked mode does the following:

- Displays the chromatograms for the first ten selected data files in the group
- Displays all chromatograms stacked vertically on top of each other in one window

**NOTE:** Stacked mode is useful for observing changes over a series of runs.

- Displays data file names in the top-left corner of the window
- Displays only one signal for each data file.

**NOTE:** To select the signal displayed, select Options from the Display menu. The first channel selected in the Display Settings dialog is displayed in Stacked mode. You cannot change the display colors set by the software.
Comparing Chromatograms

Figure 2-10  Stacked Mode Display

**Changing titles**  To change the names displayed in the window, see “Changing chromatogram titles” on page 2-23.
2.4 Using the Group Analysis Window

This section describes:
- Customizing the window
- Zooming
- Changing chromatogram titles

**Customizing the window**

Selecting items on the Display menu allows you to customize the window:

- **White or Black Background**—Selects background color for the windows.
- **Grid**—Adds a grid for the left Y-axis and X-axis.
- **Ribbon**—Adds a control button ribbon to the top of the window.

Use the Options command on the Display menu to customize the window.

1. From the Display menu, select **Options**.

   The Display Settings dialog box is displayed (Figure 2-11).
2. Select axis variables, set ranges and colors. Specify the labels to display on the left and right axes.

Using the X-axis Min and Max defaults of zero displays the entire data file for all chromatograms. This is useful when you are displaying chromatograms of different lengths. Change the min and max values when you want to display only a portion of the chromatograms.

3. Check the **Display Events** box to display events. Events include injection marks, pump on/off, UV/VIS chart mark, fraction start and end, and fraction tube changes.

**NOTE:** The software displays events only in Tiled mode.

4. Click **OK**.
Zooming

To expand a portion of data:

1. Move the cursor to the chromatogram you want to expand.
   The cursor changes to a crosshair.

   **Hint:** If you are in Tiled mode and want to zoom all chromatograms at the same time to the same scale, select **Lock Zoom** from the Display menu before zooming.

2. Hold down the left mouse button.
3. Click-drag a box around the area you want to zoom on.
4. Release the mouse button.
   The selected area is expanded.
   If you selected Lock Zoom, all chromatograms are expanded to the same scale. Only the channel on the left Y-axis is zoomed vertically. All other channels are zoomed horizontally only.
5. To return to the default scale, double-click on the chromatogram.
Changing chromatogram titles

Chromatogram titles are displayed in the title bar of Chromatogram windows in Tiled mode, and in the top left corner of the Overlay and Stacked windows.

Default titles are the data file names, followed by sample volume or template parameter value. You can change titles for reporting.

To edit the chromatogram titles:

1. Display chromatograms in Tiled mode by selecting **Tiled mode** from the Display menu.
2. Select a chromatogram.
3. From the File menu, select **Edit Title**.
   The Edit Chart Title dialog box appears (Figure 2-12).

4. Enter a **new title**. You can enter up to 34 characters, however, the maximum number of characters displayed is between 25 and 30, depending on the width of the characters and the size of the chromatogram window. Click **OK**.
   The title of the selected chromatogram changes.
5. Repeat step 2 through step 4 for all chromatogram titles you want to change.
6. Select **Save Group** from the File menu to save the chromatogram titles.

**NOTE:** The title you entered affects only the name displayed in the title bar of the chromatogram. The data file name does not change.
2.5 Printing Chromatograms and Reports

**Printing chromatograms**
To print displayed chromatograms, use the Print commands on the File menu in the Group Analysis window:

- **Print Graph**—In Stacked or Overlay mode, prints chromatograms as currently displayed.
- **Print Current Graph**—In Tiled mode, prints the selected chromatogram window as currently displayed.
- **Print All Graphs**—In Tiled mode, prints all chromatograms as currently displayed on a single page.
- **Print Report**—In Tiled mode, prints the selected chromatogram window as currently displayed on the top half of the page, with a summary of the method on the bottom half of the page.

**Printing reports of analyzed data**
To print reports of analyzed data from the Group Analysis window:

1. If desired, set up a custom report. See Section 8, Adjusting Report Format Parameters.
2. Select **Print** from the Analysis menu or select the **Print** check box on the ribbon at the top of the Group Analysis window.
3. Analyze the data. See Section 4.1, Overview of Analyzing.

   After data is analyzed, reports print.
2.6 Viewing the Method

After comparing chromatograms, you can display the method used to generate the chromatogram.

Accessing the method from Group Analysis is particularly useful when you are using templates to systematically develop methods. See “Using Group Analysis and templates” on page 2-4. You can:

- Display the group created using a template
- Examine the group and select the optimized chromatogram
- Access the method used to generate the chromatogram. This method contains the conditions set in the base method, as well as the conditions specified for the template. For example, if you are examining a data file generated using a pH template, the method contains the optimized pH.
- Create the next appropriate template for systematic methods development
- Start the new template
Viewing the method

To view the method used to generate a data file chromatogram:

1. In Tiled mode, select a chromatogram.

2. Select Open Method from the File menu or click the Open Method button on the ribbon at the top of the Group Analysis window.

   The Method Editor window opens.

   CAUTION

   If the current system configuration does not match the configuration stored in the method, a warning box is displayed. Click Do Not Update Method with System Configuration to continue without updating the method.

   If you click Update Method with System Configuration, the configuration in the method is updated. It is not saved, however, unless you manually save it by selecting Save As from the File menu.

3. To rerun the method, select Run Method from the File menu.

4. To create a template to optimize another chromatographic variable, select the template from the template menu. Set up the template. Click Run.

5. To leave the Method Editor, select Group Analysis from the Window menu.
2.7 Viewing the Event Log for Data Files

Each data file contains an event log if any errors were generated during the run.

In Tiled mode, select a chromatogram, then click the Open Log button at the top of the window to display the Event Log window for the selected file. For more information on the Event Log, see the user’s guide for your system.

**NOTE:** This button is dimmed unless a data file is displayed.

### Printing

You can manually print the contents of the Event Log by selecting Print commands from the File menu in the Event Log window:

- **Print All**—Prints all errors
- **Print Item**—Prints only the error you have selected

You can automatically print the contents of the Event Log as each sample runs by setting the method to Print after Run. For more information, see the user’s guide for your system.
2.8 Using Group Subtract

**Overview**
The Group Subtract feature allows you to subtract a baseline from one or more data files. You run a blank sample to generate a blank data file and chromatogram, then subtract the blank chromatogram from other chromatograms.

**Subtracting a baseline**

To subtract a baseline:

1. Run a blank sample to create a baseline data file and chromatogram.

2. Run your samples to create your sample data files and chromatograms. Use the Auto file extension feature so that all the sample data files have the same root file name, but different extensions.

**NOTE:** All data files that you want to subtract a baseline from must have different extensions, such as .B01, .B02, .B03, and so on. If the data files do not have different extensions, you must perform subtraction on them separately.

3. In the Group Analysis window, open the blank data file and the sample data files by selecting **Select Files** from the File menu. If these data files are already in a group file, open that group file by selecting **Open Group** from the File menu.

4. Select **Group Subtract** from the Analysis menu in the Group Analysis window.

The Group Subtract dialog box appears (Figure 2-13).
5. Type a **destination file name** (for example, subtract) for the data files you will create by subtracting a baseline. Do not type an extension. The destination files will all have the same root file name (subtract), but different extensions. The extension will be the same as the source file, such as .B01, .B02, .B03, and so on.

6. From the **Baseline File** drop-down list box, select the baseline data file (in this example, blank.bio).

7. In the **Source File Names** list box, select one or more sample data files for which you want to subtract the baseline (in this example, ANION.B00, ANION.B01, and ANION.B03).

---

**CAUTION**

*Do not select multiple data files with the same extension. If you do, the software subtracts a baseline from only one of the selected data files with a given extension. The other data files with the same extension are ignored.*
8. Click **OK**.
   In the example shown in Figure 2-13, the software subtracts the baseline of the blank data file (BLANK.BIO) from each of the source data files (ANION.B00, ANION.B01, and ANION.B03) and creates the appropriate destination files (SUBTRACT.B00, SUBTRACT.B01, and SUBTRACT.B03).

9. To view the destination files, open them by selecting **Select Files** from the File menu.
This chapter includes the following sections:

3.1 Overview ............................................................. 3-2

3.2 Data Files Generated by Automated Analysis ............................................................... 3-2

3.3 Viewing the Results of an Automated Analysis ............................................................... 3-5

  3.3.1 Viewing Preparative Method Results ................................................................. 3-5

  3.3.2 Viewing Analytical Method Results ................................................................. 3-7
3.1 Overview

This chapter describes how to view the results of an Automated Analysis. For information on setting up and running an Automated Analysis, see the VISION Workstation User's Guide, or the COBRA Robotic Sample Handling Device User's Guide.

Automated Analysis

Automated Analysis is a standard feature on VISION™ Workstations, and is available as an option on BioCAD 700E Workstations.

Automated Analysis integrates purification and analysis. Automated Analysis uses the AFC 2000 Robotic Sample Handling Device to run two methods:

- **Preparative method**—Fractionates a crude sample
- **Analytical method**—Automatically runs repeatedly to inject, analyze, and quantitate the analyte in selected fractions

3.2 Data Files Generated by Automated Analysis

Single run

If you run a single Automated Analysis, two types of data files are generated:

- **.B* file**—Generated by the preparative method, contains the chromatogram of the separation of the crude sample. Also includes a list of data file names generated by the analytical method.
- **.B## files**—Generated by the analytical method, contains the chromatogram of the fractions analyzed.

Figure 3-1 illustrates the process that occurs when you run an Automated Analysis, and shows the data files generated.
Figure 3-1  Automated Analysis Process
If you run an Automated Analysis with a template or multi-method, a group file (.GRO) file is generated. The group file contains a list of all preparative data files (.B##) created by the template or multi-method.

Figure 3-2 illustrates the process that occurs when you run a template or multi-method with Automated Analysis, and shows the data files generated.
3.3 Viewing the Results of an Automated Analysis

After running an Automated Analysis, you can view the results of the following methods:

- Preparative method
- Analytical method

Use Group Analysis to view the group files (.GRO) and data files (.B*) (chromatograms) that the preparative method and analytical method create.

3.3.1 Viewing Preparative Method Results

The following sections describe viewing the results of a:

- Single preparative method run
- Template or multi-method preparative method run

**Single run**

If you run a single preparative method, a data file (.B*) is created.

To display the preparative method data file:

1. Select **Group Analysis** from any Window menu.
   The Group Analysis window is displayed.
2. Select **Select Files** from the File menu.
   The Select Charts for Processing dialog box is displayed.
3. Select the **data file** associated with your preparative method.
   The data file is stored under the directory and file name you specified for data files before running the preparative method. The data file has a .B* extension.
4. Click **OK**.
   The data file (chromatogram) is displayed.
Multi-method or template run

If you run your preparative method from a template or multi-method, a group file (.GRO) is created. This group file contains a list of all preparative data files (.B##) created by the multi-method or template.

To open the multi-method or template group file and display the data files:

1. Select Group Analysis from any Window menu.
   The Group Analysis window is displayed.

2. Select Open Group from the File menu.
   The Open a Group for Processing dialog box is displayed.

3. Select the group file associated with the template or multi-method run of the preparative method.

   If you ran a template, the group file has the same file name you specified for data files before running the template, but with a .GRO extension. It is stored in the C:\VISION\GROUP or C:\BIOCAD\GROUP directory.

   If you ran a multi-method, the group file has the file name you specified when you ran the multi-method, with a .GRO extension. It is stored in the C:\VISION\GROUP or C:\BIOCAD\GROUP directory.

4. Click OK.

   All data files (chromatograms) created by the preparative runs are loaded in Group Analysis. The last nine data files (chromatograms) created by the multi-method or template runs are displayed. The data files have the file name you specified for data files before running the multi-method or template, with a .B## extension, beginning with .B00 and incrementing one digit for each preparative run.
5. If the multi-method or template created more than nine data files, you can view other data files in the group by selecting Select Files from the File menu.

The Select Charts for Processing dialog box is displayed, listing:

- File names of the data files in the group file
- Number of data files available in the group file
- Number of data files selected for viewing

6. Select or deselect data files for viewing by clicking on the data file name and then clicking the Select or Un-Select button.

7. Click OK.

The data files you selected for viewing are displayed.

3.3.2 Viewing Analytical Method Results

The data file from the preparative method contains a list of the data files created by the analytical method.

To display the analytical method data files:

1. Select Group Analysis from any Window menu.

   The Group Analysis window is displayed.

2. Select Open Group from the File menu.
The Open a Group for Processing dialog box is displayed (Figure 3-3).

![Open a Group for Processing Dialog Box](image)

3. Select **Data Files (*.B*)** from the List Files of Type drop-down list box, then select the **data file (.BIO or .B##)** created by the preparative method.

The data file created by the preparative method has the path and file name you specified for data files before running the preparative method and a .BIO or .B## extension.

The analytical data file names contained in the selected preparative data file are displayed in the Group Contents list box.

4. Click **OK**.

All data files (chromatograms) created by the analytical runs are loaded in Group Analysis. The last nine data files that were created are displayed. The file name and title of each data file appears on the title bar of the chromatogram. See “File name nomenclature” on page 3-9 and “Title nomenclature” on page 3-10.
5. To view other data files created by the analytical runs, select **Select Files** from the File menu.

The Select Charts for Processing dialog box is displayed, listing:

- File names of the data files created by the analytical methods
- Number of data files available
- Number of data files selected for viewing

Select or deselect data files for viewing by clicking the **data file name** and then clicking the **Select** or **Un-Select** button.

6. Click **OK**.

The data files you selected for viewing are displayed.

---

**File name nomenclature**

The file name for analytical data files appears in Group Analysis in the:

- Title bar of the analytical data file (chromatogram)
- Select Charts for Processing dialog box

The file name for analytical data files has the following nomenclature:

```
MMDDHHMM.B##
```

The nomenclature designates the time that the preparative method run started:

- **MM**—month
- **DD**—day
- **HH**—hour (based on 24 hours)
- **MM**—minutes

The .B## extension begins with .B00 and increments one digit for each fraction that the analytical method analyzes.

Therefore, all analytical data files from a single preparative method run have the same root file name, but different extensions.
Chapter 3  Viewing Results of Automated Analysis

Title nomenclature

The title for analytical data files appears after the data file name in Group Analysis in the:
- Title bar of the analytical data file (chromatogram)
- Select Charts for Processing dialog box

The title for analytical data files has the following nomenclature:

\[ X: # \text{ file name} - # \]

The nomenclature designates information about the fraction analyzed:
- \( X: # \) — rack position of the tube analyzed
- \( \text{file name} \) — file name of the preparative method that created the fraction
- \( - # \) — order the fraction was collected

Analyzing data files from analysis method

If you did not specify Analyze After Run when you created your analytical method, you can manually analyze the data files generated by the analytical method. Open the data files in the Group Analysis window as described in Section 3.3.2, Viewing Analytical Method Results, and select Analyze Individual from the Analysis menu.

NOTE: Do not select Analyze Group from the Analysis menu. The group file may not contain the appropriate analysis and report format parameters.

The data files created by the analytical method are stored in the directory you specify before running the preparative method. Use the file name and title nomenclature described above to identify data files created by the analytical method. For more information, see Section 4.3.2, Analyzing Data Files in Group Analysis.
This chapter includes the following sections:

4.1 Overview of Analyzing ........................................... 4-2
4.2 Before You Analyze ............................................. 4-3
4.3 Background Analyzing ........................................... 4-8
   4.3.1 Specifying Automatic Analyzing in the Method Editor .. 4-9
   4.3.2 Analyzing Data Files in Group Analysis ................. 4-11
   4.3.3 Analyzing and Printing from the Control Panel .......... 4-14
4.4 Interactive Viewing and Analyzing ......................... 4-16
4.5 Generating Calibration Curves and Quantitating Unknowns 4-21
4.1 Overview of Analyzing

*Overview*  
Applied Biosystems Data Analysis software provides two modes of analyzing data:

- **Background analyzing**—The software automatically analyzes specified data files and stores the analyzed results in the results section (.RST) of that data file. You can optionally print a report and export the data. See Section 4.3, Background Analyzing.

- **Interactive viewing and analyzing**—Using the Graphic Method Editor, you can graphically manipulate a chromatogram to change analysis parameters (processing and calibration) and analyze a data file. See Section 4.4, Interactive Viewing and Analyzing.
4.2 Before You Analyze

**Changing parameters** Before you analyze your data, you may want to adjust or replace the analysis (.MTH) or report format (.RPT) parameters embedded in your method file (.MET), data file (.B*), or group file (.GRO).

There are four ways to change analysis and report format parameters:

- **Adjust parameters**—Make changes to existing parameters in a file. See “Adjusting parameters” on page 4-3.

- **Replace parameters**—Copy parameters from one file to another file. See “Replacing parameters” on page 4-4.

- **Replace individual data files with group parameters**—Copy parameters from a group file to individual data files within the group. See “Replacing individual with group parameters” on page 4-6.

- **Create a method file from a group file**—Create a stand-alone method file (.MET) from a group file (.GRO). The new method file inherits the parameters from the group file. See “Creating a method file from a group file” on page 4-7.

**Hint:** Create a method file from a group file when quantitating unknowns. This feature allows you to incorporate calibration curve information into a method file to use to acquire and analyze unknowns. For more information, see Section 4.5.9, Creating a Method File (.MET) to Acquire Unknowns.

**Adjusting parameters** To adjust parameters before analyzing, see any of the following sections:

- Chapter 6, Adjusting Processing Parameters
- Chapter 7, Adjusting Calibration Parameters
- Chapter 8, Adjusting Report Format Parameters
- Chapter 9, Adjusting Analysis Parameters Graphically
Replacing parameters

You can replace the parameters in a new file with the parameters from an existing file.

To replace analysis or report format parameters in a method file (.MET), data file (.B*), or group file (.GRO):

1. Access the Replace Analysis/Report Format dialog box (Figure 4-1) by doing one of the following:

Replacing in a method file (.MET)

- To replace parameters in a method file (.MET), display the Method Editor by selecting Method Editor from the Window menu.

  Open a method file and select Replace Analysis/Report Format from the File menu.

Replacing in a data file (.B*)

- To replace parameters in a data file (.B*), display the Group Analysis window by selecting Group Analysis from the Window menu.

  Open a data file and select Replace Analysis/Report Format from the Individual section of the Analysis menu.

Replacing in a group file (.GRO)

- To replace parameters in a group file (.GRO), display the Group Analysis window by selecting Group Analysis from the Window menu.

  Open a group file and select Replace Analysis/Report Format from the Group section of the Analysis menu.

The Replace Analysis/Report Format Sections dialog box (Figure 4-1) appears displaying the open file in the Destination File text box.

The destination file is the file to which parameters will be copied.
Destination file  2. If you want to select a different destination file, select the file name from the list box. You can select multiple files by holding the Shift or Control key and clicking the file names in the list box.

Data channels  3. Select up to three data channels (UV #1, UV #2, Auxiliary).

Analysis source file  4. To replace analysis (processing and calibration) parameters, select the Analysis source file check box and click the Change button to select a file name (.MET, .B*, or .GRO).

Report Format source file  5. To replace report format parameters, select the Report format source file check box and click the Change button to select a file name (.MET, .B*, or .GRO).

6. Click OK.

The analysis and report format parameters from the source files are copied into the destination files.

Figure 4-1  Replace Analysis/Report Format Dialog Box
Replacing individual with group parameters

After adjusting parameters in a group file, you can copy the optimized parameters from the group file to the individual data files in a single step. The data files then contain the optimized parameters for future analyses and documentation purposes.

To replace the parameters in individual data files with the parameters in the group file:

1. Display the Group Analysis window by selecting Group Analysis from the Window menu.

2. Open a group file by selecting Open Group from the File menu.

3. Make sure the data files for which you want to replace analysis (.MTH) and report format (.RPT) parameters are selected. If not, select Select Files from the File menu to select the individual data files. (A “>” appears to the left of selected files.) Click OK to display the chromatograms for these data files.

4. Select Replace All w/ Group Params from the Analysis menu.

The analysis (.MTH) and report format (.RPT) parameters from the group file are copied into the selected data files.

NOTE: The above parameters are not necessarily copied into all data files in the group. Only the data files you selected are affected. For more information, see “Selecting data files in a group file” on page 2-10.
Creating a method file from a group file

Hint: Create a method file from a group file to incorporate calibration curve information into a method file to use to acquire unknowns. For more information, see Section 4.5.9, Creating a Method File (.MET) to Acquire Unknowns.

To create a stand-alone method file (.MET) from a group file (.GRO) with the same parameters as the group file:

1. Display the Group Analysis window by selecting Group Analysis from the Window menu.

2. Open a group file by selecting Open Group from the File menu.

3. Select Tiled Mode from the Display menu.

4. Select the individual data file (chromatogram) containing the configuration and chromatographic method you want to use for the method file.

NOTE: Be sure to select an appropriate data file. If you do not, the method you create will not have the desired settings.

5. Select Create Method from Group from the Analysis menu.

A file is created and saved as a stand-alone method file (.MET) in the method directory. The new method file has:

- Same chromatographic method (instrument settings) as the active data file in the group file
- Same configuration (.CFG) as the active data file in the group file
- Same analysis (.MTH) and report format (.RPT) parameters as the group file
- Same file name as the group file
- An .MET extension
4.3 Background Analyzing

You can perform background analyzing in three windows of your BioCAD, VISION or INTEGRAL software:

- **Method Editor**—When creating a method file (.MET), you can specify to automatically analyze and print a report after running the method. See Section 4.3.1, Specifying Automatic Analyzing and Printing in the Method Editor.

- **Group Analysis window**—After running a method, you can analyze an individual data file or a group of data files, and, optionally, print a report and export data. See Section 4.3.2, Analyzing Data Files in Group Analysis.

- **Control Panel**—You can analyze a selected a data file and print a report. See Section 4.3.3, Analyzing and Printing in the Control Panel.
4.3.1 Specifying Automatic Analyzing and Printing in the Method Editor

To specify automatic analyzing and printing after a method run:

1. After creating a method in the Method Editor, select **Analyze and Print Report After Run** from one of the following menus:
   - Options menu (BioCAD and INTEGRAL)
   - On Board Analysis menu (VISION)

   A check mark appears next to the command.

2. Select **Analysis Setup** from the Options menu (BioCAD and INTEGRAL) or from the On Board Analysis menu (VISION).

   The Analysis Setup dialog box appears (Figure 4-2).

   ![Figure 4-2 Analysis Setup Dialog Box](image_url)

3. Select up to three **data channels** (UV #1, UV #2, or Auxiliary) to analyze.
4. To print a chromatogram in addition to a report, select **Print Chromatogram**.

**CAUTION**

If you select User Programs in the analysis parameters (.MTH) of this method file (.MET), you must select Print Chromatogram. If you do not, the User Programs will not run after analysis. For more information, see Section 6.2.5, Running User Programs.

5. Click **OK** and save the method.

After you run the method, the following occur:

- The generated data file is automatically analyzed, using the analysis parameters (.MTH) embedded in the method file.
- A report (and optionally a chromatogram) prints, using the report format parameters (.RPT) embedded in the method file.
4.3.2 Analyzing Data Files in Group Analysis

**Individual versus Group**

Group Analysis analyzes the data files contained in a group file (.GRO). Group Analysis provides two modes of analysis:

- **Individual**—Analyzes selected data files (up to 100) in the group file using the individual analysis parameters stored in each data file.

- **Group**—Analyzes selected data files (up to 100) in the group file using the same analysis parameters stored in the group file (.GRO) you specify.

**Analyzing**

To analyze data in Group Analysis:

1. From any window, select **Group Analysis** from the Window menu. The Group Analysis window appears, with no data displayed.

2. Open or create a group file. For more information, see Section 2.2, Opening, Creating, and Editing a Group File. Save the group file by selecting **Save Group** or **Save Group As** from the File menu.

3. To export the data files as Microsoft Excel files (.XLS), select the **Export** check box at the top of the Group Analysis window.

**NOTE:** If you select the **Export** check box, after you start analyzing, an Export dialog box appears prompting you to enter run information and parameters to export. For more information, see Section 5.2, Exporting a Group of Data Files to Microsoft Excel.

4. To print a report and chromatogram after analysis, select the **Print** check box at the top of the Group Analysis window.
5. Select one of the following commands from the Analysis menu:

- **Analyze Individual**—To analyze each data file using the individual analysis parameters stored in each data file (.B*). (You can also click **Individual** on the ribbon at the top of the Group Analysis window.)

- **Analyze Group**—To analyze each data file using the same analysis parameters stored in the group file (.GRO). (You can also click **Group** on the ribbon at the top of the Group Analysis window.)

The Analyze dialog box appears (Figure 4-3).

![Figure 4-3 Analyze Dialog Box](image)

6. Select up to three **data channels** (UV #1, UV #2, Auxiliary) to analyze.

7. If you want to save result files (.RST) to use to create a calibration curve, select **Save Result Files for Calibration**. For more information, see Section 4.5, Generating Calibration Curves and Quantitating Unknowns.
8. Click OK.

The selected data files are analyzed and the results are stored in the results section (.RST) of each data file.

**NOTE:** Not necessarily all the data files in the group file are analyzed. Only the selected data files are analyzed. For more information, see “Selecting data files in a group file” on page 2-10.

**NOTE:** The data channels you select for analysis are exported if you selected the Export check box. For more information, see Section 5.2, Exporting a Group of Data Files to Microsoft Excel.

**Result files for calibration**

If you selected the Save Result Files for Calibration check box, the following occur:

- The results are also saved as stand-alone files so you can use them to create a calibration curve.
- These results files are stored in the same directory in which the data files are located.
- The result file names are the same as data file names augmented with the data channel, CAL, and an .RST extension (for example, SAMPLE_B07_UV1_CAL.RST).
4.3.3 Analyzing and Printing in the Control Panel

To analyze a single data file and optionally print a report and chromatogram:

1. From the Control Panel, select **Analyze and Print** from the Analysis menu.

   The Analyze and Print dialog box appears displaying the name of the most recently acquired data file (.B*) (Figure 4-4).

   ![Figure 4-4 Analyze and Print Dialog Box](image)

   **Figure 4-4 Analyze and Print Dialog Box**

2. Select one or more data files (.B*) to analyze. You can select multiple files by holding the **Shift** or **Control** key and clicking the file names in the list box.

3. Select up to three data channels to analyze.

4. To automatically print a report after analysis, select **Print Report**.
5. To print a chromatogram in addition to a report, select **Print Chromatogram**.

**CAUTION**

If you select User Programs in the analysis parameters (.MTH) of this method file (.MET), you must select Print Chromatogram. If you do not, the User Programs will not run after analysis. For more information, see Section 6.2.5, Running User Programs.

6. If you want to save result files (.RST) to use to create a calibration curve, select **Save Result Files for Calibration**. For more information, see Section 4.5, Generating Calibration Curves and Quantitating Unknowns.

7. To use analysis (processing and calibration) parameters from a different file, select the **Use Analysis Parameters From** check box and click the **Change** button to select a file name (.MET, .B*, or .GRO).

8. To use report format parameters from a different file, select the **Use Report Format From** check box and click the **Change** button to select a file name (.MET, .B*, or .GRO).

**NOTE:** Selecting the check boxes in step 7 and step 8 does not replace the analysis (.MTH) or report format (.RPT) parameters in the data file. It only uses these parameters to analyze the data file.

9. Click **OK** to analyze the data file.

   The data file is analyzed using the analysis parameters (.MTH) embedded in the data file you selected in step 2 (or the file you selected in step 7). The results are stored in the results section (.RST) of the data file.

   If you selected Print Report, a report is printed using the report format parameters (.RPT) embedded in the data file you selected in step 2 (or the file you selected in step 8).
4.4 Interactive Viewing and Analyzing

Overview

This section explains how to use the Graphic Method Editor to re-analyze the data from a single run to improve the results of a single analysis. You can optimize and fine-tune the analysis parameters because you can view the chromatogram and see the effect of changing the parameters immediately.

NOTE: When you save the results after interactively analyzing in the Graphic Method Editor, you change the analysis section (.MTH) and results section (.RST) of the data file only. You do not change the analysis section (.MTH) of the original method file that you ran to create the data file. You do not change the analysis section (.MTH) of the group file that contains the data file.
To graphically manipulate a chromatogram to change analysis parameters (processing and calibration) and re-analyze a data file:

**Accessing the Graphic Method Editor**

1. Access the Graphic Method Editor by doing one of the following in your BioCAD, VISION, or INTEGRAL software:

   - **From Control Panel**
     - From the Control Panel, select **Analyze Chromatogram** from the Analysis menu.

   - **From Group Analysis**
     - Display the Group Analysis window by selecting **Group Analysis** from the Window menu.

     Open a data file (.B*) or group file (.GRO).

     Select **Analyze Chromatogram** from the Analysis menu or click the **Analyze** button on the ribbon at the top of the Group Analysis window.

     The Open dialog box appears (Figure 4-5).

![Figure 4-5 Open Dialog Box](image)
Selecting a data file
2. From the list box, select the data file (.B*) to re-analyze.

CAUTION
Once you access the Graphic Method Editor, changes you make and save overwrite the analysis section (.MTH) of the data file you select in step 2. If you want to make changes to the file and save under a different name, cancel the Open dialog box and rename the data file before selecting Analyze Chromatogram.

Selecting parameters
3. To use analysis (processing and calibration) parameters from a different file, select the Use Analysis Parameters From check box and click the Change button to select a file name (.MET, .B*, or .GRO).

To use report format parameters from a different file, select the Use Report Format From check box and click the Change button to select a file name (.MET, .B*, or .GRO).

NOTE: Selecting the check boxes in step 3 does not replace the analysis (.MTH) or report format (.RPT) parameters in the data file. It only uses these parameters to analyze the data file.

Selecting a data channel
4. Select a data channel (UV #1, UV #2, or Auxiliary) to re-analyze.
5. Click **OK** to display the Graphic Method Editor (Figure 9-4 on page 9-10).

The Graphic Method Editor displays the following file names:

- **Title bar**—The data file you selected in step 2, augmented with the selected data channel and an .MTH extension

- **Status bar**—The data file you selected in step 2, augmented with the selected data channel and an .RAW extension

The software opens the raw data section (.RAW) associated with the selected data file and analyzes it using the analysis parameters (.MTH) embedded in the data file (or the file you selected in step 3). Then the software displays the chromatogram, showing the resulting integration and peak identification.

6. Adjust the analysis parameters (processing and calibration) until the parameters produce the results you want. For more information, see the following sections:

   - Section 9.3, Understanding the Graphic Method Editor Window
   - Section 9.4, Changing Display Options
   - Section 9.5, Adjusting Processing Parameters
   - Section 9.6, Working with Components
   - Section 9.7, Displaying and Printing Information

**NOTE:** Once you modify the analysis parameters, the word MODIFIED appears at the right of the status bar of the Graphic Method Editor (Figure 9-4 on page 9-10). The word MODIFIED remains there until you select **Save** from the File menu in the Graphic Method Editor.
7. Select **Save** from File menu.

   The changes you made are saved to the analysis section (.MTH) of the data file you selected in step 2.

   The data file is analyzed and the results are stored in the results section (.RST) of the data file.

   The Documentation dialog box or the Audit Trail dialog box opens.

   **NOTE:** Documentation and Audit Trail information are not supported in this version of software.

8. Click **OK** to close the dialog box.

9. Select **Exit** from the File menu to close the Graphic Method Editor, and return to the Control Panel or Group Analysis window.

### Opening additional files

You can **not** open additional data files, group files, or method files from within the Graphic Method Editor. If you try to open one of these files, an error message is displayed.

To open a different data file, group file, or method file:

1. Return to the Group Analysis window or Control Panel.
2. Repeat the procedure starting on page 4-17.
4.5 Generating Calibration Curves and Quantitating Unknowns

This section describes the following:

- General procedure for calibrating and quantitating
- Adjusting processing parameters
- Entering component information
- Analyzing standards and generating results files (.RST)
- Adjusting global calibration parameters
- Entering calibration levels and component amounts
- Associating areas with levels and generating curves
- Adjusting report format to include calibration information
- Creating a method file (.MET) to run unknowns
- Running and quantitating unknowns
4.5.1 General Procedure

To generate calibration curves and quantitate unknowns:

**Prepare standards**
1. Prepare a standard (or standards, if you are using replicates or multiple concentration levels) containing known amounts of components of interest.

**Run standards**
2. Run the standards at optimized separation conditions to determine retention times and peak areas of the components of interest.

**Adjust analysis parameters (.MTH)**
3. In the Graphic Method Editor:
   - Adjust processing parameters (peak detection/integration) for the standards. See Section 4.5.2, Adjusting Processing Parameters.
   - Enter component information for the standards. See Section 4.5.3, Entering Component Information.

**NOTE**: To simplify analysis of standards for calibration, run the standards using a multi-method. Doing so creates a group file containing a data file for each standard. If you do not run the standards as a multi-method, create a group file containing the appropriate data files before analyzing.

**NOTE**: You can also use the Text Method Editor to adjust processing parameters and enter component information. However, it is easier to adjust parameters while viewing a chromatogram in the Graphic Method Editor.
4. In the Group Analysis window, analyze the data files for the standards. The analysis generates result files (.RST) that contain the area information needed to generate the calibration curve.

See Section 4.5.4, Analyzing Standards and Generating Result Files (.RST).

5. In the Text Method Editor:
   - Adjust global calibration parameters for the group file. See Section 4.5.5, Adjusting Global Calibration Parameters.
   - Enter calibration levels and component amounts in the group file. See Section 4.5.6, Entering Calibration Levels and Component Amounts.
   - Associate areas with levels and generate the calibration curves. See Section 4.5.7, Associating Areas With Levels and Generating Calibration Curves.

6. In the Report Format Editor:
   - Enable the Identified Components option
   - Add a Raw Amount column to the report format

See Section 4.5.8, Adjusting Report Format to Include Calibration Information.

7. In the Group Analysis window, save the method file (.MET) embedded in the group file (.GRO) as a stand-alone method file (.MET).

See Section 4.5.9, Creating a Method File (.MET) to Acquire Unknowns.


See Section 4.5.10, Running and Quantitating Unknowns.
4.5.2 Adjusting Processing Parameters

To adjust processing parameters for the standards:

1. Display the Group Analysis window by selecting **Group Analysis** from the Window menu.

2. Open the group file for the standards by selecting **Open Group** from the File menu.

   If you did not run the standards in a multi-method, open the standard data files by selecting **Select Files** from the File menu. Add the data files to the list box, select the data files, and click **OK**. Then select **Save Group** from the File menu.

3. Click on the standard chromatogram that best represents the group. This chromatogram will be displayed when you adjust processing parameters in the Graphic Method Editor.

4. From the **Group** section of the Analysis menu, select **Adjust Analysis Plot**.

5. Select a **data channel** (UV #1, UV #2, or Auxiliary). Click **OK**.

6. In the Graphic Method Editor (Figure 4-6), adjust the processing parameters (peak detection/integration) as needed for the chromatogram. For more information, see Section 9.5, Adjusting Processing Parameters.

7. Continue to Section 4.5.3, Entering Component Information, before exiting the Graphic Method Editor.
4.5.3 Entering Component Information

After adjusting processing parameters, enter component information in the group file:

1. In the Graphic Method Editor (Figure 4-6), select **Edit Components** from the Calibration menu.

2. Select a component peak by clicking on the peak or by clicking **Next** or **Prev**.

![Figure 4-6 Graphic Method Editor—Entering Component Information](image-url)
3. In the Edit Components dialog box (right side of the Graphic Method Editor), enter a **Name** for the component.

   **NOTE:** You can enter from 16 to 40 characters (depending on character width) for the component name. However, only the first four or five characters are displayed on the plot. The full component name appears elsewhere in the software.

4. Set the **Absolute window** (seconds) and **Relative window** (%) for the component peak retention time.

   **NOTE:** For more information on Absolute and Relative search windows, see Section 7.5.2, Setting Up Search Windows. For information on changing search windows for a range of components, see Section 7.10, Changing Parameters for Multiple Components Simultaneously.

5. Repeat step 2 through step 4 for all component peaks in the chromatogram.

   **NOTE:** The default Component Type is Single Peak. You can select other Component Types from the Type menu. For more information on other component types, see Section 7.5.1, Component Types.

6. Click **X** to close the Edit Components dialog box.

7. From the File menu, select **Save**, then select **Exit** to return to the Group Analysis window.

   All changes you made in the Graphic Method Editor are saved to the analysis section (.MTH) of the group file (.GRO) open in the Group Analysis window.

8. If desired, repeat the following procedures for the remaining data channels:
   - Section 4.5.2, Adjusting Processing Parameters
   - Section 4.5.3, Entering Component Information
4.5.4 Analyzing Standards and Generating Result Files (.RST)

To analyze data files for the standards and generate result files that contain the area information for the calibration:

1. Display the Group Analysis window by selecting **Group Analysis** from the Window menu.

2. Open the group file containing the standards by selecting **Open Group** from the File menu.

3. From the Analysis menu, select **Analyze Group** or click on the ribbon at the top of the Group Analysis window.

   The Analyze dialog box appears (Figure 4-7).

4. Select up to three **data channels** (UV #1, UV #2, Auxiliary), enable **Save Result Files for Calibration**, and click **OK**.

   The data files are analyzed, producing result files (.RST), which are stored in the same directory in which the data files are located. The result file names are the same as data file names augmented with the data channel, CAL, and an .RST extension (for example, SAMPLE_B07_UV1_CAL.RST).
4.5.5 Adjusting Global Calibration Parameters

Adjust global calibration parameters in the group file to make the units appropriate for the scale of your application:

1. Display the Group Analysis window by selecting **Group Analysis** from the Window menu.
2. Open the group file containing the standards by selecting **Open Group** from the File menu.
3. From the **Group** section of the Analysis menu, select **Adjust Analysis Params**.
4. Select a **data channel** (UV #1, UV #2, or Auxiliary). Click **OK**.
5. From the Components menu in the Text Method Editor, select **Global Information** to display the Global Information dialog box (Figure 4-8).

![Figure 4-8 Global Information Dialog Box](image-url)
6. In the Global Information tab, adjust the calibration parameters as needed for the chromatogram. For more information, see Section 7.3, Understanding Global Calibration Parameters, and Section 7.4, Editing Global Calibration Information.

7. Click **OK** to return to the Text Method Editor.

8. Continue to Section 4.5.6, Entering Calibration Levels and Component Amounts, before exiting the Text Method Editor.
4.5.6 Entering Calibration Levels and Component Amounts

After adjusting global calibration parameters, enter calibration levels and component amounts in the group file:

1. In the Text Method Editor, select **Edit Component** from the Components menu.

   The Components dialog box appears (Figure 4-9).

2. Click the **Calibration** tab.

   ![Figure 4-9 Components Dialog Box (Calibration Tab)]

3. Select a **component** from the list box.

4. For Calibration Type, select **Use Curve**.
Generating Calibration Curves and Quantitating Unknowns

NOTE: For information on calibrating with other Calibration Types, see Section 7.5.6, Calibration Types, and “Setting calibration parameters” on page 7-46.

5. Select the Response option (Area or Height) to use for the curve. For more information, see Section 7.5.5, Response Options, and “Setting calibration parameters” on page 7-46.

6. Select the appropriate Curve Fit Type, Scaling, Weighting, and Origin Treatment. For more information, see Section 7.5.7, Selecting Fit Parameters.

NOTE: For information on changing calibration information for a range of components, see Section 7.10, Changing Parameters for Multiple Components Simultaneously.

7. Enter Levels and Amounts for each calibration level. For more information, see “Working with calibration levels” on page 7-51.

NOTE: Some Curve Fit types require a minimum number of calibration levels. For more information, see “Curve Fit Type” on page 7-26.

NOTE: Do not enter Areas. You will select result files containing areas in the next section.

8. Repeat step 3 through step 7 for each component.

9. Click OK to return to the Text Method Editor.

10. Continue to Section 4.5.7, Associating Areas With Levels and Generating Calibration Curves, before exiting the Text Method Editor.
4.5.7 Associating Areas With Levels and Generating Calibration Curves

After entering calibration levels, associate areas contained in result files with calibration levels and generate the calibration curve:

1. In the Text Method Editor, select Calibrate from the Components menu.

2. In the Manual Calibration dialog box (Figure 4-10), click .

![Figure 4-10 Manual Calibration Dialog Box—Associating Areas in Result Files with Calibration Levels]
3. In the File Select dialog box (Figure 4-11), select the **result files (.RST)** you generated for the standards in Section 4.5.4, Analyzing Standards and Generating Result Files (.RST).

**Hint:** To select multiple files, press and hold the Shift or Control key when clicking on file names.

4. Click **Open**.

The selected result files are listed at the top of the Manual Calibration dialog box (Figure 4-12).
5. Select a result file, select a Calibration Level and Type, then click Add. Repeat for each result file.

**NOTE:** If the Level drop-down list box is blank, enter calibration levels as described in Section 4.5.6, Entering Calibration Levels and Component Amounts.

**Hint:** You can select multiple result files that represent replicates of the same concentration level. Select a result file, press and hold the Shift key or Control key, then select another result file. Select the Calibration Level and Type, then click Add.

**NOTE:** The “Identify Peaks Before Calibrating” feature is not supported in this version of software.

6. Click OK.
The calibration curves are generated and displayed in the Text Method Editor (Figure 4-13).

**NOTE:** If the calibration curve is not visible, select **Component List** from the Window menu.

---

**Figure 4-13** Text Method Editor—Calibration Curve Displayed for Comp1

7. Inspect the curve for each component. Change the calibration information as needed.

8. From the File menu, select **Save**, then select **Exit** to return to the Group Analysis window.

All changes you made in the Text Method Editor, including the calibration curves, are saved to the analysis section (.MTH) of the group file (.GRO) open in the Group Analysis window.
9. If desired, repeat the following procedures for the remaining data channels:

   - Section 4.5.5, Adjusting Global Calibration Parameters
   - Section 4.5.6, Entering Calibration Levels and Component Amounts
   - Section 4.5.7, Associating Areas With Levels and Generating Calibration Curves

**Printing calibration curve**

After you generate calibration curves, you can print the curves from the Fit Analysis window. For more information, see Chapter 10, Performing a Fit Analysis.

**Deleting .RST files**

After you generate calibration curves, you can delete the stand-alone .RST files you used to generate the curves.
4.5.8 Adjusting Report Format to Include Calibration Information

To adjust the report format to include calibration information, enable the Identified Components option and add a column for raw amount:

1. Display the Group Analysis window by selecting **Group Analysis** from the Window menu.

2. Open the group file containing the standards by selecting **Open Group** from the File menu.

3. From the **Group** section of the Analysis menu, select **Adjust Report Format**.

4. Select a **data channel** (UV #1, UV #2, or Auxiliary). Click **OK**.

5. In the Report Format Editor, select **Options**.

6. In the Report Format Options dialog box, select **Identified Components** (Figure 4-14). Click **OK** to return to the Report Format Editor.

**NOTE:** The Identified Components option is enabled in the default report format. If you do not enable Identified Components, component amounts are not included in the printed report.
Chapter 4 Analyzing Data

4-38 Applied Biosystems

7. From the Report menu, select Raw Amount.

8. In the Raw Amount dialog box (Figure 4-15), enter information for the Raw Amount column in the report format. For more information, see “Adding a report column” on page 8-13. Click Insert/Add.
NOTE: If you do not add a Raw Amount column to the report format, raw amounts (concentrations) are not included in the printed report.

9. From the File menu, select Save, then select Exit to return to the Group Analysis window.

All changes you made in the Report Format Editor are saved to the report format section (.RPT) of the group file (.GRO) open in the Group Analysis window.

10. If desired, repeat step 3 through step 9 for the remaining data channels.
4.5.9 Creating a Method File (.MET) to Acquire Unknowns

**Overview**
In the previous sections you adjusted the analysis (.MTH) and report format (.RPT) parameters of the group file (.GRO) created by running your standards. Save the method file (.MET) embedded in this group file (.GRO) as a stand-alone method file (.MET). The new method file will contain the adjusted analysis and report format parameters. You will then use this new method file to acquire your unknowns.

**Creating a method file (.MET)**
To create a method file (.MET) to run your unknowns:

1. Display the Group Analysis window by selecting Group Analysis from the Window menu.
2. Open the group file for the standards by selecting Open Group from the File menu.
3. Select the individual data file (chromatogram) containing the configuration and chromatographic method you want to use to acquire your unknowns.

**NOTE:** Be sure to select an appropriate data file. If you do not, your unknowns will not be acquired under the desired conditions.
4. Select **Create Method from Group** from the Analysis menu.

A file is created and saved as a stand-alone method file (.MET) in the method directory. The new method file has:

- Same configuration (.CFG) as the active data file in the group file
- Same chromatographic method (instrument settings) as the active data file in the group file
- Any Control Panel or fraction collection events
- Same analysis parameters (.MTH), including calibration curves, and report format (.RPT) as the group file
- Same file name as the group file
- An .MET extension

5. Select **Replace All w/ Group Params** from the Analysis menu.

The analysis (.MTH) and report format (.RPT) parameters from the group file are copied into the selected data files. The calibration data files now contain all of the calibration information you created in the previous sections.

**NOTE**: The above parameters are not necessarily copied into all data files in the group. Only the data files you selected are affected. For more information, see “Selecting data files in a group file” on page 2-10.
4.5.10 Running and Quantitating Unknowns

If you run your unknowns after running your standards and generating calibration curves (as described in previous sections), there are two ways to quantitate unknowns:

- **Automatically**—Before acquisition, set the method to automatically analyze data files and print reports after running. See “Automatic quantitation” on page 4-43.

- **Manually**—After acquisition, manually analyze data files and print reports. See “Manual quantitation” on page 4-43.

**NOTE:** If you acquire your unknowns before generating a calibration curve, see “Quantitating if you acquire unknowns before generating curves” on page 4-45.
Automatic quantitation

To run and quantitate unknowns automatically:

1. Run standards, adjust parameters, and create calibration curves as described in “General Procedure” on page 4-22.

2. Display the Method Editor by selecting Method Editor from the Window menu.

3. Open the method you created in Section 4.5.9, Creating a Method File (.MET) to Acquire Unknowns.

4. Select Analyze and Print Report After Run from the Analysis menu.

5. Select Analysis Setup from the Analysis menu.

6. Select the data channels you want to analyze. Click OK.

7. Select Save from the File menu.

8. Acquire the unknowns by running the method.

   The software automatically analyzes data files generated from the unknowns and prints reports, using the adjusted analysis (.MTH) and report format (.RPT) parameters in the method file.

Manual quantitation

To run and quantitate unknowns manually:

1. Run standards, adjust parameters, and create calibration curves as described in “General Procedure” on page 4-22.

2. Display the Method Editor by selecting Method Editor from the Window menu.

3. Open the method you created in Section 4.5.9, Creating a Method File (.MET) to Acquire Unknowns.

---

**NOTE:** Do not enable Analyze and Print Report After Run in the Analysis menu.
4. Acquire the unknowns by running the method.  
The software generates data files from the unknowns.

5. Select **Group Analysis** from the Window menu.

6. In the Group Analysis window, open the **data files** generated from running the unknowns by doing one of the following:
   - If you ran the unknowns using a template or multi-method, select **Open Group** from the File menu and open the group file containing the data files.
   - If you did not run the unknowns using a template or multi-method, open the data files by selecting **Select Files** from the File menu. Add the data files to the list box, select the data files, and click **OK**.

7. Enable the **Print** check box at the top of the window.

8. Select **Analyze Individual** from the Analysis menu or click **Individual** on the ribbon at the top of the Group Analysis window.

   **NOTE:** Do not select Analyze Group. The group file may not contain the correct .MTH and .RPT parameters for the unknowns.

The software analyzes data files generated from the unknowns and prints reports, using the adjusted analysis (.MTH) and report format (.RPT) parameters in the method file.
Quantitating if you acquire unknowns before generating curves

If you acquire your unknowns at the same time you acquire your standards or before generating calibration curves, you can still quantitate your unknowns. However, you must replace the analysis (.MTH) and report format (.RPT) parameters in each data file before analyzing.

To quantitate unknowns if you acquire them before generating calibration curves:

1. Adjust parameters, and create calibration curves as described in the previous sections.

2. In the Group Analysis window, open the data files generated from running the unknowns by doing one of the following:
   - If you ran the unknowns using a template or multi-method, select Open Group from the File menu and open the group file containing the data files.
   - If you did not run the unknowns using a template or multi-method, open the data files by selecting Select Files from the File menu. Add the data files to the list box, select the data files, and click OK. Select Save Group from the File menu.

3. From the Group section of the Analysis menu, select Replace Analysis/ Report Format.

The Replace Analysis/Report Format dialog box (Figure 4-16) appears displaying the group file name you opened in step 2 in the Destination File Name text box.
4. In the Replace Analysis/Report Format Sections Dialog Box (Figure 4-16), select:

- **Destination File**—Group file created by running the unknowns. Select the group file you opened in step 2. (This is the file you want to copy the calibration curves to.)

- **Analysis Source File**—Method file you want to copy the analysis parameters (including the calibration curve) from. Select the method file created in Section 4.5.9, Creating a Method File (.MET) to Acquire Unknowns.

- **Report Format Source File**—Method file you want to copy the report format parameters from. Select the method file created in Section 4.5.9, Creating a Method File (.MET) to Acquire Unknowns.

- **Data Channels**—Select up to three (UV #1, UV #2, Auxiliary).

![Figure 4-16 Replace Analysis/Report Format Dialog Box](image)
5. Click **OK**.

   The selected analysis parameters (.MTH) and report format parameters (.RPT) are copied into the destination file.

6. Select **Replace All w/ Group Params** from the Analysis menu.

   The analysis (.MTH) and report format (.RPT) parameters from the group file are copied into the selected data files.

7. Enable the **Print** check box at the top of the window.

8. Select **Analyze Individual** from the Analysis menu or click **Individual** on the ribbon at the top of the Group Analysis window.

   The data files of the unknowns are analyzed using the calibration curve you created and the results are stored in the results section (.RST) of each data file. A report is printed for each data file, using the report format you created.
5  Exporting Data

This chapter includes the following sections:

5.1  Overview of Exporting ............................... 5-2
5.2  Exporting a Group of Data Files to Microsoft Excel ............................... 5-3
5.3  Exporting a Single Chromatogram .......... 5-13
5.4  Using Microsoft Excel .............................. 5-15
5.5  Plotting Data In Excel .............................. 5-18
5.1 Overview of Exporting

There are two ways to export:

- **Group of data files**—Export a group of data files as a Microsoft Excel file (.XLS). You export all data files in a group file and all data channels at a time. See Section 5.2, Exporting a Group of Data Files to Microsoft Excel.

- **Single chromatogram**—Export a single chromatogram as a text file (.T*) for use in Microsoft Excel. You export the chromatogram from only one data file at a time, but all data channels. See Section 5.3, Exporting a Single Chromatogram.

**NOTE**: Only Microsoft Excel 97 is supported by Applied Biosystems Data Analysis software. Microsoft Excel 97 is available as an option with the BioCAD SPRINT, BioCAD 700E, VISION, INTEGRAL 100Q workstations, and version 3.0 software upgrade packages.
5.2 Exporting a Group of Data Files to Microsoft Excel

This section describes:
- Exporting a group of data files
- Information exported

5.2.1 Exporting a Group of Data Files

**Before exporting**
Before exporting, analyze all chromatograms. For more information, see Section 4.1, Overview of Analyzing.

**Exporting a group of data files**
When you export a group of data files to Microsoft Excel from the Group Analysis window, note the following:

- The data files are exported as Microsoft Excel files (.XLS).
- All data files in the group file are exported, not just selected data files.
- All data channels can be exported to Microsoft Excel at a time. The data channels exported are the data channels you select when analyzing the data.
To export a group of data files:

1. From any window, select Group Analysis from the Window menu.
   The Group Analysis window appears.
2. Open or create a group file. For more information, see Section 2.2, Opening, Creating, and Editing a Group File. Save the group file by selecting Save Group or Save Group As from the File menu.
3. Select Export from the Analysis menu or select the Export check box on the ribbon at the top of the Group Analysis window.
4. Click Group or Individual on the ribbon at the top of the Group Analysis window to select up to three data channels to analyze and export. For more information, see Section 4.3.2, Analyzing Data Files in Group Analysis.

Analysis begins. After some time, the Spreadsheet Run Field Selection dialog box appears (Figure 5-1).

Figure 5-1 Spreadsheet Run Field Selection Dialog Box
5. Select the **run information** (fields) to export. For more information on the run fields, see Section 5.2.2, Information Exported to Excel.

If you select Sample Name, the following information is exported:

- Sample name
- Name of the first component entered in the Sample Editor
- Concentration of the first component entered in the Sample Editor

**NOTE:** Select all fields you may want to use now. After you export, you cannot add fields. You must return to Group Analysis and export again.

6. Click the **Peak Info** button.

The Spreadsheet Peak Field Selection dialog box appears (Figure 5-2).

![Figure 5-2 Spreadsheet Peak Field Selection Dialog Box](image)
7. Select the **peak information** (fields) to export for each peak in the chromatograms. For more information on the peak fields, see Section 5.2.2, Information Exported to Excel.

8. Click **OK** in both dialog boxes.

   The Microsoft Excel software opens a new worksheet named XXX.XLS, where XXX is the name of your software (BioCAD, VISION, or INTEGRAL).

9. Save the worksheet under a new name, to prevent data from being overwritten. By default, files are saved in the GROUP directory for your software. However, you can save files to any directory.

**NOTE:** For more information on using the Excel worksheet, see Section 5.4, Using Microsoft Excel.

---

**After exporting**

After exporting data files, you can plot the data as an X/Y chart or a column/line chart. For more information, see Section 5.5.1, Plotting an X/Y Chart, or Section 5.5.2, Plotting a Column/Line Chart.
5.2.2 Information Exported to Excel

All fields you can export from Group Analysis to Microsoft Excel are described in this section.

*Run information fields*

Run information fields are common to all peaks in a run.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run File</td>
<td>Full path and name of data file (*.BIO or *.B##). Always included in the first column.</td>
</tr>
<tr>
<td>Method name</td>
<td>Analysis parameters used to process data</td>
</tr>
<tr>
<td>Run Date and Time</td>
<td>Date and time of run</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Packing</td>
<td>Column packing material</td>
</tr>
<tr>
<td>Diameter (mmD)</td>
<td>Column diameter in mm</td>
</tr>
<tr>
<td>Length (mmL)</td>
<td>Column length in mm</td>
</tr>
<tr>
<td>Column Volume (ml)</td>
<td>Column volume in ml</td>
</tr>
<tr>
<td>Void Volume (ml)</td>
<td>Column void volume in ml</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Column serial number</td>
</tr>
</tbody>
</table>
### Sample Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Sample Name                  | - Name of injected sample  
- Rack position  
- Vial type  
- Name of first component (from method and system configuration in data file) |
| Sample Concentration (units) | Concentration of first component in sample in selected units (from method and system configuration in data file).                        |
| Sample Volume (µl or ml)     | Volume of sample in selected units (from method in data file).                                                                             |

### Flow Rate Information (from Data File)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow Rate (ml/min)</td>
<td>Flow rate during first elution block in method from data file.</td>
</tr>
<tr>
<td>Linear Velocity (cm/hr)</td>
<td>Linear velocity during first elution block in method from data file.</td>
</tr>
</tbody>
</table>
Peak information fields

Peak fields are specific to each peak.

<table>
<thead>
<tr>
<th>Peak Identification (from Peak Report)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Peak Number</td>
</tr>
<tr>
<td>Peak Name</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Peak Retention Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Retention Time (min)</td>
</tr>
<tr>
<td>Retention Volume (ml)</td>
</tr>
</tbody>
</table>
| $k'$ | Capacity factor, calculated by the following formula: 

\[
\frac{(Retention \ Volume - Void \ Volume)}{Void \ Volume}
\]

Void volume is equal to Column Void Volume plus system void volume between injector valve and UV detector flow cell (from system configuration in the data file). |
## Blend Values at Peak

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%A %B %C %D %E %F</td>
<td>Calculated percent of buffer/solvent channel at UV detector, at retention time.</td>
</tr>
<tr>
<td>Blend [Eluent] (units)</td>
<td>Calculated concentration of eluent in selected units at UV detector, at retention time. Only available if method is programmed in eluent mode.</td>
</tr>
</tbody>
</table>
### Monitor Values at Peak

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pH</td>
<td>pH reading at retention time of peak.</td>
</tr>
<tr>
<td>Conductivity (mS)</td>
<td>Conductivity reading at retention time of UV #1 peaks.</td>
</tr>
<tr>
<td>Pressure (units)</td>
<td>Measurement from the pressure monitor current units (in bar or psi) at retention time of peak.</td>
</tr>
<tr>
<td>UV #2</td>
<td>UV #2 channel reading at retention time of UV #1 peaks.</td>
</tr>
<tr>
<td>Auxiliary</td>
<td>Auxiliary channel reading at retention time of UV #1 peaks.</td>
</tr>
<tr>
<td>Peak Height (AU)</td>
<td>Peak height from peak report.</td>
</tr>
</tbody>
</table>

### Peak Area Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Area</td>
<td>Peak area from peak report.</td>
</tr>
<tr>
<td>Peak Area%</td>
<td>Area% of peak.</td>
</tr>
</tbody>
</table>
### Peak Width Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Width Time (min)</td>
<td>Width of peak in minutes calculated by the following formula:</td>
</tr>
</tbody>
</table>
|                                  | \[
|                                  | \text{Peak Width} = 1.6 \left( \frac{\text{Peak Area}}{\text{Peak Height}} \right) \text{Time} \] |
| Peak Width Volume (ml)           | Width of the peak in ml. Equal to:                                          |
|                                  | \text{Peak Width Time} \times \text{Flow Rate (at retention time)}          |
| Plate Count (plates)             | Theoretical plate count based on the selected peak, calculated by the      |
|                                  | following formula:                                                          |
|                                  | \[
|                                  | \text{Plate Count} = 6.28 \times \left( \frac{\text{Retention Time} \times \text{Peak Height}}{\text{Peak Area}} \right)^2 \] |
| Efficiency (plates/m)            | Efficiency = Plates/meter                                                    |
| Asymmetry                        | B/A                                                                          |
|                                  | where:                                                                       |
| B                                | t_E - t_R                                                                     |
| A                                | t_R - t_S                                                                     |
| t_E                              | time at peak end                                                             |
| t_R                              | time at peak apex (retention time)                                          |
| t_S                              | time at peak start                                                           |
5.3 Exporting a Single Chromatogram

When you export a chromatogram from the Group Analysis window, note the following:

- The chromatogram is exported as a text file (.TXT) that you can later open and plot in Microsoft Excel.
- Only one chromatogram can be exported at a time.
- All data channels from a single chromatogram are exported. Data is exported at the data rate you select.

To export a chromatogram from the Group Analysis window for plotting in Microsoft Excel:

1. From any window, select Group Analysis from the Window menu.
   The Group Analysis window appears, with no data displayed.

2. Open or create a group file or open a data file. For more information, see Section 2.2, Opening, Creating, and Editing a Group File. Save the group file by selecting Save Group or Save Group As from the File menu.

3. Select Tiled mode from the Display menu.

4. Select the chromatogram to export.

**NOTE:** Only the selected chromatogram is exported, not all chromatograms in the group file.

5. Select Export Chromatogram from the Analysis menu or click [Export Chromatogram] on the ribbon at the top of the Group Analysis window.

The Export Chromatogram dialog box appears.
Figure 5-3  Export Chromatogram Dialog Box

6. Select a data rate (points per second) for exporting and click OK.

All channels of the selected chromatogram are exported to the original directory in which the data file is stored, with the following naming conventions:

<table>
<thead>
<tr>
<th>If the data file is named</th>
<th>Exported chromatogram is named</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMPLE.BIO</td>
<td>SAMPLE.TXT</td>
</tr>
<tr>
<td>SAMPLE.B01, SAMPLE.B02, and so on</td>
<td>SAMPLE.T01, SAMPLE.T02, and so on</td>
</tr>
</tbody>
</table>

**NOTE:** The exported file contains tab delimiters.

Exported chromatograms in Excel

Open the text file (.T*) in Microsoft Excel and plot using the Chromatogram command on the VISION, BIOCAD, or INTEGRAL menu. For more information, see Section 5.5.3, Plotting Chromatogram Charts.
5.4 Using Microsoft Excel

This section gives you a quick introduction to Microsoft Excel and instructions on how to use the Excel worksheet you generate when exporting a group of data files from the Group Analysis window.

For detailed instructions on using the Excel software, see the user’s guide provided with your system.

Export data files to the Excel spreadsheet using Group Analysis, described in Section 5.2, Exporting a Group of Data Files to Microsoft Excel. Exported fields are described in Section 5.2.2, Information Exported to Excel. A blank Excel worksheet is shown in Figure 5-4.

![Blank Excel Worksheet]

Figure 5-4  Blank Excel Worksheet
Chapter 5 Exporting Data

A typical Excel worksheet generated from the Group Analysis window is shown in Figure 5-5.

Exported run data is listed in the far left columns, then exported peak data is listed in columns to the right.

Each row contains data for an individual peak. Peaks from each data file are grouped together, with a blank row separating data files.

**Figure 5-5 Typical Excel Worksheet Generated From Group Analysis Window**
Inserting rows and columns
You can insert rows and columns in the worksheet, and change data to suit your needs. Follow these guidelines to insert rows and columns:

- Insert columns to the left or immediate right of the last column of data.
- Insert rows above or immediately below the last row. Inserting columns or rows past these end points produces unpredictable results when you run the special macro.

You can enter data in rows and columns you insert. For example, to add additional data for each peak, insert a column, and enter the name of the field in Row 4. If units are associated with the field, enter them (in parentheses) in Row 3. Enter data in the column.

Special macro menu
The Excel worksheet generated from the Group Analysis window includes a menu named for your software, for example, VISION, BIOCAD, or INTEGRAL. Use the special macro menu to plot data.

Saving data in different formats
To transfer Excel data to other programs, you can save spreadsheet data in different formats, including WK* and .DIF. When you save to a different format, only data is saved. The special macro sheet and generated charts are not saved in the new format.

To save data in different formats, select Save As from the File menu. Select the format from the Save File as Type drop-down list.
5.5 Plotting Data In Excel

The special macro menu (VISION, BIOCAD, or INTEGRAL menu) in the Excel window, lets you create charts and plot data. Three kinds of charts are available:

- **XY Chart**—Graphs data exported from Group Analysis. For more information on exporting, see Section 5.2, Exporting a Group of Data Files to Microsoft Excel.

- **Column/Line Chart**—Creates bar and line charts using data exported from Group Analysis. For more information on exporting, see Section 5.2, Exporting a Group of Data Files to Microsoft Excel.

- **Chromatogram**—Creates a chromatogram using chromatogram exported from Group Analysis. For more information on exporting, see Section 5.3, Exporting a Single Chromatogram.

You can also modify charts in Excel.

5.5.1 Plotting an X/Y Chart

To plot an X/Y chart for an exported group of data files:

1. Select the **X/Y Chart** from the special macro menu on your system (VISION, BIOCAD, or INTEGRAL menu).

   The X-Y Plot dialog box appears (Figure 5-6).
2. Select the **X-axis variable**, **Y-axis variable**, and **series identifier** for the chart. Series identifier is the parameter for which you are plotting X and Y axis values (for example, Peak Number).

   **NOTE:** Only the fields you exported are available for plotting. If the desired field is not listed, return to the Group Analysis window and export again.

3. Click **OK**. The special macro finds all unique values of the series identifier field, and allows you to select the ones to plot. Select the series and click **OK**.

   **Hint:** To select more than one series, hold down the Shift or Control key when you click.

Before plotting, the software extracts the information you specified for plotting and copies the data into rows below the main worksheet. Then the X/Y chart is plotted in a new window. Figure 5-7 is an example XY chart that plots Peak Area versus Sample Volume for Peak Numbers 1 through 5.
4. Save the chart by selecting **Save** from the File menu.

   **NOTE:** When you select Save, a message is displayed stating that the chart was created in a previous version of Excel. Click **Yes** to update the chart to Microsoft Excel 97 format.

5. Print the chart by selecting **Print** from the File menu.

6. Close the chart by selecting **Close** from the File menu.

7. To return to the Group Analysis window, you can:
   - Select **Exit** from the File menu (closes the Excel software)
   - Minimize the Excel window by clicking on the **Minimize** button in the top right corner of the window (does not close the Excel software)
5.5.2 Plotting a Column/Line Chart

To plot a column/line chart for an exported group of data files:

1. Select the **Column/Line Chart** from the special macro menu on your system (VISION, BIOCAD, or INTEGRAL menu).

   The Column/Line Chart dialog box appears (Figure 5-8).

2. Select:
   
   - **Category**—X-axis variable
   - **Charted variable**—Y-axis variable
   - **Series**—Parameter for which you are plotting X and Y axis values (for example, Peak Number)
3. Click **OK**. The special macro finds all unique values of the series identifier field, and allows you to select the ones to plot. Select the series and click **OK**.

**Hint:** To select more than one series, hold down the Shift or Control keys when you click.

Before plotting, the software extracts the information you specified for plotting and copies the data into rows below the main worksheet. Then the chart is plotted in a new window.

Figure 5-9 through Figure 5-11 are examples of a bar chart, stacked bar chart, and line chart that plot Peak Number versus Peak Area for Sample Volumes of 10 and 20 µl.

![Figure 5-9 Example Bar Chart](image)
Plotting Data In Excel

Figure 5-10  Example Stacked Bar Chart

Figure 5-11  Example Line Chart
4. Save the chart by selecting **Save** from the File menu.

**NOTE:** When you select Save, a message is displayed stating that the chart was created in a previous version of Excel. Click **Yes** to update the chart to Microsoft Excel 97 format.

5. Print the chart by selecting **Print** from the File menu.

6. Close the chart by selecting **Close** from the File menu.

7. To return the Group Analysis window, you can:
   - Select **Exit** from the File menu (closes the Excel software)
   - Minimize the Excel window by clicking on the **Minimize** button in the top right corner of the window (does not close the Excel software)
5.5.3 Plotting Chromatogram Charts

Chromatogram charts allow you to easily export chromatograms into other Windows programs such as word processors, graphics programs, and desktop publishing programs.

This section describes:
- Opening an exported file in Excel
- Plotting a Group Analysis chromatogram

Opening an exported file in Excel

To open an exported file in Excel:

1. Export the chromatogram. See Section 5.3, Exporting a Single Chromatogram.

2. Open the Excel software by selecting Microsoft Excel from the Window menu in the Control Panel.

3. Open the exported file by selecting Open from the File menu. The exported file is stored in the same directory as the original data file. The file has the same name as the original data file, but with a .TXT or .T01, .T02 and so on extension.

Plotting a Group Analysis chromatogram

After opening the exported file in Excel:

1. From the special macro menu (VISION, BIOCAD, or INTEGRAL menu), select Chromatogram.

The Chromatogram Setup dialog box appears (Figure 5-12).
Figure 5-12 Group Analysis Chromatogram Setup

*NOTE:* In chromatogram charts, the X-axis is plotted in time and the Y-axis is plotted in AU at the wavelength of the data channel selected before analyzing.

2. Select the following:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Scale</td>
<td>Minutes or seconds.</td>
</tr>
<tr>
<td>2nd Y Axis</td>
<td>Values to plot on the right axis.</td>
</tr>
<tr>
<td>1st Y Axis</td>
<td>Additional values to plot on the left axis. (UV Channel #1 is always plotted.) The left axis in the plot is always labeled with the wavelength for UV Channel #1. The label you select here is not displayed. If you do select a 1st Y axis, the scale of the Y-axis is expanded to accommodate both traces being plotted.</td>
</tr>
</tbody>
</table>
3. Click **OK**.

The software creates a chromatogram in an Excel X/Y chart. You can customize the chart, save it, and import it into other programs, or transfer it using the Windows Clipboard.

![Chromatogram Exported from Group Analysis](image)

**Figure 5-13 Chromatogram Exported from Group Analysis**
5.5.4 Modifying a Chart

If necessary, you can change a chart. You can change:

- **Ranges for the axes**—Double-click on the axis to modify. The Patterns dialog box is displayed. Click the **Scale** button and enter new values for Minimum and Maximum. Click **OK**.

- **Labels for the axes**—Display the worksheet by selecting it from the Window menu. Highlight the label (in Row 4 at the top of the worksheet), and type in the new label. After typing the change, press **Enter**. (You can also click the Check Mark at the top of the window.) To view the chart again, select it from the Window menu.

**NOTE:** Axis labels displayed in the chart are taken from the worksheet. Do not change the axis labels in the chart, change them in the worksheet.

- **General formatting**—Use the **Modify Template** command (see below).

- **Chart annotations**—Use the Excel drawing tools.
5.5.5 An Excel Example

This Excel example shows data exported from a Loading Study template. The loading study tests for capacity of an affinity column.

In this example, the following data was exported:

- Sample Volume
- Peak Number
- Peak Area

![Excel Spread Sheet](image)

**Figure 5-14 Excel Spread Sheet**

**Plotting**  
To plot the data:

1. Select X/Y Chart from the special macro menu (VISION, BIOCAD, or INTEGRAL menu).

2. In the X-Y Plot dialog box (Figure 5-6), select:
   - X Variable—**Sample Volume**
   - Y Variable—**Area**
   - Series Identifier—**Peak Number**
3. For Series to Be Plotted, select **Peak #1**.

   The following X/Y chart is plotted.

   ![Excel Chart of Area versus Sample Volume](image)

   **Figure 5-15 Excel Chart of Area versus Sample Volume**
Adjusting Processing Parameters

This chapter includes the following sections:

6.1 Overview of Processing Parameters .................... 6-2
6.2 Adjusting Processing Parameters ....................... 6-4
  6.2.1 Adjusting Peak Detection and Integration Parameters .......... 6-11
  6.2.2 Adjusting Baseline Timed Events ............................ 6-14
  6.2.3 Selecting Optional Reports ............................. 6-19
  6.2.4 Editing Replot Parameters ............................. 6-23
  6.2.5 Running User Programs ............................... 6-29
6.1 Overview of Processing Parameters

Overview
This chapter explains how to use the Text Method Editor to adjust processing parameters in the analysis section (.MTH) of a method file (.MET), data file (.B*), or group file (.GRO).

You can also use the Text Method Editor to adjust calibration parameters in the analysis section (.MTH) of a method file (.MET), data file (.B*), or group file (.GRO). For more information, see Chapter 7, Adjusting Calibration Parameters.

You can graphically adjust processing parameters by manipulating a chromatogram in the Graphic Method Editor. For more information, see Chapter 9, Adjusting Analysis Parameters Graphically.

**Figure 6-1 Processing Parameters**

- MET, B*, or GRO File
- MTH Analysis parameters:
  - Processing parameters (peak detection/integration)
  - Calibration parameters (calibration components)
- RPT Report Format parameters
What are processing parameters?
The analysis section (.MTH) of a method, data, or group file contains default processing parameters (Figure 6-1) that control the following steps in data analysis:

- How peaks are detected and integrated
- How optional reports and replots are printed
- Which user programs are run at which point in the data analysis process

You can adjust processing parameters for five processing functions:

- Integration
- Baseline Timed Events
- Optional Reports
- Replot
- User Programs

NOTE: You can change the default processing parameters by editing the DEFAULT.MTH file. For more information, see “Editing DEFAULT.MTH” on page 6-10.

Replacing processing parameters
In addition to adjusting processing parameters, you can also replace processing parameters in a file by copying the parameters from another file. For more information, see “Replacing parameters” on page 4-4.
6.2 Adjusting Processing Parameters

You develop and modify processing parameters using the commands in the Process menu in the Text Method Editor.

To adjust processing parameters in the analysis section (.MTH) of a method file (.MET), data file (.B*), or group file (.GRO):

1. Access the Text Method Editor by doing one of the following in your BioCAD, VISION, or INTEGRAL software:

   **CAUTION**
   Once you access the Text Method Editor, changes you make and save overwrite the contents of the file you open in this step. If you want to make changes to the file and save under a different name, select **Save As** or **Save Group As** now, before selecting Adjust Analysis Parameters.

   **From Method Editor**
   - Display the Method Editor by selecting **Method Editor** from the Window menu. Open a method file (.MET). Select **Adjust Analysis Params** from the File menu.

   **From Group Analysis**
   - Display the Group Analysis window by selecting **Group Analysis** from the Window menu. Open a data file (.B*) or group file (.GRO). Select **Adjust Analysis Params** from the Individual or Group section of the Analysis menu.

   **NOTE:** Select Adjust Analysis Parameters from the Individual section to adjust the processing parameters of a single data file. Select Adjust Analysis Parameters from the Group section to adjust the processing parameters of a group file.
NOTE: If the Adjust Analysis Params command does not appear in the Individual section of the Analysis menu, select Tiled Mode from the Display menu.

The Adjust dialog box appears (Figure 6-2).

![Adjust Dialog Box](image)

**Figure 6-2 Adjust Dialog Box**

**Selecting a data channel**  
2. Select a data channel for which you want to change processing parameters.  
3. Click OK to display the Text Method Editor, Method Summary, and Component List windows (Figure 6-3).

The file (.MET, .B*, or .GRO) you selected in step 1 appears in the title bar, augmented with the selected data channel and an .MTH extension.
The Method Summary displays information about the instrument settings associated with the file that is currently active.

**NOTE:** To view the Method Summary or Component List window, select **Method Summary** or **Component List** from the Window menu. You can control these windows by clicking to minimize, clicking to resize, or clicking to maximize.
Adjusting processing parameters

4. In the Text Method Editor, select **Integration** from the Process menu.

The Process dialog box opens to the Integration tab (Figure 6-4).

![Process Dialog Box (Integration Tab)](image)

Figure 6-4  Process Dialog Box (Integration Tab)
5. Set peak detection and integration parameters.
   Peak detection parameters include:
   - Bunching factor
   - Noise threshold
   - Area threshold

   Peak integration parameters include:
   - Peak separation criteria
   - Exponential skim criteria

   For more information, see Section 6.2.1, Adjusting Peak Detection and Integration Parameters.

6. Click the Baseline Timed Events tab and set baseline timed events that determine how the software processes data. For more information, see Section 6.2.2, Adjusting Baseline Timed Events.

7. Click the Optional Reports tab to specify up to six different types of reports that will be printed, in addition to the main report specified in the report format section (.RPT) of the method, data, or group file. For more information, see Section 6.2.3, Selecting Optional Reports.

8. Click the Replot tab to set the characteristics of the chromatogram the software produces after analyzing a raw data file.
   Replot parameters include:
   - Scaling factors
   - Offsets
   - Plot title
   - X/Y axis labeling information

   For more information, see Section 6.2.4, Editing Replot Parameters.

9. Click the User Programs tab to specify the file names of the programs you want to run during or after data analysis. For more information, see Section 6.2.5, Running User Programs.
NOTE: Once you modify the analysis section of a method file (.MET), data file (.B*), or group file (.GRO), the word MODIFIED appears at the right of the status bar of the Text Method Editor (Figure 6-3). The word MODIFIED remains there until you select Save from the File menu in the Text Method Editor.

10. After making changes to the values in the dialog box, do any of the following:

   • To save your work and close the dialog box, select OK.
   • To save your work without closing the dialog box, select Apply.
   • To close the dialog box and discard your changes since the last time you chose Apply, select Cancel.

11. Select Save from the File menu to save any changes.

CAUTION
Once you select Save, the changes you made overwrite the contents of the file you opened in step 1.

The Documentation dialog box or the Audit Trail dialog box opens.

NOTE: Documentation and Audit Trail information are not supported in this version of software.

12. Click OK to close the dialog box.

13. Select Exit from the File menu to close the Text Method Editor, and return to the Method Editor or Group Analysis window.
Opening additional files

You can not open additional data files, group files, or method files from within the Text Method Editor. If you try to open one of these files, an error message is displayed.

To open a different data file, group file, or method file:
1. Return to the Method Editor or Group Analysis window.
2. Repeat the procedure starting on page 6-4.

Unsupported commands

The following commands in the Text Method Editor are not supported:

- **File menu**—New, Open, Import, Save As, Description, Audit Trail, Review
- **Instrument menu**—All commands
- **Other menu**—Sequence Editor

**NOTE:** You can use the Open command under the File menu to edit the default analysis parameters file, as described below.

Editing DEFAULT.MTH

When you create a new method file (.MET) or group file (.GRO), default parameters are loaded from the default analysis parameters file, DEFAULT.MTH, which is located in C:\PENEXE\TCWS\VER6.1.0\CONFIG\USER\PERSEPTIVE.

To edit DEFAULT.MTH, access the Text Method Editor, open DEFAULT.MTH by selecting **Open** from the File menu, edit it as desired, and save it. The software will prompt you to verify that you want to change the default analysis parameters file.
6.2.1 Adjusting Peak Detection and Integration Parameters

The Integration command in the Process menu lets you enter the parameters that affect peak detection and integration.

- **Peak detection**—The process by which the software examines raw data points to determine where peaks exist. Your entries for basic integration parameters are used in this process.

- **Peak integration**—The process of determining peak area. Your entries for advanced integration parameters are used in this process.

For technical information about peak detection and peak integration and how baseline timed events affect them, refer to Appendix A, Discussion of Data Analysis.

**NOTE:** You seldom need to modify the advanced parameters because their values have been optimized for normal chromatographic situations. Modify these values with caution. If you change these parameters without fully understanding the potential consequences, you might obtain invalid results.
To edit peak detection and integration parameters:

1. Select **Integration** from the Process menu to open the Process dialog box or, if the Process dialog box is already open, click the **Integration** tab.

![Figure 6-5 Process Dialog Box (Integration Tab)](image)

2. In the Bunching Factor text box, type the number of successive raw data points you want to average to establish a single bunched data point.

3. In the Noise Threshold text box, type a value that helps determine the difference between baseline noise and the start of a peak.
4. In the Area Threshold text box, type a value that helps discriminate between noise spikes and peaks.

   As a general rule, set the area threshold to approximately five times the noise threshold. However, the optimal ratio depends on the actual peak size and signal-to-noise ratio.

5. Under Peak Separation Criteria, type a value for Width Ratio and Valley-To-Peak Ratio.

6. Under Exponential Skim Criteria, type a Peak Height Ratio, Adjusted Height Ratio, and Valley Height Ratio.

7. To restore the parameters in the dialog box to the system defaults, click Reset.
6.2.2 Adjusting Baseline Timed Events

Baseline timed events alter the way the software detects and integrates peaks during the analysis. You can use baseline timed events to help maintain consistent results when peak characteristics and baseline characteristics change.

Although you can set timed events in the analysis section of a method file or data file, you can also add them directly to the chromatogram by using the Graphic Method Editor. Using the Graphic Method Editor helps you see how adding one or more baseline timed events affects the run. For more information about the Graphic Method Editor, see Chapter 9, Adjusting Analysis Parameters Graphically.

The following sections describe how to:

- Add baseline timed events
- Edit baseline timed events
- Delete baseline timed events
To add baseline timed events:

1. Select **Baseline Timed Events** from the Process menu to open the Process dialog box, or if the Process dialog box is already open, click the **Baseline Timed Events** tab.

![Figure 6-6 Process Dialog Box (Baseline Timed Events Tab)](image)

2. In the Time text box, type the **time** at which you want this event to occur.
3. From the Event list, select a **timed event**. Choices are:

<table>
<thead>
<tr>
<th>Event</th>
<th>Value</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set bunch factor to value</td>
<td>1 – 99</td>
<td>BF</td>
</tr>
<tr>
<td>Set noise threshold to value</td>
<td>1 – 999999</td>
<td>NT</td>
</tr>
<tr>
<td>Set area threshold to value</td>
<td>5 – 10^{15}</td>
<td>AT</td>
</tr>
<tr>
<td>Enable peak detection</td>
<td>-</td>
<td>+P</td>
</tr>
<tr>
<td>Disable peak detection</td>
<td>-</td>
<td>−P</td>
</tr>
<tr>
<td>Enable negative peak detection</td>
<td>-</td>
<td>+N</td>
</tr>
<tr>
<td>Disable negative peak detection</td>
<td>-</td>
<td>−N</td>
</tr>
<tr>
<td>Inhibit end of peak detection</td>
<td>-</td>
<td>+I</td>
</tr>
<tr>
<td>Allow end of peak detection</td>
<td>-</td>
<td>−I</td>
</tr>
<tr>
<td>Turn on non-forced common baseline</td>
<td>-</td>
<td>+CB</td>
</tr>
<tr>
<td>Turn off non-forced common baseline</td>
<td>-</td>
<td>−CB</td>
</tr>
<tr>
<td>Force the end of current peak</td>
<td>-</td>
<td>E</td>
</tr>
<tr>
<td>Force start of new peak</td>
<td>-</td>
<td>S</td>
</tr>
<tr>
<td>Force baseline to current point</td>
<td>-</td>
<td>BL</td>
</tr>
<tr>
<td>Force horizontal forward baseline</td>
<td>-</td>
<td>+HF</td>
</tr>
<tr>
<td>Stop horizontal forward baseline</td>
<td>-</td>
<td>−HF</td>
</tr>
<tr>
<td>Force horizontal backward baseline</td>
<td>-</td>
<td>HR</td>
</tr>
<tr>
<td>Start manual integration window</td>
<td>-</td>
<td>+M</td>
</tr>
<tr>
<td>End manual integration window</td>
<td>-</td>
<td>−M</td>
</tr>
</tbody>
</table>

*Continued*
4. In the Value text box, type a **value**, if required.

5. Select **Correct Actual Times Of All Baseline Events Based On Actual RT Of Nearest Reference Peak** if you want your baseline timed events to shift in proportion to the shift of the retention time of the nearest reference peak.

6. Click **Add** to add this event to the Defined Events list.

---

**Event | Value | Code**
--- | --- | ---
Turn on valley-to-valley baselines | - | +V
Turn off valley-to-valley baselines | - | –V
Force an exponential skim | - | +X
Prevent an exponential skim | - | –X
Force a tangential skim | - | T
Smooth Peak Ends On | - | +SM
Smooth Peak Ends Off | - | –SM
Force retention time of current peak to be the event time | - | RT
Locate peak retention time at the maximum data point | - | LM
Force a baseline at any point in data file | - | UF

*NOTE:* This table provides a brief description of each timed event. The code column indicates the corresponding baseline timed event code that appears on the chromatogram in the Graphic Method Editor. For technical information about these events, see Section A.3.3, How Timed Events Affect Peak Detection, and Section A.4.5, How Timed Events Affect Integration.
Editing a baseline timed event

You can also edit or delete the timed events once you have added them.

To edit a timed event:
1. In the Defined Events list, select an event to edit.
2. Type the new time or value in the Time or Value text boxes.
3. Click Change.

Deleting a baseline timed event

To delete a timed event:
1. In the Defined Events list, select the event you want to delete.
2. Click Delete to delete the selected event, or click Clear List if you want to delete all timed events.
6.2.3 Selecting Optional Reports

**Overview**
You can generate up to six additional reports. These reports can be formatted according to the report format parameters that define the layout of the report. If you want to only print the reports generated by the report format files specified in the method file (.MET), leave the text fields on the Optional Reports tab blank.

**Before you begin**
Before specifying optional reports, you must first use the Report Format Editor to save stand-alone .RPT files that you then specify in the Optional Reports tab of the Process dialog box. For more information on how to create a report format file, see Chapter 8, Adjusting Report Format Parameters.

**Generating and printing reports**
To generate and print additional reports:

1. Select **Optional Reports** from the Process menu to open the Process dialog box, or if the Process dialog box is already open, click the **Optional Reports** tab (Figure 6-7).
2. Under Report Format Or Template Files, select a field and click the Report option button (the left button) to select .RPT files.

3. Locate and select the file that you want to use and click OK.

   The software inserts the path and file name of the file that you selected in the report format field.

---

Figure 6-7 Process Dialog Box (Optional Reports Tab)
4. Under Options For Selected Report, do one of the following:

- To save the report to a file, click the Folder icon. In the Open dialog box, type or select an output file name where you want to store the report and click OK.

- To print the report, click the Printer icon. In the Printer Select dialog box, select a printer and click OK.

See your application manager for information about default and other printers.

The software inserts the output information that you selected in the Output field.

5. If you are printing the report, specify the number of copies you want to print in the Copies text box.

6. If you are saving the report in a file, select Append to Existing Results to add the report to the current output file that you specified in step 4.

---

**CAUTION**

*If you clear this box, the software overwrites the contents of the output file.*

---

**Specifying plot settings**

To specify plot settings:

1. Click the Plot Settings button to open the Plot Settings dialog box.
2. In the Plot Number list, select the plot to which you want the current settings to apply.

3. To plot all data that collected during the run, select **Set Plot Limits To Full Run**.

   If you clear this option, the software only plots the data in the range that you define in the Start Time and End Time text boxes.

4. Under **Scaling Type**, select whether to use Vertical, Autozero, or Absolute Scaling.

   These options and the necessary Scale Factors are defined in Section 6.2.4, Editing Replot Parameters.

5. In the Scale Factor text box, type the corresponding factor for the Scaling Type you chose in step 4.

6. Click **OK** to save the settings and return to the Optional Reports tab.
6.2.4 Editing Replot Parameters

The Replot command in the Process menu lets you specify how the replot appears when you print it. The settings include paper orientation, what portion of the plot you want to print, labeling information, and scaling parameters.

You can produce replots in two different ways:

- You can print one or two chromatograms on one or more pages in portrait or landscape format.
- You can embed a portrait-formatted replot within a report where both appear on a single page.

Although you select the embedded replot option in the Report Format Editor (see Chapter 8, Adjusting Report Format Parameters), the software uses the analysis parameters (.MTH) embedded in the file.
To edit replot parameters:

1. Select Replot from the Process menu to open the Process dialog box, or if the Process dialog box is already open, click the Replot tab.

![Process Dialog Box (Replot Tab)](image)

2. To suppress printing of a full-page plot after data analysis, deselect the Generate A Separate Replot check box and skip to step 8.

   If you deselect this option, you can still enter parameter values that will affect a replot embedded in the report.

3. In the Number of Pages text box, type the number of pages on which you want the replot(s) to appear.

   This option enables you to display more detail than if you print the replot on a single page. This option is only available if you select Generate A Separate Replot.

Figure 6-9 Process Dialog Box (Replot Tab)
4. To print two plots with different scale factors on the same page, select Generate Second Plot, and then type a Scale Factor for the second plot.

   All other replot parameters are shared between the two plots.

5. Under Orientation, select Portrait or Landscape.
   - **Portrait**—Prints the plots so that the X-axis spans the width of the page.
   - **Landscape**—Prints the plots so that the X-axis spans the length of the page.

6. Under Retention Labels, select a label position option.
   
   Labels do not overlap if you place them at the top of the plot. If they are close enough to overlap, some labels will be omitted. All labels at the tops of peaks are shown, even if they overlap.

7. Under Component Labels, select an option to specify how you want component names to appear on the replot.
   - **None**—Suppresses all component names on the replot.
   - **Expected Time**—Includes the names of all expected components on the replot, whether or not a corresponding peak is present. The component name appears at the expected retention time for the component.
   - **Actual Time**—Positions component names under the corresponding peak at its actual retention time. If no peak corresponds to an expected component, the component name does not appear on the replot.
8. Under Miscellaneous, do one of the following:
   - To print the whole chromatogram, select **Set Plot Limits To Data Limits**.
   - To specify a particular time period for the replot, deselect Set Plot Limits To Data Limits, and then type the **Start Time** and **End Time** to designate which portion of the plot you want to print.

9. In the Plot Title text box, type the **name** you want to appear on the replot(s).

   This option is not available for a replot that is embedded in a report.

10. In the X-Axis Label text box, type the **label** you want to use for the time axis of the replot(s).

11. In the Y-Axis Label text box, type the **label** you want to use for the response axis of the replot(s).

12. Select **Draw Baselines** if you want to print baselines for each peak.

13. Select **Timed Events** if you want each timed event to appear on the printed replot(s).

14. Under Scaling Type, select the **scaling option** you want to use for the replot(s).

   - **Vertical Scaling**—Scales the plot so that the largest peak prints at full scale.
   - **Autozero Offset**—Scales the plot so that the Y-axis minimum data point value is at 5 percent of full scale. The software determines the Y-axis maximum based on the value you type in the Full Scale text box.
   - **Absolute Scaling**—Lets you type precise full-scale and offset values. In this case, the Y-axis minimum is equal to the Offset value and the range of the Y-axis is equal to the Full Scale value.
15. Based on your choice in step 14, do one of the following:

- If you selected Vertical Scaling, type a value in the Scale Factor text box.
- If you selected Absolute Scaling, type a value in the Offset text box.
- If you selected Autozero Offset or Absolute Scaling, type a value in the Full Scale text box.

**About scaling types**

The Vertical Scaling, Autozero Offset, and Absolute Scaling parameters all determine the scaling of the voltage axis. This section provides additional information on these parameters.

**Vertical Scaling**

If you select this option, the voltage scale will be relative—it will be based on the maximum and minimum points in the chromatogram. With relative scaling, you type a scale factor that determines the relationship between the data limits and the voltage scale. For example, if the scale factor is 1, the maximum data value minus the minimum data value will set the raw scale. If the scale factor is 2, the initial scale will be equal to the difference divided by 2. The plot or final scale is set by the plot offset which adjusts the initial scale by five percent to keep the chromatogram on the page.

The relationship between the plot scale, plot offset, reported high point and reported low point is shown below:

\[
\text{Scale}_{\text{initial}} = \frac{\text{Maximum} - \text{Minimum}}{\text{Scale Factor}}
\]

\[
\text{Scale} = \text{Scale}_{\text{initial}} + 0.05 \times \text{Scale}_{\text{initial}}
\]

\[
\text{Offset} = \text{Minimum} - 0.05 \times \text{Scale}_{\text{initial}}
\]

\[
\text{High Pt}_{\text{Plot}} = \text{Scale} + \text{Offset}
\]

\[
\text{Low Pt}_{\text{Plot}} = \text{Offset}
\]
If the data maximum is 1000 mAU, the minimum is 50 mAU, and the scale factor is 2, then the initial scale will be 475 mAU. The plot scale will be 498.75 mAU (rounded to 499 mAU in the plot header). The plot offset will be 26.25 mAU, rounded to 30 mAU. The high point reported on the plot header will be 525 mAU. The low point reported on the plot header will be 26.25 mAU, rounded to 26.3 mAU.

**Auto-Zero Plot Offset**

If you select this option, type the absolute plot scale. The lowest point will be calculated from the minimum data value as follows.

\[
\begin{align*}
Scale &= \text{User-entered Scale} \\
Offset &= \text{Minimum} - 0.05 \times \text{Scale} \\
High \ Pt_{\text{plot}} &= Scale + Offset \\
Low \ Pt_{\text{plot}} &= Offset
\end{align*}
\]

If you type 1000 mAU as the scale, and the minimum data value is 50 mAU, the plot scale will be 1000 mAU and the plot offset will be 26.25 mAU (rounded to 30 mAU in the header). The high point will be reported as 1026.25 mAU (rounded to 1026.3 mAU). The low point will be reported as 26.25 mAU (rounded to 26.3 mAU).

**Absolute Scaling**

If you select this option, you then type an absolute plot scale and offset. The software makes no adjustments to the bottom of the plot.

\[
\begin{align*}
Scale &= \text{User-entered Scale} \\
Offset &= \text{User-entered Offset} \\
High \ Pt_{\text{plot}} &= Scale + Offset \\
Low \ Pt_{\text{plot}} &= Offset
\end{align*}
\]
6.2.5 Running User Programs

The User Programs command in the Process menu allows you to run up to five other programs during data analysis. The entry points for the programs can be:

- After baseline subtraction
- After peak detection or integration
- After component identification
- After calibration
- After quantitation
- After report generation
- After replot generation

You can also synchronize these programs with data analysis. Synchronization allows you to execute user programs during predefined stages of data analysis.

**Specifying User Programs for method files and data files**

*NOTE: If you are specifying User Programs in the analysis parameters (.MTH) of a method file (.MET), make sure your method specifies to print chromatograms after analysis. For more information, see Section 4.3.1, Specifying Automatic Analyzing and Printing in the Method Editor.*

*If you are specifying User Programs in the analysis parameters (.MTH) of a data file (.B*), make sure you print chromatograms after analysis. For more information, see Section 4.3.2, Analyzing Data Files in Group Analysis, or Section 4.3.3, Analyzing and Printing in the Control Panel.*
To run user programs in conjunction with analysis:

1. Select **User Programs** from the Process menu to open the Process dialog box, or if the Process dialog box is already open, click the **User Programs** tab.

![Figure 6-10 Process Dialog Box (User Programs Tab)](image)

2. Click the **folder icon** to select the **name of the program** to run during data analysis.
3. In the Command Line text box, type the **information** you want to pass to the user program.

   To pass the names of files that the software uses or generates during the run, use the variables shown below. When a user program runs, it adds the command line by taking the specified information and providing file name substitution for the variables as follows:

   - **$RAW**—Full path and file name of the temporary raw data file
   - **$RST**—Full path and file name of the temporary result data file
   - **$MET**—Full path and file name of the temporary analysis parameters file (.MTH)

4. In the Execute After list box, select the point during data analysis at which you want to run the program.

   **NOTE:** The “Synchronize With Data Analysis” feature is not supported in this version of software.
5. Repeat step 2 through step 4 for each program you want to use.
This chapter includes the following sections:

7.1 Overview of Calibration Parameters .......... 7-2
7.2 Adjusting Calibration Parameters ............. 7-4
7.3 Understanding Global Calibration Parameters................................................. 7-9
7.4 Editing Global Calibration Information...... 7-13
7.5 Understanding Component Parameters ... 7-15
7.6 Setting Component Defaults .................. 7-28
7.7 Adding and Editing Components............. 7-39
7.8 Loading and Merging Components From Files ........................................... 7-54
7.9 Deleting Components .......................... 7-57
7.10 Changing Parameters for Multiple Components Simultaneously ............... 7-58
7.11 Performing a Manual Calibration .......... 7-61
7.1 Overview of Calibration Parameters

Overview
This chapter explains how to use the Text Method Editor to adjust calibration parameters in an analysis section (.MTH) of a method file (.MET), or data file (.B*), or group file (.GRO).

You can also use the Text Method Editor to adjust processing parameters in the analysis section (.MTH) of a method file (.MET), data file (.B*), or group file (GRO). For more information, see Chapter 6, Adjusting Processing Parameters.

You can graphically adjust calibration parameters by manipulating a chromatogram in the Graphic Method Editor. For more information, see Chapter 9, Adjusting Analysis Parameters Graphically.

Figure 7-1 Calibration Parameters
Overview of Calibration Parameters

What are calibration parameters?

The analysis section (.MTH) of a method, data, or group file contains default calibration parameters (Figure 7-1). These calibration parameters identify and calibrate the components that the software analyzes. Calibration parameters are divided into two groups:

- **Global parameters**—Apply to the analysis as a whole
- **Component parameters**—Define the specific calibration treatment for each peak in the analysis

Calibration parameters include a component list and parameters that determine how the software matches peaks with named components. Calibration parameters, which apply only to components being analyzed by the method, include component names, expected retention times, and calibration data (the responses produced by different component amounts). Calibration parameters also include parameters the software uses to calculate each component’s calibration curve.

**NOTE:** You can change the default calibration parameters by editing the DEFAULT.MTH file. For more information, see “Editing DEFAULT.MTH” on page 7-8.

Replacing calibration parameters

In addition to adjusting calibration parameters, you can also replace calibration parameters in a file by copying the parameters from another file. For more information, see “Replacing parameters” on page 4-4.

Generating calibration curves

You can use Applied Biosystems Data Analysis software to generate calibration curves to quantitate unknowns. For more information, see Section 4.5, Generating Calibration Curves and Quantitating Unknowns.
7.2 Adjusting Calibration Parameters

You develop and modify calibration parameters using the commands in the Components menu in the Text Method Editor.

To adjust calibration parameters in the analysis section (.MTH) of a method file (.MET), data file (.B*), or group file (.GRO):

1. Access the Text Method Editor by doing one of the following in your BioCAD, VISION, or INTEGRAL software:

   **CAUTION**
   Once you access the Text Method Editor, changes you make and save overwrite the contents of the file you open in this step. If you want to make changes to the file and save under a different name, select Save As or Save Group As now, before selecting Adjust Analysis Parameters.

   **NOTE:** Select Adjust Analysis Parameters from the Individual section to adjust the processing parameters of a single data file. Select Adjust Analysis Parameters from the Group section to adjust the processing parameters of a group file.
NOTE: If the Adjust Analysis Params command does not appear in the Individual section of the Analysis menu, select Tiled Mode from the Display menu.

The Adjust dialog box appears (Figure 7-2).

![Adjust Dialog Box](image)

**Figure 7-2 Adjust Dialog Box**

**Selecting a data channel**

2. Select a **data channel** for which you want to change processing parameters.

3. Click OK to display the Text Method Editor, Method Summary, and Component List windows (Figure 7-3).

The file (.MET, .B*, or .GRO) you selected in step 1 appears in the title bar, augmented with the selected data channel and an .MTH extension.
Chapter 7 Adjusting Calibration Parameters

Figure 7-3 Text Method Editor, Method Summary, and Component List Windows

The Method Summary displays information about the instrument settings associated with the file that is currently active.

**NOTE:** To view the Method Summary or Component List window, select **Method Summary** or **Component List** from the Window menu. You can control these windows by clicking **\(\text{\textdagger}\)** to minimize, clicking **\(\text{\textexclamdown}\)** to resize, or clicking **\(\text{\textdaggerdbl}\)** to maximize.
4. To set calibration parameters, use the commands in the Components menu (Figure 7-4). The commands are described in the following sections starting on page 7-9.

![Components Menu Commands](image)

**Figure 7-4 Components Menu Commands**

**NOTE:** Once you modify the analysis section of a method file (.MET), data file (.B*), or group file (.GRO), the word MODIFIED appears at the right of the status bar of the Text Method Editor (Figure 7-3). The word MODIFIED remains there until you select **Save** from the File menu in the Text Method Editor.

5. Select **Save** from the File menu to save any changes.

**CAUTION**

Once you select Save, the changes you made overwrite the contents of the file you opened in step 1.
The Documentation dialog box or the Audit Trail dialog box opens.

NOTE: Documentation and Audit Trail information are not supported in this version of software.

6. Click OK to close the dialog box.
7. Select Exit from the File menu to close the Text Method Editor, and return to the Method Editor or Group Analysis window.

Opening additional files

You can not open additional data files, group files, or method files from within the Text Method Editor. (If you try to open one of these files, an error message is displayed.)

To open a different data file, group file, or method file:
1. Return to the Method Editor or Group Analysis window.
2. Repeat the procedure starting on page 7-4.

Nonsupported commands

The following commands in the Text Method Editor are not supported:
- **File menu**—New, Open, Import, Save As, Description, Audit Trail, Review
- **Instrument menu**—All commands
- **Other menu**—Sequence Editor

NOTE: You can use the Open command under the File menu to edit the default analysis parameters file, as described below.

Editing DEFAULT.MTH

When you create a new method file (.MET) or group file (.GRO), default parameters are loaded from the default analysis parameters file, DEFAULT.MTH, which is located in C:\PENEXE\TCWS\VER6.1.0\CONFIG\USER\PERSEPTIVE.

To edit DEFAULT.MTH, access the Text Method Editor, open DEFAULT.MTH by selecting Open from the File menu, edit it as desired, and save it. The software will prompt you to verify that you want to change the default analysis parameters file.
7.3 Understanding Global Calibration Parameters

The settings in the Global Information dialog box (Figure 7-5) apply to the method as a whole, including how the software calibrates peaks that are unidentified in the run.

![Global Information Dialog Box](image)

**Figure 7-5  Global Information Dialog Box**

The analysis section of every new method file (.MET) contains a set of default parameters, which appear in the Global Information and Component Defaults dialog boxes. You only need to change the defaults if you are creating a component list.

This section explains the parameters in the Global Information dialog box. The procedures for completing the dialog box follow.
### Volume units
Specifies the units you want to use for sample volume in the analysis. These units are for reference only in the method and in reports, and do not affect the calculations that the software performs.

### Quantitation units
Specifies the units used for amounts or concentrations for calibration standards and sample quantitations. These units are for reference only in the method and in reports and do not affect the calculations that the software performs.

### Sample Volume
Specifies the normal sample volume for the calibration standards.

### Void time
Specifies the elution time of an unretained peak. The software uses this value to calculate $k'$ and relative retention values as follows:

$$
k' = \frac{\text{peak retention time} - \text{void time}}{\text{void time}}
$$

$$
\text{relative retention} = \frac{\text{peak retention time} - \text{void time}}{\text{reference peak retention time} - \text{void time}}
$$

The Void time also corrects the retention times of reference peaks when the software calculates the expected component retention times. For more information, see Section 7.5.3, Reference Components.
Unidentified Peak Quantitation

Specifies how the software calculates unidentified peak amounts in the analysis. The options are:

- **Always use calibration factor** — Calculates component amounts based on the constant calibration factor you enter in the dialog box.

- **Use nearest component** — Calculates each unidentified peak using the same options as the nearest component. The amounts are calculated as if the unidentified peak is the same as the component.

- **Use nearest reference** — Calculates each unidentified peak using the same options as the nearest reference peak. The software calculates the amounts as if the unidentified peak is the same as the reference peak.

For more information on the quantitation of unidentified peaks, see Appendix A, Discussion of Data Analysis.

Correct amounts during calibration

This feature is not supported in this version of software.

Reject outliers during calibration

Checks the response for each component from a calibration run against the current average. If the response falls outside the percentage deviation from the average you specify, the software rejects the results (does not include them as a replicate).

Send Tagged Only Results to LIMS

This feature is not supported in this version of software.
**Calibration**

Specifies the calibration setting. The options are:

- **External standard**—Uses component amounts and response values to compute either an average calibration factor or a calibration curve.

- **Internal standard**—Uses amount ratios and response ratios to compute the average calibration factor or calibration curve.

The *amount ratio* is the amount of component in a standard sample divided by the amount of the designated internal standard in the same sample. The *response ratio* is the area or height of the component peak divided by that of the internal standard peak. For information on external and internal standards, see Appendix A, Discussion of Data Analysis.
7.4 Editing Global Calibration Information

To edit global calibration parameters:

1. Select **Global Information** from the Component menu to open the Global Information dialog box (Figure 7-6).

![Global Information Dialog Box](image)

*Figure 7-6 Global Information Dialog Box*

There are two tabs in the Global Information dialog box:

- **Global Information**—Use this tab to set parameters that apply to all components in the method or to all unidentified peaks.

- **LIMS Results**—Not supported in this version of software.
2. In the Volume Units text box, type the units you want to use for sample volume.

3. In the Quantitation Units text box, type the units you want to use for amounts or concentrations.

4. In the Sample Volume text box, type the value that represents the normal sample volume for the calibration standards you are using.

   You only need to alter the default value if you plan to use different volumes for different samples.

5. In the Void Time text box, type a time value that represents the elution time of an unretained peak.

6. Under Unidentified Peak Quantitation, type a value in the Calibration Factor text box and, if necessary, select a calibration option.

   **NOTE:** The Correct Amounts During Calibration feature is not supported in this version of software.

7. To exclude replicates that are outside a chosen limit, select Reject Outliers During Calibration and type the Allowed Deviation percentage you want to use.

8. Under Calibration, select External Standard or Internal Standard as the calibration type.

9. Make any other changes to the values in the Global Information dialog box, and then do any of the following:

   - To save your work and close the dialog box, click OK.
   - To save your work without closing the dialog box, click Apply.
   - To discard your changes since the last time you chose Apply and close the dialog box, click Cancel.
7.5 Understanding Component Parameters

The Component List window (Figure 7-7) displays the components in the analysis parameters. The component parameters in the middle section of the window show how you want the components to be quantitated.

![Component List Window](image)

**Figure 7-7 Component List Window**
You provide this information through the parameters in the Component Defaults and the Components dialog boxes. These dialog boxes contain essentially the same parameters:

- Parameters that specify how the software matches components to a peak or peaks (on the Identification tab).
- Parameters that affect calibration (on the Calibration tab).

The default parameter values apply to every component in the list. You can change the values associated with each component individually by choosing the Edit or Add Component command in the Components menu.

This section describes some of the parameters and concepts you need to know when completing the parameters in the components dialog boxes. The procedures for completing the information follow the descriptions starting with Section 7.6, Setting Component Defaults, on page 7-28.
7.5.1 Component Types

You can define three types of components in the method:

- Peak (single peak components)
- Named groups
- Timed groups

**Single Peak Components**

The *single peak component* is the simplest and most common component type. This setting identifies a component as a single peak in the run. The software performs a calibration by relating an amount to a single peak response at each level except when you calibrate by reference or a constant calibration factor.

*Figure 7-8 Components Dialog Box—Peak Component Type*
**Named Groups**  A named group consists of two or more single peak components. You must first identify a peak as a component before you can include it in a named group. The group area and height are the sum of the individual peak areas and heights. The software calculates the components as a group, independent of its members’ calibrations. The software reports the results as if the group is a single component. You can calibrate the components in a named group individually and report the results for individual components. Members of a named group can appear anywhere in the chromatogram, and a single peak component can be a member of more than one named group.

![Components Dialog Box—Named Group Component Type](image)

**Figure 7-9 Components Dialog Box—Named Group Component Type**
**Timed Groups**  A *timed group* consists of a group of peaks whose retention times fall within a group time window that you define. The time window consists of a start time and an end time, so a timed group is comprised of a series of contiguous peaks. Each peak is detected and integrated individually. The group area and height are the sum of the individual peak areas and heights. The group is calibrated independently of its members’ calibrations if they are identified as components. Peaks need not be identified to be included in a timed group.

![Figure 7-10 Components Dialog Box—Timed Group Component Type](image)

*Figure 7-10 Components Dialog Box—Timed Group Component Type*


7.5.2 Setting Up Search Windows

When setting up peak components, you need to define a search window to enable the software to match components with the correct peaks in a run (Figure 7-8 on page 7-17). A search window is a time tolerance before and after the expected retention time of the component. This window allows the software to identify components despite small variations in retention time from run to run.

The software must find a peak within a component’s search window to identify it as that component. If the component’s search window contains no peaks, the software will not be able to find the component in the sample. If more than one peak occurs within the search window, you can designate the largest peak in the window, or the peak closest to the expected retention time, as the component. You can also establish separate windows for each component in a method.

The search window has two parts:

- **Absolute window**—Defined by an amount of time, in seconds.
- **Relative window**—Defined by a percentage of the component’s expected retention time.

Because the relative search window is a percentage of the expected retention time, the window increases as retention time increases. This increase helps compensate for the greater uncertainty that occurs in peaks eluting later in the run.

The calculation for the total size of the search window, $W$ (in seconds), centered at the expected retention time of the component, $RT_{exp}$ (in minutes), is:

$$ W = 2 \left( \text{absolute window} + \frac{RT_{exp} \times \text{relative window} \times 60}{100} \right) $$
For example, consider a peak with an expected retention time of 15 minutes, an absolute search window of 10 seconds, and a relative search window of 5%. The window size on each side of the expected retention time is then 55 seconds—10 seconds plus 5% of 15 minutes (or 45 seconds). The total width of the window is then 110 seconds.

7.5.3 Reference Components

Retention times for components can vary greatly from run to run. If you create an excessively wide search window to find these peaks, you can cause windows to overlap. Overlapping windows complicate the peak identification process because it then becomes difficult for you to predict the component assignments the software will make. For more information about how the software handles overlapping windows during component identification, see Section A.5.1, Overlapping Search Windows.

To compensate for these shifts in peak retention times, you can use reference components (see Figure 7-8 on page 7-17). As with any other peak component, a reference component has an expected retention time and a search window. However, a reference component is usually readily identifiable either because it is well separated from other peaks or because it is always the largest peak in that region of the chromatogram.

When you establish a reference component, the software uses the ratio of the actual retention time of the reference peak to the expected time in order to calculate adjusted expected retention times for the components associated with the reference component.
The complete equation for the adjustment calculation is:

\[ T_{adj\ comp} = \left( \frac{T_{act\ ref} - T_{void}}{T_{exp\ ref} - T_{void}} \right) T_{exp\ comp} \]

where

- \( T_{adj\ comp} \) is the adjusted expected retention time for a component
- \( T_{act\ ref} \) is the actual retention time of the reference component from the run
- \( T_{exp\ ref} \) is the expected retention time of the reference component as defined in the method
- \( T_{void} \) is the Void Time (if you have entered one in the Global Information dialog box)
- \( T_{exp\ comp} \) is the expected retention time of the component as defined in the method

You can define one or more components as reference peaks in the component list. However, you cannot use named or timed group components as reference peaks. For information about optimizing component identification, see Appendix A, Discussion of Data Analysis.
7.5.4 Internal Standard Components

If you select Internal Standard as the method of Calibration in the Global Information dialog box, you must associate each component (that is not itself an internal standard) with a designated internal standard component (see Figure 7-8 on page 7-17). You can define one or more components as internal standards in the component list. However, you cannot use named or timed group components as internal standards.

When you use an internal standard, the software relates amount ratios to response ratios in order to compute the calibration curve or average calibration factor. The amount ratio is the amount of component in the calibration standard divided by the amount of the internal standard component in the same sample. The response ratio is the area or height of the component peak divided by that of the internal standard peak. For more information about the internal standard method, see Appendix A.6.3, External Standard Versus Internal Standard Calibration, in Appendix A, Discussion of Data Analysis.

7.5.5 Response Options

The Area and Height Response options on the Calibration tab (see Figure 7-11 on page 7-25) specify whether the software calibrates and quantitates each component using peak area or peak height values. You can change the option if you want to use a different response mode for different components.
7.5.6 Calibration Types

You can use a different calibration type for each component in a method. The calibration types are:

- **Use Calibration Factor**—Calculates component amounts based on the constant calibration factor you enter for the individual component. Note that this is different from the calibration factor you enter in the Global Information dialog box, which is used for all unidentified peaks. The calibration factor is divided into the peak response to obtain an amount during quantitation.

- **Average Calibration Factor**—Averages the response-to-amount values (or response ratio-to-amount ratio for internal standard calibration) at each calibration standard level. It applies to multi-level calibrations but does not construct a calibration curve from the data.

- **Calibrate By Reference**—Quantitates the component using the calibration type of a designated reference component. The software calculates the amounts as if the peak were the same as the calibration reference component. The designated calibration reference component can be any component in the method (other than an internal standard), and it is different from any time reference peak specified for identification purposes.

- **Use Curve**—Creates a calibration curve based on the data collected from standard samples. The actual curve for each component depends on the values in a number of parameters. If you specify an external standard calibration, the curve then shows the relationship between amount and response (area or height) values. If you specify an internal standard calibration, the curve then shows the relationship between amount ratios and response ratios (between the component and its designated internal standard component).
7.5.7 Selecting Fit Parameters

If you select Use Curve as the Calibration Type in one of the tabs in the Components dialog boxes, the Curve Fit Type, Scaling, and Weighting parameters become active. These parameters determine exactly how the software constructs the curve from the data points.

*Figure 7-11 Components Dialog Box (Calibration Tab)*
Chapter 7 Adjusting Calibration Parameters

**Curve Fit Type**

The Curve Fit Types options are:

- **Point To Point**—Averages all replicate amount and response data at each calibration level to derive a point. Each pair of points is connected by a straight line segment. You can use this fit type with one or more calibration levels.

- **1st Order Polynomial**—Calculates a first-order polynomial (linear) fit using the coefficients of the curve (the intercept and slope). A component must have at least two calibration levels to use this type of fit.

- **2nd Order Polynomial**—Calculates a second-order polynomial (quadratic) fit using the curve coefficients. A component must have at least three calibration levels to use this type of fit.

- **3rd Order Polynomial**—Calculates a third-order polynomial (cubic) fit using the curve coefficients. A component must have at least four calibration levels to use this type of fit.

For more information about how the software solves the various calibration curve types, see Appendix A, Discussion of Data Analysis.

**Scaling Factor**

Instead of using response versus amount (or response ratios versus amount ratios for internal standard) for the calibration curve, you can use alternative functions of the amounts. The Scaling options are:

- **None**—Does not add a scaling factor.

- **1/X**—Plots response as a function of the reciprocal of the amount.

- **1/(X*X)**—Plots response as a function of the reciprocal of the square of the amount.

- **log[X]**—Plots response as a function of the base-10 log of the amount.

- **1/log[X]**—Plots response as a function of the reciprocal of the base-10 log of the amount.
If you are using internal standard calibrations, X represents the amount ratio.

**NOTE:** If you use one of these scaling alternatives, some values will not be valid. For example, you cannot use 0.0 with \( \frac{1}{X} \) or \( \frac{1}{(X^*X)} \), and you cannot use an amount less than 1.0 with a logarithmic option.

**Weighting Factor**

By default, the software weights each data point equally when it calculates the calibration curve equation. However, you can use different weighting options to affect how the curve is fit to the data. The Weighting options are:

- **None** — Applies no weighting.
- **\( \frac{1}{X} \)** — Uses the reciprocal of a point's amount value.
- **\( \frac{1}{Y} \)** — Uses the reciprocal of a point's response value.
- **\( \frac{1}{(X^*X)} \)** — Uses the reciprocal of the square of a point's amount value.
- **\( \frac{1}{(Y^*Y)} \)** — Uses the reciprocal of the square of a point's response value.

**Origin**

The software provides three alternatives for defining how you want to treat the origin in calculating a calibration curve. The origin is the point (0,0). The options under Origin Treatment are:

- **Force** — The intercept is always zero in the calculation. With this option, the curve is forced to pass through the origin.
- **Include** — The origin is added to the calculation but does not appear in the calibration level list.
- **(None)** — If you deselect both of these options, the software does not factor the origin into the calibration.

**User Values/LIMS**

This feature is not supported in this version of software.
7.6 Setting Component Defaults

This section describes the Component Defaults dialog box and the procedures for setting up defaults. For detailed information on the specific parameters in the Component Defaults dialog box, see Section 7.5, Understanding Component Parameters.

The Defaults command in the Components menu lets you set the default values that the software provides when you add new components to the analysis parameters. Customizing component defaults is useful in the following situations:

- You want to add to a method or series of methods a large number of components whose parameters are the same.
- You want to add to a method a large number of components that share an internal standard or retention reference.

You generally use the component defaults function in conjunction with the Components dialog box, which you use for adding new components. For example, if you want to add 100 components that have the same calibration settings, set the common parameters in the Default Components dialog box. Then, when you add each component using the Components dialog box, you only need to specify the unique parameters such as the component names and retention times. For information on adding new components, see Section 7.7, Adding and Editing Components.
Enter Component Default Information

The following is the general procedure for entering component default information.

To enter component default information:

1. Select **Defaults** from the Components menu to open the Component Defaults dialog box (Figure 7-12).

![Component Defaults Dialog Box](image)

Figure 7-12 Component Defaults Dialog Box
Chapter 7 Adjusting Calibration Parameters

There are three tabs in the Component Defaults dialog box:

- **Identification**—Select this tab to establish parameters for component identification. The options on this tab change depending on the component type you select. For more information, see “Entering Component Identification Defaults” on page 7-31.

- **Calibration**—Select this tab to set the calibration defaults you want to use. For more information, see “Setting the Calibration Defaults” on page 7-32.

- **User Values/LIMS**—Not supported in this version of software.

2. Make any changes to the values in the Component Defaults dialog box, and then do any of the following:

   - To save your changes and close the dialog box, click **OK**.

   - To save your changes without closing the dialog box, click **Apply**.

   - To discard your changes since the last time you chose Apply and close the dialog box, click **Cancel**.

The following sections describe how to complete each tab of the Component Defaults dialog box.
You can specify that the software identify new components as peak, named group, or timed group components. This section describes the procedures for setting defaults for each type. Generally, you set up component identification defaults for peak components.

If you are setting up default internal standards or reference peaks, the components you want to designate must appear in the component list for the open method. For example, if you want to set Cytochrome C as an internal standard for new peak components, you must first add it to the method and then specify that it is an internal standard in the Components dialog box.

To set a single peak component as the default type:
1. Select the Identification tab of the Component Defaults dialog box.
2. Select Peak under Component Type.
3. In the Absolute Window text box, type the time you want to use for the default absolute search window.
4. In the Relative Window text box, type the percentage you want to use for the default relative search window.
5. Select Find Largest Peak In Window if you want the default to be to identify peaks by size (based on height, not area).

When you deselect this option, the software identifies the peak closest to the expected time as the component.

6. To designate a component as the default reference peak, select it from the Reference list.
7. To designate a component as the default internal standard, select it from the Internal Standard list.
Setting defaults for new components

The procedures for setting identification defaults for named group and timed group components are very similar to those for peak components, except that many parameters are not available.

- For named group components, select the component that you want to designate as the default internal standard for the open method.
- For timed groups, select the default retention reference and/or the default internal standard for the open method.

Setting the Calibration Defaults

Calibration values affect how the software calculates component amounts. You can select from the following types of calibration for components:

- Using a constant calibration factor
- Calculating an average calibration factor
- Using the calibration curve of another component (calibration reference)
- Solving the component's calibration curve

The procedures for setting up each calibration type follow. This section also provides instructions for working with calibration levels.
Setting Component Defaults

Constant calibration factor

To calibrate using a constant calibration factor:
1. Select the Calibration tab of the Component Defaults dialog box.
2. Select Use Calibration Factor as the Calibration Type.
3. Type a calibration factor value in the Cal Factor text box.
4. Under Response, select whether to use Area or Height.

Average calibration factor

To calibrate using an average calibration factor:
1. Select the Calibration tab of the Component Defaults dialog box.
2. Select Avg Calibration Factor as the Calibration Type.
3. Under Response, select whether to use Area or Height.
   The table in which you specify the calibration levels becomes active.
4. Edit the Level, Amt, and Area or Height values.
   For more information on levels, see “Adding default calibration levels” on page 7-37.
To calibrate using a reference component:

1. Select the **Calibration** tab of the Component Defaults dialog box.

2. Select **Calibrate By Reference** as the Calibration Type.

3. Select a **component** from the open method in the Cal Reference list.

   You do not have to select a specific component to use Calibrate By Reference as the default calibration type. However, you must pick one when you add new components.
To calibrate using calibration curve parameters:

1. Select the **Calibration** tab of the Component Defaults dialog box.

2. Select **Use Curve** as the Calibration Type.

3. Under Response, select **Area** or **Height**.

   The last column of the table changes to Area or Height depending on the option you select.

4. From the Curve Fit Type list, select a **curve type**.

   When you set defaults, you must enter an appropriate number of levels for the curve type you have selected. However, you do not have to change amounts from 0.0000. Based on the calibration curve type, the minimum number of levels required are:

<table>
<thead>
<tr>
<th>Calibration Curve Type</th>
<th>Minimum Number of Levels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point To Point</td>
<td>1</td>
</tr>
<tr>
<td>1st Order Polynomial</td>
<td>2 (or 1 if you include the origin)</td>
</tr>
<tr>
<td>2nd Order Polynomial</td>
<td>3 (or 2 if you include the origin)</td>
</tr>
<tr>
<td>3rd Order Polynomial</td>
<td>4 (or 3 if you include the origin)</td>
</tr>
</tbody>
</table>
5. From the **Scaling list**, select a factor you want to use.
   For definitions of the choices, see Section 7.5.7, Selecting Fit Parameters.

6. From the **Weighting list**, select a factor you want to use.
   For definitions of the choices, see Section 7.5.7, Selecting Fit Parameters.

7. Under Origin Treatment, select **Include** or **Force** as the origin option, if required.
   Leave both options deselected to omit the origin from the calibration.

8. Edit the **Level**, **Amount**, and **Area/Height** values as necessary.
   For more information on how to create new calibration levels, see “Adding default calibration levels” on page 7-37.
**Adding default calibration levels**

To determine unknown component amounts, the software compares the component's response (peak area or height) to the response of a known amount of the same component in a single standard sample. To improve the accuracy, you can choose to inject more than one standard sample, where each sample contains the same component but in different amounts. These varying samples are called *calibration levels*.

The response produced by the component at each calibration level, plotted against the level amount, defines the points on which the component's calibration curve is based.

Some notes about calibration levels:

- You can only add calibration levels with the Avg Calibration Factor and Use Curve calibration types.
- A component can have up to 100 calibration levels, but the level names for all components in a standard sample must be the same.
- Use unique level names for different levels.
- Ensure that two different levels do not have the same amount unless the component is an internal standard component.

To add new calibration levels:

1. Select **Avg Calibration Factor** or **Use Curve** as the Calibration Type.
2. Under Response, select whether to use **Area** or **Height**.
3. Type a **level name** or **number** in the first empty cell in the Level column.
4. Type a value in the first empty cell in the **Amt. column**.

You do not need to type an amount of more than zero when you set defaults. Do this only when you add components to the list.
5. Select the **Area/Height column** and type a **value**.

Whether you type an area value or a height value depends on whether you chose to calibrate by area or height. You can leave this value at zero and fill it in later by running a calibration standard.

The software adds a new row to the table after you complete the columns for the current level.

6. Repeat step 2 through step 5 to add additional levels.

This feature is not supported in this version of software.
7.7 Adding and Editing Components

You add and edit components in the Components dialog box. The New Component and Edit Component commands in the Components menu both open the Components dialog box. The difference between the two commands is in the initial “mode” of the dialog box:

- When you select New Component, the dialog box is ready to accept your input of a new component (add mode)
- When you select Edit Component, the dialog box is ready for you to select an existing component to edit (edit mode)

Whichever command you use, once the Components dialog box is open you can both add and edit without having to close and reopen the dialog box to change the mode.

- To switch from editing to adding, click the New Component command button.
- To switch from adding to editing, select a component to edit from the list.

You can also open the Components dialog box in edit mode by double-clicking a component name in the Component List window. This both opens the window and pre-selects the component that you want to edit.

For detailed information on the specific parameters contained in the Components dialog box, see Section 7.5, Understanding Component Parameters.
The following is the general procedure for adding and editing component information.

To add or edit component information:

1. Select **New Component** or **Edit Component** from the Components menu to open the Components dialog box.

![Components Dialog Box](image)

**Figure 7-13 Components Dialog Box (Identification Tab)**
There are three tabs in the Components dialog box:

- **Identification**—Select this tab to set parameters for component identification. The options on this tab change depending on the peak type you select.

- **Calibration**—Select this tab to set the calibration parameters you want to use.

- **User Values/LIMS**—Not supported in this version of software.

2. You can use the **Next** and **Previous** buttons to scroll through the list of components that are already in the method.

3. To delete the currently selected component from the component list, click **Delete Component**.

4. Make any changes to the values in the Components dialog box. For information on how to complete each tab of the Components dialog box, see Section 7.7.1, Adding a Component, and Section 7.7.2, Editing a Component. Then do any of the following:

   - To save your work and close the dialog box, click **OK**.

   - To save your work without closing the dialog box, click **Apply**.

   - To close the dialog box and discard your changes since the last time you chose Apply, click **Cancel**.
7.7.1 Adding a Component

If you are adding a large number of components whose parameters are the same, you might want to customize the component defaults before starting this procedure. For more information, see Section 7.6, Setting Component Defaults.

To prepare to add a new component:

Do one of the following:

- Select **New Component** from the Components menu to open the Components dialog box in add mode.
- Select the **New Component** command button on the Identification tab of the Components dialog box.

When adding components, the first step is to complete the component identification information. You can add the following types of components:

- Single peak components
- Named group components
- Timed group components

Note the following about component types:

- Any peak component you add to the component list in a method can also act as a reference component or internal standard.
- You must have identified the single peak or timed group components before you can create a named group. The members of a named group do not need to be located contiguously in the chromatogram: they can appear anywhere.
- Peaks need not be identified to be included in a timed group.
Adding a peak component

To add a peak component to the component list:

1. Select the Identification tab of the Components dialog box and select Peak as the component type.

2. In the Name text box, type a name for the component.

3. In the Retention Time text box, type the expected retention time for the component.

4. In the Absolute Window text box, type the size of the absolute search window you want to use on either side of the expected retention time.

5. In the Relative Window text box, type a percentage of the expected retention time you want to add onto either side of the absolute search window.

6. Select Find Largest Peak In Window if you want the software to identify the largest peak (based on height, not area) as the component rather than the one closest to the expected retention time.

7. Do one of the following:
   - To use the current component as a retention reference for other components in the method, select This Component Is A Retention Reference.
   - To use another component in the current method as a reference, select a retention reference from the Reference list.
   - Select <no reference> in the Reference list if this component needs no retention reference.
8. If the method specifies internal standard calibration, do one of the following:

   - To use the current component as an internal standard for other components in the method, select **This Component Is An Internal Standard**.

   - To use **another component** as an internal standard component, select one from the Internal Standard list.

**NOTE:** If you are performing an internal standard calibration, you must select an internal standard.

---

**Adding a named group**

To add a named group to the component list:

1. Select the **Identification** tab of the Components dialog box and select **Named Group** as the Component Type.

2. In the Name text box, type a **name** for this group.

3. Select the **components** you want to include in the named group from the Group Members box.

   The list includes all peak and timed group components contained in the open method. To select multiple components, hold down the Ctrl key and then click on each name.

4. From the Internal Standard list, select the component you want to use as the **internal standard**.

   This list consists of all components in the open method that have already been designated as internal standards.
Adding a timed group

To add a timed group to the component list:

1. Select the Identification tab of the Components dialog box and select Timed Group as the Component Type.

2. In the Name text box, type the name you want to use for this timed group.

3. In the Start Time text box, type the starting time you want to use.
   
The software includes in the group only those peaks whose crests occur after this time.

4. In the End Time text box, type the ending time you want to use.
   
The software includes in the group only those peaks whose crests occur before this time.

5. From the Reference list, select the component you want to use as a reference component.
   
   If you specify a reference component, the software adjusts the actual start and end times used to define the group based on the actual retention time of the reference peak in each run.

6. If necessary, select the name of a component you want to use as an internal standard from the Internal Standard list.
Chapter 7 Adjusting Calibration Parameters

Setting calibration parameters
Calibration values affect how the software calculates component amounts. You can select from the following types of calibration for components:

- Using a constant calibration factor
- Calculating an average calibration factor
- Using the calibration curve of another component (calibration reference)
- Solving the component's calibration curve

The procedures for setting up each calibration type follow. This section also provides instructions for working with calibration levels.

Constant calibration factor
If you select Use Calibration Factor, the software divides the component's response by the calibration factor to obtain an amount.

To calibrate using a constant calibration factor:

1. Select the Calibration tab of the Components dialog box.
2. Select Use Calibration Factor as the Calibration Type.
3. Type a **calibration factor value** in the Cal Factor text box.

4. Under Response, select whether to use **Area** or **Height**.
Chapter 7 Adjusting Calibration Parameters

**Average calibration factor**

If you select Average Calibration Factor as the calibration type, the software averages the slope at each calibration point on the curve and uses this average as a single calibration factor. The software does not perform a linear regression on the data. Because this calculation requires that the intercept of the curve pass through the origin, the Origin options are not available when you add new components or edit existing components.

The slope at each calibration point referred to above is either a response-to-amount ratio (for external standards), or response ratio-to-amount ratio (for internal standards) for each replicate.

To calibrate using an average calibration factor:

1. Select the **Calibration** tab of the Components dialog box.
2. Select **Avg Calibration Factor** as the Calibration Type.
3. Under Response, select whether to use **Area** or **Height**.
   
   The last column of the table changes to Area or Height, depending on the option you select.
4. Edit the **Level**, **Amt**, and **Area** or **Height** values as necessary.
   
   For more information on levels, see “Working with calibration levels” on page 7-51.
You can perform a calibration by using the calibration of another component. The software calculates the amount for the component based on the calibration curve of the other component. This type of calibration is called *calibrating by reference*. The calibration reference component, in this case, can be any component: it does not have to be one previously defined as a reference peak.

To calibrate using a reference component:
1. Select the **Calibration** tab of the Components dialog box.
2. Select **Calibrate By Reference** as the Calibration Type.
3. Select a component to use as a reference from the Cal Reference list.

To calibrate using a calibration curve:
1. Select the **Calibration** tab of the Components dialog box.
2. Select **Use Curve** as the Calibration Type.
3. Under Response, select whether to use **Area** or **Height**.
   The last column of the table changes to Area or Height depending on the option you select.
4. Select the **Curve Fit Type** you want to use from the list.

Depending on the calibration curve type, the minimum number of levels required are as follows:

<table>
<thead>
<tr>
<th>Calibration Curve Type</th>
<th>Minimum Number of Levels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point To Point</td>
<td>1</td>
</tr>
<tr>
<td>1st Order Polynomial</td>
<td>2 (or 1 if you include the origin)</td>
</tr>
<tr>
<td>2nd Order Polynomial</td>
<td>3 (or 2 if you include the origin)</td>
</tr>
<tr>
<td>3rd Order Polynomial</td>
<td>4 (or 3 if you include the origin)</td>
</tr>
</tbody>
</table>

5. Select the **Scaling factor** you want to use from the list.

For definitions of the options, see Section 7.5.7, Selecting Fit Parameters.

6. Select the **Weighting factor** you want to use from the list.

For definitions of the options, see Section 7.5.7, Selecting Fit Parameters.

7. Under Origin Treatment, select **Include** or **Force** as the origin option if required.

Include origin adds point 0,0 to the calibration (zero amount to zero response). Force origin prevents any offset, forcing the curve to go through the point of origin.

Leave both options deselected to omit the origin from the calibration.

8. Edit the **Level**, **Amount**, and **Area/Height** values as necessary.

For more information on how to create new calibration levels, see “Working with calibration levels” on page 7-51.
Working with calibration levels

If you did not build calibration levels in the Component Defaults dialog box, or if you need additional levels, you can add new levels in the Components dialog box.

To determine unknown component amounts, the software compares the component’s response (peak area or height) to the response of a known amount of the same component in a single standard sample. To improve the accuracy, you can choose to inject more than one standard sample, where each sample contains the same component but in different amounts. These varying samples are called *calibration levels*.

The response produced by the component at each calibration level, plotted against the level amount, defines the points on which the component’s calibration curve is based.

Some notes about calibration levels:

- You can add calibration levels only with the Avg Calibration Factor and Use Curve calibration types.
- A component can have up to 100 calibration levels, but the level names for all components in a standard sample must be the same.
- Use unique level names for different levels.
- Ensure that two different levels have different amounts unless the component is an internal standard component.

You can also revise an existing calibration level, or delete it from the list if it no longer applies to a specific method or component. If you are using named or timed groups, these actions apply to a group of components.
Adding a calibration level

To add a calibration level:

1. Select **Avg Calibration Factor** or **Use Curve** as the Calibration Type.

2. Under Response, select **Area** or **Height** as the option you want to edit.

3. Type a **level name** or **number** in the first empty cell in the Level column.

4. Type a value in the first empty cell in the **Amt. column**.

5. Select the **Area/Height column** and type a **value**.

   You can leave this value set to zero, and then fill it in later by running a calibration standard.

   The software adds a new row to the table after you complete the columns for the current level.

6. Repeat step 2 through step 5 to add additional levels.

Changing a calibration level

To change an existing calibration level:

1. In the table showing the levels, select the **cell** that contains the parameter you want to change.

2. Edit the parameters as necessary.

   If you change level entries that contain any replicates, the software will delete the replicates.

Deleting a calibration level

To delete a calibration level:

1. Click inside the **row** you want to delete.

2. Press the **Delete** key.
7.7.2 Editing a Component

The procedure for editing a component is the same as that for adding a new component, except that you select an existing component instead of entering a new name.

To edit component information:

1. Do one of the following:
   - Select **Edit Components** from the Components menu.
   - Double-click the **component name** to open the Components dialog box.

2. Use the mouse or click the **Next** and **Previous** buttons to select the **component** that you want to edit from the list in the dialog box.

3. Edit the component parameters as necessary.

   For specific procedures, see Section 7.7.1, Adding a Component.
7.8 Loading and Merging Components From Files

When you adjust the analysis section of a method file (.MET) or data file (.B*), you can use the component list from another text file, and edit the component information as necessary for the current method. To use the components from another file, you select the Load and Merge commands in the Components menu.

- **Load**—The software replaces the existing components in the component list with the components from the file.

- **Merge**—The software intersperses, by retention time, the existing components in the component list with the components from the file.

To use the Text File commands, you must first generate an ASCII text file. Each line of the text file represents a component that you want added to the list, and each line must have the following format:

"<name>“, <time> [, <abs> [, <rel>]]

Two examples are:

"Cytochrome C“, 8.6, 5, 0.1

"Lysozyme“, 13.15, 6, 0.1

where <name> is the component name, and <time> is the expected time for the component. You must specify both of these values, and you must enclose the name in quotes. The remaining two values, representing the size for the absolute search window and the size for the relative search window, are optional. You must separate all values on a line by commas.

The information in the component default file supplies all other values, including the search window values, if they are not defined in the text file.
Loading and Merging Components From Files

**Loading components**

To load components from a text file:

1. Do one of the following:
   
   - Select **Load/Text File** or **Load/Result File** from the Components menu to open the file selection dialog box for the specified type of file. Skip to step 5.
   
   - Select **Load/Method File** from the Components menu to open the Load From Method File dialog box. Continue with step 2.

   **NOTE:** Load/Result File and Load/Method File are applicable only if you create stand-alone results files (.RST) and analysis method files (.MTH).

2. Leave **Copy Levels From Method File** selected if you want to copy calibration levels.

3. Leave **Copy Replicates From Method File** selected if you want to copy replicate injection information.

4. Click **OK** to open the file selection dialog box showing method files.

5. Select the file whose component list you want to load into the current method file, and then click **OK**.

   The component information contained in the selected file appears in the component list. The new information overwrites existing data in the component list.
The procedure for merging components is similar to loading, including the option to include calibration information from method files.

To merge components from a text file:

1. Select Merge/Text File, Merge/Result File, or Merge/Method File from the Components menu.

   **NOTE:** Merge/Result File and Merge/Method File are applicable only if you create stand-alone results files (.RST) or analysis method files (.MTH).

2. Select the file with the component information you want to merge, including the levels, and replicates from the calibration section of the method if you are merging a method file.

3. Click OK.
7.9 Deleting Components

To delete a component from the component list:

1. In the Component List window, select the component you want to delete.

2. Select Delete Component from the Components menu or press the Delete key.

   The selected component and its related information is deleted, and the Component List window changes to show information on the next component.

To delete all components, levels, and replicates, select Delete All Components from the Components menu.

After asking you to confirm the command, the software deletes all components from the component list for the calibration parameters of the open file.
7.10 Changing Parameters for Multiple Components Simultaneously

The following commands in the Components menu allow you to make changes simultaneously to multiple components:

- **Change Component Info**—Changes the search window and reference peak information for a range of components.
- **Change Calibration Info**—Changes parameters for a range of components.

The changes apply to the range of components and parameters that you specify in each dialog box. You specify the component range by using the index numbers for each component, which appear next to the entry in the component list.

To change component information for a range of components:

1. Select **Change Component Info** from the Components menu to open the Change Component Information dialog box.

2. To redefine the search window size, select the **Absolute Window** option, and type a new **value** (in seconds) in the text box.

3. To redefine the relative window size as a percentage of the expected retention time, select the **Relative Window** option, and type a new **value** in the text box.

4. To change to peak identification, select the **Peak Identification** option. Select **Find Largest Peak** if you want to identify the largest peak (based on height, not area) in the search window as the component.
changing parameters for multiple components simultaneously

5. To change the reference component, select the Reference Component option, and then select a name from the list. Select <no reference> to remove an existing reference component.

6. To change the internal standard component, select the ISTD Component option, and then select a component name from the list.

7. In the First Component text box, type the index number of the first component in the range that you want to change.

8. In the Last Component text box, type the index number of the last component in the range that you want to change.

9. Click OK.

The software updates the component list to reflect the changes you specified.
The Change Calibration Info command in the Components menu allows you to change the calibration data for more than one component. For example, you can change all components to use peak height instead of peak area.

To change calibration parameters for a range of components:

1. Select Change Calibration Info from the Components menu to open the Change Calibration Information dialog box.

2. To change the calibration type, select Change Calibration Type and select an option.
   
   For detailed information on each of the options, see “Setting calibration parameters” on page 7-46.

3. To change the peak response you want to use for calibration, select Change Response and select Area or Height.

4. To change the origin option, select Change Origin and select Include Origin, Force Origin or neither (to reset a previous origin option).

5. To change the plot scaling, select Change Scaling and select an option from the list.

6. To change the regression weighting, select Change Weighting and select an option from the list.

7. To change the curve fit type, select Change Curve and select an option from the list.

8. In the First Component text box, type the first index number in the range of components that you want to change.

9. In the Last Component text box, type the last index number in the range of components that you want to change.

10. Click OK.

   The software updates the component list to reflect the changes you specified.
7.11 Performing a Manual Calibration

The Calibrate command in the Components menu lets you use response values from one or more result files to update the calibration information in a method file. The procedure consists of:

- Selecting one or more result files
- Selecting a calibration level for each result file
- Selecting the calibration type for each combination of result files and calibration levels
- Performing the calibration

To perform a manual calibration, you must have a component list and calibration levels associated with each component in the list. You also need to verify that the calibration parameters for each component are correct before you perform a manual calibration.

When you manually calibrate a method, you create a *calibration replicate*. A replicate is a repetitive analysis of the same calibration standard for a particular calibration level. Since it is a unique analysis, you can use replicates to average calibrations.
Performing a manual calibration

To perform a manual calibration:

1. Select **Calibrate** from the Components menu to open the Manual Calibration dialog box.

2. Click **Add** to select the appropriate result file.

3. Select a **level** in the Level list box.

4. Select the Calibration Type:
   - **Replace**—Replaces the new replicates with the existing replicates.
   - **Average**—Averages the existing calibration replicates with the new replicates.

**Figure 7-15 Manual Calibration Dialog Box**
Performing a Manual Calibration

5. Repeat step 2 through step 4 to include more files.

**NOTE:** The Identify Peaks Before Calibrating feature is not supported in this version of software.

6. Click **OK**.

**Changing an entry**

To change an entry in the Filename/Level/Cal Type list:

1. Select the **entry** you want to change in the Filename/Level/Cal Type list.
2. Select a new **file name**, **level**, or **calibration mode**.
3. Click **Change**.
4. Click **OK**.

**Deleting an entry**

To delete an entry from the Filename/Level/Cal Type list:

1. Select the **entry** you want to delete in the Filename/Level/Cal Type list.
2. Click **Delete**.
3. Click **OK**.
Chapter 7 Adjusting Calibration Parameters

Excluding and Deleting Replicates

The software stores Calibration replicates. The averages appear in the Components dialog box. Once you create a replicate, you can either exclude it from the current calibration or delete it altogether.

To exclude a replicate:

1. Select Edit Component from the Components menu or double-click the component name in the Component List to open Components dialog box.

2. Select the Calibration tab to view the level settings for the selected component.

3. Double-click any level when the Replicates button is enabled or click the Replicates button to open the Replicates dialog box.

![Figure 7-16 Replicates Dialog Box](image)

4. Select the replicate you want to exclude from the list.

5. Click Exclude.

6. Repeat step 4 and step 5 for each additional replicate you want to exclude.

7. Click OK.
Performing a Manual Calibration

8. Click **OK** to close the Components dialog box.

   The points representing replicates now appear in a different color on the calibration curve for that component. The software excludes these replicates from the analysis (and the plot), but the replicates still exist in the result file.

**Including a replicate**

To include a replicate that you have excluded:

1. In the Components dialog box, double-click any **level** when the Replicates button is enabled or click the **Replicates** button to open the Replicates dialog box.

2. Select the **replicate** you want to include.

3. Click **Include**.

4. Repeat step 2 and step 3 for each additional replicate you want to include.

5. Click **OK**.

6. Click **OK** to close the Components dialog box.

**Deleting a replicate**

To delete a replicate:

1. In the Components dialog box, select the **replicate** you want to delete.

2. Click **Delete**.

3. Click **OK**.

   The software removes the replicate designation from the level you selected. Points associated with replicates also disappear from the calibration curve.

4. Click **OK** to close the Components dialog box.
This chapter includes the following sections:

8.1 Overview of Report Format Parameters................. 8-2
8.2 Adjusting Report Format Parameters.................... 8-4
8.3 Creating Title, Header, and Footer Text .............. 8-10
8.4 Setting Up Report Columns ......................... 8-12
   8.4.1 Adding and Deleting Columns ..........8-12
   8.4.2 Editing Column Information ........8-16
   8.4.3 Moving Columns ...................8-17
   8.4.4 Creating a Custom Expression
      Data Column ............................8-18
8.5 Editing Report Format Options ....................... 8-23
8.6 Printing Report Format Files ......................... 8-28
8.1 Overview of Report Format Parameters

Overview

This chapter explains how to use the Report Format Editor to adjust the report format section (.RPT) of a method file (.MET), data file (.B*), or group file (.GRO).

Figure 8-1  Report Format Parameters

MET, B*, or GRO File

MTH Analysis parameters:

- Processing parameters (peak detection/integration)
- Calibration parameters (calibration components)

RPT Report Format parameters
Overview of Report Format Parameters

**What are report format parameters?**
The report format section (.RPT) of a method, data, or group file contains default report format parameters (Figure 8-1). Report format parameters control:

- Parameters included in the report
- Appearance of the printed report

After the software analyzes a data file, it saves the results in the results section (.RST) of the data file and reports the results of that analysis using the report format parameters (.RPT).

**NOTE:** You can change the default report format parameters by editing the DEFAULT.RPT file. For more information, see “Editing DEFAULT.RPT” on page 8-9.

**Replacing report format parameters**
In addition to adjusting report format parameters, you can also replace report format parameters in a file by copying the parameters from another file. For more information, see “Replacing parameters” on page 4-4.

**Stand-alone .RPT files for optional reports**
You can select to generate up to six optional report formats in the analysis section (.MTH) of a file. For more information, see Section 6.2.3, Selecting Optional Reports. However, first you must use the Report Format Editor to save stand-alone .RPT files that you then select in the Optional Reports tab of the Process dialog box.
8.2 Adjusting Report Format Parameters

**Menus and commands**
You develop and modify report format parameters using the following menus and commands in the Report Format Editor (see Figure 8-3 on page 8-7):

- **File menu**
  Allows you to create, open, and save files; type a description of the report format; change printers; print report formats; and, exit the program.

- **User Notes menu**
  Allows you to create header, footer, and title text for the report.

- **Report menu**
  Allows you to select the columns that you want to have in the report including custom expressions that generate values in a column.

- **Edit menu**
  Allows you to move and delete columns.

- **Options command**
  Allows you to specify a variety of reporting options such as the size of the system header and the components to include.
To adjust report format parameters in a method file (.MET), data file (.B*), or group file (.GRO):

1. Access the Report Format Editor by doing one of the following in your BioCAD, VISION, or INTEGRAL software:

   **CAUTION**
   Once you access the Report Format Editor, changes you make and save overwrite the contents of the file you open in this step. If you want to make changes to the file and save under a different name, select **Save As** or **Save Group As** now, before selecting Adjust Report Format.

   **From Method Editor**
   - Display the Method Editor by selecting **Method Editor** from the Window menu.
   - Open a method file (.MET).
   - Select **Adjust Report Format** from the File menu.

   **From Group Analysis**
   - Display the Group Analysis window by selecting **Group Analysis** from the Window menu.
   - Open a data file (.B*) or group file (.GRO).
   - Select **Adjust Report Format** from the **Individual** or **Group** section of the Analysis menu.

   **NOTE:** Select Adjust Report Format from the Individual section to apply the changes to a single data file. Select Adjust Report Format from the Group section to apply the changes to a group of data files.
NOTE: If the Adjust Report Format command does not appear in the Individual section of the Analysis menu, select Tiled Mode from the Display menu.

The Adjust dialog box appears (Figure 8-2).

![Figure 8-2 Adjust Dialog Box](image)

**Selecting a data channel**

2. Select a data channel for which you want to change reporting parameters.

3. Click OK to display the Report Format Editor (Figure 8-3).

The file (.MET, .B*, or .GRO) you selected in step 1 appears in the title bar, augmented with the selected data channel and an .RPT extension.
4. If desired, change the default title and create a report header and footer. See Section 8.3, Creating Title, Header, and Footer Text.

5. Set up the columns you want to use for this report. See Section 8.4, Setting Up Report Columns.


7. If desired, print a copy of the contents of the report format file (.RPT). See Section 8.6, Printing Report Format Files.
NOTE: Once you modify a report format file (.RPT), the word MODIFIED appears at the right of the status bar of the Report Format Editor (Figure 8-3). The word MODIFIED remains there until you select Save from the file menu in the Report Format Editor.

8. Select Save from the File menu.

CAUTION

Once you select Save, the changes you made overwrite the contents of the file you opened in step 1.

The Documentation dialog box or the Audit Trail dialog box opens.

NOTE: Documentation and Audit Trail information are not supported in this version of software.

9. Click OK to close the dialog box.

10. To save a stand-alone .RPT file that you can specify in the optional reports section of the processing parameters select Save As from the File menu and specify a file name. For more information on specifying optional reports, see Section 6.2.3, Selecting Optional Reports.

11. Select Exit from the File menu to return to the Method Editor or Group Analysis window.
Opening additional files

You cannot open additional data files, group files, or method files from within the Graphic Method Editor. If you try to open one of these files, an error message is displayed.

To open a different data file, group file, or method file:

1. Return to the Method Editor or Group Analysis window.
2. Repeat the procedure starting on page 8-5.

Non-supported commands

The following commands under the File menu in the Report Format Editor are not supported:

- New
- Open
- Save As
- Description
- Audit Trail

NOTE: You can use the Open command under the File menu to edit the default analysis parameters file, as described below.

Editing DEFAULT.RPT

When you create a new method file (.MET) or group file (.GRO), initial settings and columns are loaded from the default report format file, DEFAULT.RPT, which is located in C:\PENEXE\TCWS\VER6.1.0\CONFIG\USER\PERSEPTIVE.

To edit DEFAULT.RPT, access the Report Format Editor, open DEFAULT.RPT by selecting Open from the File menu, edit it as desired, and save it. The software will prompt you to verify that you want to change the default report format file.
8.3 Creating Title, Header, and Footer Text

The commands in the User Notes menu allow you to create the following in a report format file (.RPT):

- Report title
- Report header
- Report footer

Creating a report title

To create a report title:

1. Select Title from the User Notes menu to open the Title dialog box.

![Figure 8-4 Title Dialog Box]

2. Type the title you want to use for this report and click OK.

When you click OK, the dialog box closes and the title for this report format file (.RPT) appears at the top of the report.

NOTE: After you create a report title, you can edit the title by clicking the title in the Report Format Editor window to open the Title dialog box.
Creating a header or footer

To create a header or footer:

1. Select **Header** or **Footer** from the User Notes menu to open the Header dialog box (Figure 8-5) or the Footer dialog box.

![Image of Header Dialog Box]

2. Type the **text** you want to appear as the header or footer in the text area of the dialog box and click **OK**.

When you come to the end of a line, press **Ctrl+M** to start a new line. You can enter up to 512 characters. To delete all existing text, click **Delete**.

When you click **OK**, the header or footer appears in the report window.

**NOTE:** After you create a report header or footer, you can edit the header or footer by clicking anywhere in the header or footer text in the Report Format Editor window to open the Header or Footer dialog box.
8.4 Setting Up Report Columns

This section describes:

- Adding and deleting columns
- Editing column information
- Moving columns
- Creating a custom expression data column

8.4.1 Adding and Deleting Columns

The default report format file shipped with the software includes the following columns:

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak</td>
<td>Time</td>
<td>Area</td>
<td>Height</td>
<td>Area</td>
<td>Norm. Area</td>
<td>Bl. Area</td>
<td>Bl. Area/Height</td>
</tr>
<tr>
<td>#</td>
<td>(min)</td>
<td>[pA:s]</td>
<td>[pA]</td>
<td>[%]</td>
<td>[%]</td>
<td>[s]</td>
<td>[s]</td>
</tr>
<tr>
<td>000</td>
<td>000.00</td>
<td>0000000.00</td>
<td>000000.00</td>
<td>000.00</td>
<td>000.00</td>
<td>XXX</td>
<td>0000000.0000</td>
</tr>
</tbody>
</table>

You can add and delete columns from a report format file (.RPT) as desired.
**Adding a report column**

To add a report column:

1. Select **Report** to display the available column types (Figure 8-6).

![Figure 8-6 Available Column Types](image)

2. Select a **column type** listed in the menu (Figure 8-6).

---

**NOTE:** For an explanation of each column type, refer to the Glossary.

The following column types are not supported:

- Normalized Area Percent
- Normalized Amount
- Voltage +/- Range
- Lambda Max
- Peak Purity Index
- Absorbance Ratio
- Spectral Standard Confirmation
- Spectral Library Confirmation
- Peak Library Search
- Mobility
Select **Blank Column** to insert blank space between columns or in the left or right margins.

Select **Custom Expression** to include mathematical operations within a column. For more information, see Section 8.4.4, Creating a Custom Expression Data Column.

The Column Information dialog box appears (Figure 8-7). The word "<none>" appears next to Current Column until you add this column to the report.

3. Type a **column number** in the Column Number text box. This establishes the location of this column relative to other columns on the page. For a column type that is not currently in the report, the default value is the next available column number. For a column type that already appears in the report, the default is the existing column number.

   If you assign the new column the same number as an existing column, the software automatically shifts the columns to the right to insert it.

4. Type the number of characters for the **column width**.
5. If Digits is available, type the **number of digits** you want
to display after the decimal point.

6. Type **text** for the **top line** of the column name in the
Column Label text box.

   **NOTE:** A column name can consist of one or two lines of
   alphanumeric characters. The Column Label text box is the top
   line. The Second Label text box is the bottom line.

   **NOTE:** If the column label exceeds the number of
   characters in the Column Width text box, the column
   will expand to the label width.

7. Type **text** for the **bottom line** of the column name in the
Second Label text box.
   The default format uses the second line for units.

8. Select **Calculate Total For This Column** to include a
column total.
   This option is available only for columns that have
numeric values.

9. Click **Insert/Add**.
   The new column appears in the report format.

**Deleting a report column**

To delete a report column:
- Click the **column** you want to delete to display the
  Column Information dialog box (Figure 8-7). Click **Delete**.

  **OR**

- Select **Delete Column** from the Edit menu to display the
  Delete Column dialog box. Type the **number of the column**
  that you want to delete, and click **OK**.
8.4.2 Editing Column Information

Use the Replace command to edit the information that appears for any column in a report format file.

To edit existing column information:

1. Click the column that you want to edit to display the Column Information dialog box (Figure 8-7).

2. Edit the information as described in “Adding a report column” on page 8-13. However, do not change the column number or you will move the column.

3. Click Replace.
8.4.3 Moving Columns

You can change the position of columns in a report format file in two ways:

- Use the Move button in the Column Information dialog box
- Use the Move Column command in the Edit menu

**Move button**

To move a column using the Move button:

1. Click the column you want to move to open the Column Information dialog box (Figure 8-7).
2. In the Column Number text box, type the new column number.
3. Click Move to close the dialog box and reposition the columns.

**Move Column command**

To move a column using the Move Column command:

1. Select Move Column from the Edit menu to open the Move Column dialog box (Figure 8-8).
2. Type the number of the column you want to move in the Which Column To Move text box, and type the number where you want the column to appear in the New Column Position text box.
3. Click OK to close the dialog box and move the column to the new location.
8.4.4 Creating a Custom Expression Data Column

**Overview**  Custom Expression is a special type of data column that allows you to include mathematical operations within a column. The information is the result of a calculation that is performed when the report is generated.

**Example**  For example, you must use custom expressions to calculate scaled percentage values. To obtain scaled values, the largest peak is assigned a value of 100% (or some other percentage) and percentage values for other peaks are scaled proportionately. You can use the following expressions:

- Scaled area:  \( \frac{#PA}{#MA} \times 100 \)
- Scaled height:  \( \frac{#PH}{#MH} \times 100 \)
- Scaled amount:  \( \frac{#AA}{#MC} \times 100 \)

In these expressions, \( #PA, #PH, \) and \( #AA \) represent peak area, peak height, and adjusted amount, respectively; and \( #MA, #MH, \) and \( #MC \) represent the maximum peak area, maximum peak height, and maximum adjusted amount, respectively.
Guidelines

Creating a custom expression is much like building a mathematical expression, except that you use the data values and operators provided in the Custom Expression Editor:

- Data values can be numbers or predefined values such as Area Percent and Sample Volume.
- Operators can be arithmetic, exponential or logarithmic.
- Calculations can be binary (performed with two values) or multi-level.

**NOTE:** Use US conventions for all number formats in the Custom Expression Editor. For example, although a Windows system may be set up to use German number formats, such as using a comma to designate a decimal point, the Custom Expression Editor only accepts a period as a decimal point.

**NOTE:** When a calculation is invalid (for example, division by zero), a dashed line appears in the report instead of a numeric value.
Creating a custom expression

To create a custom expression data column:

1. Select **Custom Expression** from the Report menu to open the Custom Expression Editor dialog box (Figure 8-9).

   The list box on the left shows the types of data that are available for calculations. Most of the items refer to individual peak values (such as #PA for Peak Area). Other items refer to the entire run (such as #TA for Total Area).

   ![Custom Expression Editor Dialog Box](image)

   **Figure 8-9 Custom Expression Editor Dialog Box**

2. Enter the desired **expression** in the Custom Expression text box.

   You can enter the expression either by choosing items from the Available Column Values and Available Operations lists or by typing the values and operations directly into the Custom Expression text box. To use constants as values, type desired constants directly into the Custom Expression text box.

   Most terms listed in the Available Column Values list are defined in the Glossary, which is available in this manual and in online Help.

3. Click **OK** when the expression is complete.
The Custom Expression Editor dialog box closes and the Custom Expression dialog box appears (Figure 8-10).

![Custom Expression Dialog Box](image)

**Figure 8-10  Custom Expression Dialog Box**

4. Type the **column number** where you want the expression to appear.

5. Type other **parameters** for this column. For more information, see “Adding a report column” on page 8-13.

6. Click **Insert/Add**.

   The label you assigned to the custom expression appears at the top of the column. When the software generates a report based on this format file, the result of that expression will appear in the column.
Creating additional custom expressions

Use data from an existing custom expression column as a basis (or template) for creating additional custom expressions. This enables you to derive new custom expressions from existing custom expressions quickly without having to re-enter data.

When there is only one custom expression in the report, its data is always used as a template for creating another custom expression. But when there is more than one custom expression, you must select the specific custom expression whose data you want to use. You can either:

- Click the desired custom expression to display the Custom Expression Editor dialog box.

  OR

- Select Custom Expression from the Report menu to display the Duplicate Columns dialog box. Select the custom expression column whose data you want to use and select OK.

Whichever method you select, the Custom Expression Editor dialog box appears (Figure 8-9). It already contains expression data. Use the procedure described in “Creating a custom expression” on page 8-20 to build the new custom expression.
8.5 Editing Report Format Options

Edit report format options to control which information is included in a report.

To edit report format options:

1. Select **Options** to display the Report Format Options dialog box (Figure 8-11).

   ![Report Format Options Dialog Box](image)

   **Figure 8-11 Report Format Options Dialog Box**

2. Select the **size** (Small, Medium, or Large) of the System Header you want to include in the report. The System Header contains summary information about the analysis. It is not simply a label like the user-entered report header is. Table 8-1 shows which data is included in Small, Medium, and Large report headers.
Table 8-1  Data Included in Report Headers

<table>
<thead>
<tr>
<th>Item</th>
<th>Comments</th>
<th>Small</th>
<th>Medium</th>
<th>Large</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Version</td>
<td>Turbochrom software version</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Operator</td>
<td>Not supported</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Sample Number</td>
<td>Not supported</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Autosampler</td>
<td>Not supported</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Instrument Name</td>
<td>SPRINT, BioCAD 700E, VISION, or INTEGRAL 100Q</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Instrument Serial #</td>
<td>Not supported</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Delay Time</td>
<td>Always reported as 0.00 min</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Sampling Rate</td>
<td>Data rate for exporting (pts/sec)</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Volume Injected</td>
<td>Not supported (Always 1.0 µl)</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>NOTE: This is not the injection volume you enter in your method.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sample Amount</td>
<td>Sample volume injected</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Data Acquisition Time</td>
<td>Date and time data acquired</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Date</td>
<td>Date and time report printed</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Sample Name</td>
<td>Sample name in method</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Study</td>
<td>Name of method file (.MET) or template</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Rack/Vial</td>
<td>Not supported</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Channel</td>
<td>Not supported (Always A)</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>A/D mV Range</td>
<td>Not supported (Always 1000)</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>
### Table 8-1  Data Included in Report Headers (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Comments</th>
<th>Small</th>
<th>Medium</th>
<th>Large</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Time</td>
<td>Length of run (minutes)</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Area Reject</td>
<td>Not supported (Always 0.0)</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Dilution Factor</td>
<td>Not supported (Always 0.0)</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Cycle</td>
<td>Not supported (Always 1)</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Raw Data File</td>
<td>Raw data section (.RAW) of analyzed file</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Result File</td>
<td>Results sections (.RST) of analyzed file</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Inst Method</td>
<td>Not supported</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Proc Method</td>
<td>Analysis section (.MTH) of analyzed file</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Calib Method</td>
<td>Analysis section (.MTH) of analyzed file</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Sequence File</td>
<td>Not supported</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Processing parameters</td>
<td>Noise threshold, Area threshold, bunch factor, multiplier, divisor, and addend</td>
<td>-</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>User#</td>
<td>Not supported</td>
<td>-</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>Number of peaks detected</td>
<td></td>
<td>-</td>
<td>-</td>
<td>x</td>
</tr>
</tbody>
</table>
3. Select any **Report Body Options** you want to use. To print only the system header information in the report, deselect Print Main Report Body and go to step 5.

Refer to the Status bar for a description of each Report Body Option. Certain options are further described below.

- If you choose to include named or timed groups in the body of the report (by selecting **Identified named groups** or **Identified time groups**), then the individual members of the group will not be reported. The group amount will be based on the calibration of the group as a whole. Conversely, if groups have been defined but are not included in the report body, the individual components and/or peaks will be reported based on their individual calibrations.

**NOTE:** If you select **Identified named groups** or **Identified time groups**, include a Component Name column in the report format. For more information, see “Adding a report column” on page 8-13.

- If you select **Missing Components**, **Missing Named Groups**, or **Missing Timed Groups**, the peak index and quantities will be zero because no peaks will be found. The rows will contain zeroes and will use the expected retention time.

4. Type a value for **Area Reject** to represent the minimum peak area that you want included in the report.

5. Select the **Compressed Mode** option you want to use.

   If you select **Always Use Condensed Font**, the report will print 132 characters per line. If you select **Use Normal Font When Possible**, the software will print the report using 79 characters per line whenever possible.
6. Select any **Miscellaneous Options** you want to use. Refer to the Status bar for a description of each option. Certain options are further described below:

---

**NOTE:** *Create AIA Metafile is not supported in this version of software.*

---

- If you select either **Expand Named Groups** or **Expand Timed Groups**, the software will include a supplementary report following the main report. This report includes the individual component and/or peak results. These results are always based on the individual calibration of the group members. For timed group members, this may be one of the options for calibrating unidentified peaks.

- Select **Create ASCII Delimited File** if you want to create a file that contains a version of the report that is readable by another application.

  When you print a report from the Graphic Method Editor, these files are saved in the DATA directory with the file extensions .TX0 through .TX6. TX0 is the base report, and TX1 through TX6 are the optional reports from the processing section of the method. The report name is taken from the name of the data file.

- Select **Formfeed Between Reports** to start any optional report on a new page. Otherwise, the optional report will immediately follow the primary report on the same page.

---

**NOTE:** *You select optional reports in the analysis parameters (.MTH). For more information, see Section 6.2.3, Selecting Optional Reports.*
To print a chromatogram and report on one page, set System Header to None, select Print Replot with Report, deselect Formfeed Between Reports, and deselect Generate a Separate Replot in the Replot Options dialog box in the analysis parameters section of the method (see Section 6.2.4, Editing Replot Parameters).

7. Type a value in the Replot Size text box to indicate the height of the chromatogram replot on the page.

8. Click OK.

8.6 Printing Report Format Files

The Print command in the File menu lets you print a copy of the current report format file. This output lists the contents of the report format file. It does not print an example of the report format like the one you see in the Report Format Editor window.
This chapter includes the following sections:

9.1 Overview of Analysis Parameters and Graphic Editing ............................................. 9-2
9.2 Adjusting Analysis (Processing and Calibration) Parameters Graphically ........... 9-3
9.3 Understanding the Graphic Method Editor Window ............................................. 9-10
9.4 Changing Display Options ................................................. 9-12
9.5 Adjusting Processing Parameters ............... 9-24
9.6 Working with Components ......................... 9-39
9.7 Displaying and Printing Information ........... 9-60
9.1 Overview of Analysis Parameters and Graphic Editing

**Overview**
This chapter explains how to create optimal analysis parameters (.MTH) within a method file (.MET), data file (.B*), or group file (.GRO), by manipulating a typical chromatogram in the Graphic Method Editor.

**Text editing versus graphic editing**
Analysis parameters such as integration thresholds, timed events, and component retention times determine how the software analyzes raw data. When you vary these parameters, you can dramatically affect the outcome of an analysis. However, when you first create analysis parameters in the Text Method Editor, it is difficult to estimate what values will provide the best data analysis. Sometimes, you need to perform an analysis before you can verify the results.

When you view the data in graphic form, you can determine if the software is detecting peaks correctly, placing baselines properly, and if expected retention times and search windows for components are identifying peaks accurately. If you discover that the analysis is inadequate or wrong, you can change the analysis parameters while viewing the chromatogram and see the effects of the change immediately.

---

**Figure 9-1 Analysis Parameters**

<table>
<thead>
<tr>
<th>MET, B*, or GRO File</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTH</td>
</tr>
<tr>
<td>Analysis parameters:</td>
</tr>
<tr>
<td>Processing parameters (peak detection/integration)</td>
</tr>
<tr>
<td>Calibration parameters (calibration components)</td>
</tr>
<tr>
<td>RPT</td>
</tr>
<tr>
<td>Report Format parameters</td>
</tr>
</tbody>
</table>
9.2 Adjusting Analysis (Processing and Calibration) Parameters Graphically

Overview
You can access the Graphic Method Editor to adjust analysis parameters from two windows:

- **Method Editor**—To graphically adjust analysis parameters (.MTH) of a method file (.MET)
- **Group Analysis window**—To graphically adjust analysis parameters (.MTH) of a data file (.B*) or group file (.GRO)

Hint: To adjust the analysis parameters (.MTH) of a method file (.MET), you need a representative data file to view and manipulate in the Graphic Method Editor. If you do not have a representative data file, run your method to generate a data file. Then select the generated data file as described in the following procedure. You can rerun your method after adjusting the analysis parameters (.MTH).

To graphically adjust analysis parameters (.MTH) of a method file (.MET):

1. Display the Method Editor by selecting **Method Editor** from the Window menu.
2. Open a method file (.MET).

**CAUTION**
Once you access the Graphic Method Editor, changes you make and save overwrite the contents of the file you open in step 2. If you want to make changes to the file and save under a different name, select **Save As** now, before selecting Adjust Analysis Plot.
3. Select **Adjust Analysis Plot** from the File menu.

The Select Example Data File dialog box appears (Figure 9-2).

![Select Example Data File Dialog Box](image)

4. Select a **data file (.B*)**.

Select a data file that is representative of the one you will generate with the method file (.MET) opened in step 2. You will manipulate the chromatogram of this data file to change the analysis parameters in the method file (.MET). However, this manipulation does **not** change the analysis parameters in this data file (.B*).

5. Select a **data channel** (UV #1, UV #2, or Auxiliary) to analyze.
6. Click **OK** to display the Graphic Method Editor window (Figure 9-4).

The Graphic Method Editor displays the following file names:

- **Title bar**—The method file you selected in step 2, augmented with the selected data channel and an .MTH extension
- **Status bar**—The data file you selected in step 4, augmented with the selected data channel and an .RAW extension

The software performs peak detection, integration, and component identification on the raw data using the analysis parameters (.MTH) embedded in the method file (.MET) you opened in step 2. Then the software displays the chromatogram, showing the resulting integration and peak identification.

7. Adjust the analysis parameters (.MTH) as described in “Adjusting analysis parameters” on page 9-8.
Adjusting .MTH of a data file or group file

To graphically adjust analysis parameters (.MTH) of a data file (.B*) or group file (.GRO):

1. Display the Group Analysis window by selecting Group Analysis from the Window menu.

2. Open a data file (.B*) or group file (.GRO).

**CAUTION**
Once you access the Graphic Method Editor, changes you make and save overwrite the contents of the data file or group file you open in step 2. If you want to make changes to the file and save under a different name, select Save Group As now, before selecting Adjust Analysis Plot.

3. Select Adjust Analysis Plot from the Individual or Group section of the Analysis menu.

**NOTE:** Select Adjust Analysis Plot from the Individual section to change the analysis section (.MTH) of the active data file. Select Adjust Analysis Plot from the Group section to change the analysis section (.MTH) of the group file.

**NOTE:** If the Adjust Analysis Plot command does not appear in the Individual section of the Analysis menu, select Tiled Mode from the Display menu.

The Adjust dialog box appears (Figure 9-3).
4. Select a data channel (UV #1, UV #2, or Auxiliary) to analyze.

5. Click OK to display the Graphic Method Editor window (Figure 9-4).

   The Graphic Method Editor displays the following file names:
   - **Title bar**—The data file or group file you selected in step 2, augmented with the selected data channel and an .MTH extension
   - **Status bar**—The active data file, augmented with the selected data channel and an .RAW extension

   The software performs peak detection, integration, and component identification on the raw data using the analysis parameters (.MTH) embedded in the file you opened in step 2. Then the software displays the chromatogram, showing the resulting integration and peak identification.

6. Adjust the analysis parameters (.MTH) as described in “Adjusting analysis parameters” on page 9-8.
After you access the Graphic Method Editor:

1. Adjust the analysis parameters (processing and calibration) until the parameters produce the results you want. For more information, see the following sections:
   - Section 9.3, Understanding the Graphic Method Editor Window
   - Section 9.4, Changing Display Options
   - Section 9.5, Adjusting Processing Parameters
   - Section 9.6, Working with Components
   - Section 9.7, Displaying and Printing Information

   NOTE: Once you modify the analysis parameters, the word MODIFIED appears at the right of the status bar of the Graphic Method Editor (Figure 9-4). The word MODIFIED remains there until you select Save from the File menu in the Graphic Method Editor.

2. Select Save from File menu.

   The changes you made are saved to the analysis section (.MTH) of the method file, data file, or group file whose name appears in the title bar.

   The Documentation dialog box or the Audit Trail dialog box opens.

   NOTE: Documentation and Audit Trail information are not supported in this version of software.

3. Click OK to close the dialog box.

4. Select Exit from the File menu to close the Graphic Method Editor, and return to the Method Editor or Group Analysis window.

You can not open additional data files, group files, or method files from within the Graphic Method Editor. If you try to open one of these files, an error message is displayed.
To open a different data file, group file, or method file:

1. Return to the Method Editor or Group Analysis window.
2. Repeat the procedure starting on page 9-3.

**Non-supported commands**

The following commands under the File menu in the Graphic Method Editor are not supported:

- New: New Data File
- Open: New Report Format
- Save As: Save Result File As
- Description: Save Result File with Time Stamp
- Audit Trail: Save As MetaFile
- Preserve View
9.3 Understanding the Graphic Method Editor Window

By default, the Graphic Method Editor (Figure 9-4) shows a *working chromatogram* in the main work area of the window, and a *reference chromatogram* above it.

![Figure 9-4 Graphic Method Editor Window](image)

You can toggle the display of the reference chromatogram by selecting **Reference Chromatogram** from the Display menu.
The Graphic Method Editor contains the following menus and commands:

**File menu** Allows you to:
- Print
- Save changes
- Exit the Graphic Method Editor

**Process menu** Allows you to:
- Edit baseline timed events
- Optimize processing parameters such as noise and area thresholds
- Manually integrate peaks by redrawing the baseline

**Calibration menu** Allows you to perform component tasks such as:
- Create or merge component lists from peak lists
- Change component information and build or edit named and timed groups
- Display and revise search windows
- Update calibration information

**Display menu** Allows you to control display characteristics, including the plot scale and whether items such as the report header, peak report, or reference chromatogram appear on the screen.

**Status bar** The status bar, located at the bottom of the Graphic Method Editor window, shows:
- Data file name
- Mouse pointer X and Y coordinates
- Number of points in the chromatogram
- Help for the currently selected command
- Whether or not you have modified the file
9.4 Changing Display Options

Display menu commands let you change how chromatographic data appears as well as other attributes of the Graphic Method Editor. You can:

- Open a report information window above the chromatogram to review the peak report or report header, select another report format file, or print a report
- Use raw data points or bunched points to display the chromatogram
- Show or hide the reference chromatogram
- Display the entire chromatogram, if you have expanded it
- Redefine the plot scale by entering specific values
- Expand both chromatograms together by expanding the reference chromatogram

The following sections explain how to perform each task. For more information on how to use the report commands, see Section 9.7, Displaying and Printing Information.
9.4.1 Changing the Plot Display

You can display the chromatogram as any one of the following formats:

- Raw data points
- Raw and bunched data points
- Line segments

Figure 9-5, Figure 9-6, and Figure 9-7 illustrate each format.
To change the plot display:

Select one of the following formats from the Display menu:

- Raw Points
- Raw Points With Bunching
- Lines

The plot appears in the format you selected.
9.4.2 Changing the Plot Scale

The Rescale Plot command in the Display menu lets you change the parameters that affect which part of the run (the chromatographic data) that you see in the main window. These parameters include:

- Starting and ending times
- Offset value
- Full scale value

To edit the scaling parameters:

1. Select Rescale Plot from the Display menu.

   The Rescale Plot dialog box appears (Figure 9-8).

   ![Figure 9-8  Rescale Plot Dialog Box](image)

2. In the Start Time text box, type the time you want at the start of the plot window.

   The start time must be the same as or greater than the delay time for the start of data acquisition. This time must also be less than the total run time for the chromatogram.

3. In the End Time text box, type the time you want at the end of the plot window.

   The end time must be later than the start time, and be less than the total run time for the chromatogram.
4. In the Offset text box, type the offset value that you want to appear at the bottom of the plot window.

The plot always appears above the actual bottom of the window to allow enough room for component names.

5. In the Full Scale text box, type a value to specify the height of the plot window.

The mAUnit value assigned to the top of the plot window is equal to the full scale value plus the offset value. A data point that has a voltage value equal to the sum of the offset and full scale is plotted at the top of the window. A data point with a value equal to the offset voltage is plotted at the bottom of the window.

6. Click OK to redraw the plot using the new values.

Redrawing the plot

To redraw the plot at the default scaling:

Select Entire Chromatogram from the Display menu.

The software re-displays the plot in its entirety, showing the full time span and recalculating the full scale and offset values, based on the maximum and minimum data values in the file.

9.4.3 Expanding Chromatograms

By default, the software displays the chromatogram and shows the complete run with the largest peak set to full scale. You can quickly expand and reduce the plot display by using the mouse to rescale the plot manually. You can also redefine scaling parameters in the Rescale Plot dialog box, as shown in Section 9.4.2, Changing the Plot Scale.
Expanding the chromatogram

To expand the chromatogram using the mouse:

1. Position the mouse pointer where you want the starting point of the expansion to be.

2. Click-drag to select a rectangular area of the working chromatogram to enlarge (Figure 9-9).

3. Release the mouse button.

The selected area of the working chromatogram expands, and the software highlights the visible portion in the reference chromatogram (Figure 9-10).
Figure 9-10  Expanded Area of Working Chromatogram

The left and right sides of the selection rectangle are equivalent to the starting and ending times in the Rescale Plot dialog box. The height and bottom position of the selection rectangle are equivalent to the full scale and offset values in the Rescale Plot dialog box.
Returning chromatogram

To return the chromatogram to a previous level of expansion:

- Position the mouse anywhere on the chromatogram and click the right button one or more times until the plot appears at the level of expansion you want.

- To immediately return the plot to the default view, select Entire Chromatogram from the Display menu.

When you select a portion of the working chromatogram to expand it, the software does not normally expand the reference chromatogram. The Expand Reference Chromatogram command enables you to expand both chromatograms simultaneously.

Expanding both chromatograms simultaneously

To expand both reference and working chromatograms simultaneously:

1. Select Expand Reference Chromatogram from the Display menu.

2. In the reference chromatogram, select the part of the plot you want to enlarge.

   The software redraws both plots to show the part of the run you selected. Figure 9-11 shows both chromatograms expanded.
Figure 9-11  Both Chromatograms Expanded
Reducing reference chromatogram

To reduce just the reference chromatogram:

- Click the right mouse button inside the reference chromatogram.

- The software restores the reference chromatogram to the previous scaling; the working chromatogram maintains its current level of expansion.

Reducing both chromatograms

To reduce both reference and working chromatograms:

1. Click the right mouse button inside the working chromatogram.

- The software restores both plots to the previous scaling.

- If you click the right mouse button inside the reference chromatogram after you start to reduce the view in the working chromatogram, an update message appears.

2. Click Yes and click the right mouse again to continue reducing the view.
9.4.4 Manipulating the Reference Chromatogram

If you have not expanded the reference chromatogram, the software displays visible portion of the working chromatogram as a selection rectangle in the reference chromatogram. You can manipulate this selection rectangle to change which part of the plot appears in the working chromatogram window.

To display a different part of the chromatogram:
1. Move the mouse pointer over the selection rectangle in the reference chromatogram.
   The mouse pointer changes to a cross.
2. Click-drag the outline of the selection rectangle to the part of the chromatogram you want to view.
3. Release the mouse button.
   The software displays the selected part of the reference chromatogram in the working chromatogram.

In addition to changing which part of the chromatogram appears in the working area, you can also change the size and proportions of the selection rectangle in the reference chromatogram.

To change the size of the displayed region:
1. Move the mouse pointer to an edge of the selection rectangle in the reference chromatogram.
   The mouse pointer changes to a double-headed arrow.
2. Click-drag the edge until the rectangle is the size you want.
3. Release the mouse button.
9.4.5 Hiding or Showing the Reference Chromatogram

By default, the software displays the reference chromatogram above the working chromatogram in the Graphic Method Editor. You use the Reference Chromatogram command as a toggle to hide or show the reference chromatogram.

To hide or show the reference chromatogram:

1. Select Reference Chromatogram from the Display menu to deselect the command.

   The software redraws the working chromatogram to fill the entire window.

2. Select Reference Chromatogram again to show the reference chromatogram.
9.5 Adjusting Processing Parameters

Most of the commands in the Process menu affect peak detection and integration. For detailed information on the basic concepts, terminology, and effects of setting these parameters, see Chapter 6, Adjusting Processing Parameters.

The following sections explain how to adjust processing parameters in the Graphic Method Editor and see their effects on a completed run.

9.5.1 Setting Baseline Timed Events

Baseline timed events affect how the software detects and integrates peaks during a run. Therefore, you can use them to help maintain consistent results when peak and baseline noise characteristics change.

You can set baseline timed events for the processing parameters of the analysis section (.MTH) of a file in the Graphic Method Editor.
Setting baseline timed events

To set baseline timed events:

1. Select Baseline Events from the Process menu to open the baseline timed events display.

![Figure 9-12 Baseline Timed Events Display](image)

The menu bar changes to show the following commands:

- **Delete Events**—Lets you delete one or more baseline timed events from the chromatogram.

- **Reprocess**—Reprocesses the raw data file using the new baseline events.

- **Return**—Closes the baseline timed events display.
2. From the Events list, select the **baseline timed event** that you want to add.

   For technical information about these events, see Section A.3.3, How Timed Events Affect Peak Detection, and Section A.4.5, How Timed Events Affect Integration.

3. If the event requires a **value**, select one from the Value list.

4. On the chromatogram, click where you want the event to occur.

   The event appears at the specified point on the plot.

   ![Chromatogram with baseline timed events marked]

   If you make a mistake, you can delete the event and try again. Alternatively, you can set the exact time at which you want the event to occur in the Baseline Timed Events tab of the Process dialog box. For more information, see Section 6.2.2, Adjusting Baseline Timed Events.

5. Repeat step 2 through step 4 to add other events.

6. Select **Reprocess** or **Return** to implement the change.
Deleting baseline timed event

To delete a baseline timed event:

1. Select **Baseline Events** from the Process menu to open the baseline timed events display.

2. Select **Delete Events** to display the Delete Timed Events dialog box.

3. Select one or more **events** to delete.

4. Click **OK**.

   The software deletes the events from the list and the chromatogram.
Reprocessing peak data

To reprocess peak data after adding or deleting baseline timed events:

1. Select **Reprocess**.
   
The software reprocesses the raw data by performing peak detection, integration, component identification, and quantitation, using the current analysis parameters.

2. Select **Return** to close the baseline timed events display.
9.5.2 Setting Noise and Area Thresholds

To ensure that the software detects small peaks, but does not interpret baseline noise as peaks, you need to calculate the baseline noise and set noise and area thresholds to ignore the baseline noise.

The Noise/Area Threshold command in the Process menu lets you change the settings that exist in the analysis parameters, and view the result of the changes immediately.

To change the noise and area thresholds used in the analysis section of a method file or data file:

1. Select **Noise/Area Threshold** from the Process menu.

   The status bar message prompts you to outline the portion of the baseline that you want to use for calculating a new threshold level.

2. In the working chromatogram, click-drag to select the part of the baseline that you want to analyze.

   The software uses only the starting and ending times of your selection, not the height.

3. Release the mouse button.

   The Noise/Area Threshold dialog box appears (Figure 9-14), and the software draws the baseline drift and RMS baseline noise levels for the selected section.

   ![Figure 9-13 Example of Selected Baseline](image-url)
The Noise/Area Thresholds dialog box has the following information and options:

- **Baseline Drift**—The calculated drift (slope) for the best fit.
- **Baseline Intercept**—The calculated intercept (at time = 0 minutes) for the best fit.
- **RMS Baseline Noise**—The calculated noise value (root-mean squared) for the best fit.
- **Current NT**—The current noise threshold level.
- **Current AT**—The current area threshold level.
- **Suggested NT**—The suggested optimum noise threshold.
- **Suggested AT**—The suggested optimum area threshold.

4. Make any changes to the values in the **Suggested NT** and **Suggested AT** text boxes and click **OK**.

The software reprocesses the data and redraws the results of the integration based on the new noise and/or area threshold levels.
9.5.3 Setting a New Bunching Factor

When you develop analysis parameters, you need to determine how much data to collect to achieve the most accurate quantitation. The Sampling Rate/Bunching Factor command in the Process menu helps optimize peak detection by:

- Measuring the peak width to determine the right sampling rate for future analyses.
- Setting the best bunching factor to reprocess files that already exist.
To set a new bunching factor:

1. Select **Sampling Rate/Bunching Factor** from the Process menu.

   The status bar message prompts you to outline the narrowest peak to use for the calculation.

2. Click-drag to outline the narrowest peak in the working chromatogram (Figure 9-15). This is the same action you would perform to expand the working chromatogram to show just that peak.

   You do not need to select the entire peak because the software uses only the starting and ending times of the region that you select.

   ![Click-Dragging to Select Narrowest Peak](Figure 9-15)

   **Figure 9-15 Click-Dragging to Select Narrowest Peak**

When you release the mouse button, the Sampling Rate/Bunching Factor dialog box appears (Figure 9-16).
Adjusting Processing Parameters

Figure 9-16 Sampling Rate/Bunching Factor Dialog Box

The dialog box has the following information and options:

- **Peak Width (s)**—The width of the peak, in seconds, that you just selected.
- **Peak Width (pts)**—The width of the peak, in data points, that you just selected.
- **Old Sampling Rate (pts/s)**—Not supported in this version of software.
- **Old Bunching Factor (pts)**—The bunching factor currently set in the processing section of the analysis parameters.
- **Sampling Rate**—Not supported in this version of software.
- **Bunching Factor**—The recommended new bunching factor.

3. Leave Bunching Factor selected and then type a new value.

4. Click **OK**.

   The software reprocesses the data and redraws the chromatogram using the new values.
9.5.4 Changing Peak Separation and Exponential Skim Criteria

Peak separation indicates whether a peak is fully resolved from the peaks on either side of it, or if it partially overlaps one or both of the other peaks. The software uses two criteria to determine if peaks are separated:

- Width ratio
- Valley-to-peak ratio

For more information, see “Peak separation criteria” on page -15.

The software uses three criteria to define whether or not to use an exponential skim line to calculate the area of peaks eluting on the trailing edge of a parent peak:

- Peak height ratio
- Adjusted height ratio
- Valley height ratio

For more information, see “Exponential skims” on page -33.

The Peak Separation/Expo Skim command in the Process menu lets you set and modify each of these parameters. For more information on each of these options, see Chapter 6, Adjusting Processing Parameters.

CAUTION

Modify these values with caution. If you change these parameters without fully understanding the potential consequences, you might obtain invalid results.
To change the peak separation and exponential skim criteria for a peak:

1. Select **Peak Separation/Expo Skim** from the Process menu to display the Peak Separation/Expo Skim dialog box (Figure 9-17).

![Peak Separation/Expo Skim Dialog Box](image)

**Figure 9-17 Peak Separation/Expo Skim Dialog Box**

2. Make any changes to the values for the Peak Separation Criteria.

A peak must meet both of the following criteria to be considered separated:

- **Width Ratio**—The ratio of the distance between two peaks to the width of the base of the second peak. If the actual value of this ratio for two peaks is greater than the value set here, the software considers the peaks separated. Otherwise, the software marks them as overlapped.

- **Valley-To-Peak Ratio**—The ratio of the height of the valley between the peaks to the height of the smaller peak. If the actual value of this ratio for two peaks is less than or equal to the value set here, the software considers the peaks to be separated. Otherwise the software marks them as overlapped.
This information determines how the software draws the baseline beneath the peaks. The baseline codes in a report indicate the baseline used for each peak.

3. Make any changes to the values for the Exponential Skim Criteria.

All peaks must meet all the following three criteria to be skimmed. If any of the peaks does not meet these criteria, the software uses a vertical dropline to separate the peaks.

- **Peak Height Ratio**—The ratio of the baseline-corrected height of the parent peak to the baseline-corrected height of the child peak. The actual value of this ratio must be greater than the value set here for the child peak to be skimmed off the parent. To disable exponential skimming throughout the run, you can set this parameter to its maximum value.

- **Adjusted Height Ratio**—The ratio of the height of the parent peak above its start point to the height of the child peak above the same point. The actual value of this ratio must be greater than the value set here for the child peak to be skimmed off the parent.

- **Valley Height Ratio**—The ratio of the baseline-corrected height of the child peak to the height of the valley between the parent and child peaks above the baseline. The actual value of this ratio must be less than the value set here for the child peak to be skimmed off the parent.

4. Click **OK**.

The software reprocesses the data file and changes the chromatogram display to reflect the new values.
9.5.5 Drawing the Baseline Manually

The Manual Integration command in the Process menu allows you to set timed events that indicate the baseline that you want to use beneath specific peaks.

These manual integration timed events become part of the analysis parameters, just like ordinary baseline timed events, and the software does not erase them if you reprocess the data later with the same method. The UF events override the normal peak detection process.

If you manually draw in a baseline for a peak that the software did not previously detect, the software integrates the peak. However, if you draw a segment of the baseline underneath a cluster of peaks, the software will end the current cluster and draw new peaks as directed by the timed events.

To redraw a baseline:

1. Toggle **Manual Integration** from the Process menu.

   The status bar message at the bottom of the window prompts you to draw a baseline under a new or existing peak.

2. To draw a new baseline, click-drag the mouse from the required baseline starting point to the ending point.

   As you drag, the software creates a line between the starting point and the current mouse location.

When you release the mouse button, the software draws the new baseline on the plot and adds the +UF and −UF timed events to the chromatogram.
You can underline more than one peak at a time, and include peaks that were not marked previously by baselines. If you mark peaks that do not have baselines, the software adds the new peaks to the peak list. The software reprocesses the data through peak detection and integration, and redraws the plot.

**NOTE:** To start (or end) a baseline at the exact mouse pointer location, hold the Shift key while pressing (or releasing) the mouse button. Otherwise, the start or end point will be the raw data value on the Y-axis that corresponds to the cursor time position.

3. Repeat Step 2 for each baseline you want to add.

**Deleting a baseline**

To delete a baseline:

- Select **Baseline Events** and delete the +UF and –UF timed events with the Delete Events command.

  OR

- Right click between the +UF and -UF events and select **Delete Baseline** from the pop-up menu. If you have more than one baseline, the software will delete the baseline closest to the mouse pointer.
9.6 Working with Components

Using the Calibration commands

This section describes the different procedures for components tasks for the Graphic Method Editor. The commands in the Calibration menu allow you to establish, or revise, the component information in the calibration section of the analysis parameters. The component information defines which peaks the software identifies and as what component. You can add, delete, or change components, create or modify groups, change search windows, and modify other calibration characteristics.

For detailed information on the basic concepts, terminology, and effects of setting calibration parameters, see Chapter 7, Adjusting Calibration Parameters.

The following sections describe how to:

- Create a component list from a peak list
- Edit component information
- Add and edit single peak components
- Re-identify peaks
- Create and edit named and timed groups
- Display search windows
- Update calibration information
9.6.1 Creating a Component List From a Peak List

During the peak detection phase of data analysis, the software assigns a sequential number to each detected peak. This list is referred to as the peak list. The component list, in contrast, is the list you create in the analysis parameters that identifies each peak as a specific component.

The Load From Peak List and Merge From Peak List commands in the Calibration menu let you add components to the analysis parameters from the current peak list.

Creating a component list

To create a component list from a peak list:

Select Load From Peak List from the Calibration menu.

The software adds a component to the list for every unidentified peak in the chromatogram. Component names take the form peak (n), where (n) is the index number of the peak.

You can use the Load From Peak List command even if a component list already exists. The software retains in the list any existing components that are matched with peaks and deletes any component that is not matched with a peak. Previously unidentified peaks will be added to the component list as described above.

The Merge From Peak List command, in contrast, retains all existing components whether they are matched to peaks or not. It adds a new component for each previously unidentified peak.
To merge a peak list with the component list:

Select **Merge From Peak List** from the Calibration menu.

The software retains all current components whether the components are identified with a peak or not. The software then adds a component name to the list for every unidentified peak in the chromatogram. These component names take the form `peak (n)`, where `(n)` is the index number of the peak. The software bases the index number on the order that it occurs in the run. The new component names appear on the chromatogram.

When you merge or load from component lists, the software creates default component names. You can use the Edit Components command to enter new names.
Reviewing and revising component names

To review and revise component names:

1. Select **Edit Components** from the Calibration menu to display the Edit Components dialog box to the right of the Graphic Method Editor (Figure 9-18).

2. In the **Name** combo box, rename each component as necessary.

3. Click **Next** or **Prev** to process the change and to select the next or previous name in the list.

4. Repeat step 2 and step 3 for all component names you want to change.

5. Select **Return** to close the dialog box when done.

---

**Figure 9-18 Edit Components Dialog Box**
9.6.2 Editing Component Information

The Edit Components command in the Calibration menu of the Graphic Method Editor lets you:

- Assign a component name to a previously unidentified peak
- Change the association between peaks and components (re-identify peaks)
- Update the calibration level and amount for a component
- Define or specify components as reference components or internal standards
- Define and modify single peak, named group, and timed groups components
- Display or change search windows

To open the Edit Components dialog box:

Select **Edit Components** from the Calibration menu to display the Edit Components dialog box to the right of the Graphic Method Editor (Figure 9-19).
The menu bar changes to display the following commands:

- **Type menu**—Lets you select the type of component to add or edit.
- **Re-Identify command**—Re-identifies peaks after you change component information.
- **Return command**—Closes the Edit Components dialog box and restores the main Graphic Method Editor window.
9.6.3 Adding and Editing Single Peak Components

The following procedures explain how to:

- Identify a previously unidentified peak by creating a new component
- Change information for an existing component

If you want to change which peak a component is assigned to, see “Re-Identifying Peaks” on page 9-49.

To add or edit a single peak component:

1. Select **Edit Components** from the Calibration menu.

   The Edit Components dialog box appears and the plot display changes to reflect component names, retention times, and search windows. The first peak in the plot, which the software may or may not have identified as a component, has a dotted rectangle around it to indicate that it is the currently selected peak. Click **Next** and **Prev** in the dialog box to select the next or previous peak.

2. Click the **peak** that you want to identify as a new component or click the **Next** button until that peak is outlined.

   If the peak has already been identified as a component, the component information appears in the Edit Components dialog box. Otherwise, the Name text box is blank and the other parameters have default values.

3. In the Name text box, type the **new name** you want to assign to this peak.

   The name you assign appears on the plot after you complete the remaining entries for the component and click Next or Prev. To cancel a pending entry of a new component, click on another peak in the plot.
4. Do one of the following:
   - To specify for this component to serve as a reference peak for other components, select the Ref. check box.
   - To specify for an existing reference component to serve as a reference for this component, select the component from the Reference list. This option is only available if you deselect the Ref check box.

5. Do one of the following:
   - To specify for this component to serve as an internal standard for other components, select the ISTD check box.
   - To specify for an existing internal standard component to serve as an internal standard reference for this component, select the name from the ISTD list. This option is only available if you deselect the ISTD check box.

6. To change the size of the search window, type a value in the Absolute Window and Relative Window text boxes.

   The total search window is the sum of the absolute and relative windows, which the software applies to either side of the current retention time of the component.

   The relative window is a percentage of the expected retention time of the component. Changes are in increments of tenths of a second for the absolute window and tenths of a percent for the relative window.

   The search window marker (| — |) for the selected peak changes dynamically as you alter these values. The example below shows the original search window on the left, and a reduced absolute window on the right.
7. To identify the largest peak eluting within the search window as the component, select **Find Largest Peak In Window**.

   This option selects the largest peak as the designated component. If you deselect this option, the software identifies the peak closest to the expected retention time in the window as the component.

8. If you do not want to recalibrate the component, skip to step 13. If your file contains a calibration curve that you want to update, continue with step 9 to recalibrate the component.

   **NOTE:** For information on generating a calibration curve, see Section 4.5, Generating Calibration Curves and Quantitating Unknowns.

9. Select **Update Calibration**.

   The Level and Amount text boxes and the Calibration Type settings become enabled. This option only updates the calibration for the component you are currently working with. To update all components, use the **Calibrate** command in the Calibration menu.

10. In the Level field, do one of the following:

    - To select from existing calibration levels, type the **level name** or select it from the list.

    - To create a new calibration level, type the new **level name** in the Level text box.

11. In the Amount text box, type the **standard amount** of the component.
12. Under Calibration Type, select one of the following:

   - **Average**—Adds an entry to the calibration replicate list for this component in the current analysis parameters.
   - **Replace**—Deletes all calibration replicates in the current analysis parameters and replaces them with one replicate for the current data file.

   The Replace option also applies to retention time replicate information.

13. Click **Reset RT** if you are editing an existing component and want to set the expected retention time to the actual value in the current data file. For a new component, this will already be true. The software deletes any existing retention time replicate information.

   Windows in black are drawn at the retention time recorded in the method. The search window turns red for any component that references the edited component. This indicates that the expected retention time of the reference component now equals the actual value in the current data file. Thus, a red search window represents the reference peak adjustment plus the expected retention time of the component.

14. Click **Next** or **Prev** to implement the changes and move to the next or previous component in the list.

15. Repeat step 2 through step 14 for each component you want to add.

16. Select **Return** to close the Edit Components dialog box.

---

**NOTE:** Component names for peaks that are close to each other might not appear on the plot. Expand the plot to see all component names.
9.6.4 Re-Identifying Peaks

You can re-identify the peaks displayed in the Graphic Method Editor in two ways:

- By using the Re-Identify command
- By explicitly assigning a component name to a selected peak

**Re-Identify command**

When you select the Re-Identify command, the software runs the peak identification stage of data analysis and incorporates any changes you have made to the component parameters, such as search window sizes or reference peak assignments. You can then review the new peak identities by selecting each peak in turn.

**Assigning component name**

To assign or move a component name to a peak:

1. Select Edit Components from the Calibration menu.
2. In the plot window, click the peak that you want to re-identify.
3. From the Name list, select the name of the component you want to assign to this peak.
4. Make any changes to the other component options.
5. Click Next, Prev, or Return to implement the changes.

   If you try to assign a component name to a peak that is already identified as another component, an error message appears.

   If you do not want to delete the old component, you must first re-assign that component to an unidentified peak. You cannot designate a component as “unassigned.”

6. Select Return to close the Edit Components dialog box.
9.6.5 Creating and Editing Named And Timed Groups

You can identify a group of peaks as a single component for the purposes of calibration and reporting.

A *named group* consists of two or more single peak components that are grouped together in order to be reported as a single entity. Before you can assign a component to a named group, you must first identify the peak as a component. Members of a named group can appear anywhere in the chromatogram. They do not have to be located contiguously. A single peak component can be a member of more than one named group. If you wish, you may calibrate the components in a named group individually and report the results for individual components.

A *timed group* is a group of contiguous peaks whose retention times fall within a time window, which you define. The software can include a peak in a timed group even if the peak is not identified as a component.

In both named and timed groups, each peak is detected and integrated individually. The software calibrates the group independently of its members’ calibrations. The group area and height are the sum of the individual peak areas and heights.

For more information on developing a component list in the method, see Chapter 7, Adjusting Calibration Parameters.

The procedure for creating and editing these groups in the Graphic Method Editor is similar to that for single peak components.
Creating a named group

To create a named group:

1. Select **Edit Components** from the Calibration menu.

   The Edit Components dialog box appears to the right of the Graphic Method Editor and shows the options for single peak components.

2. Select **Named Group** from the Type menu.

   The dialog box changes to reflect the options for named groups (Figure 9-20).

---

Figure 9-20  Edit Components Dialog Box
If the calibration parameters have any existing named groups, the name of the first group appears in the Name text box. The Group Members list box then contains a list of all components in the method with the group members selected in the list and on the plot.

3. Click New in the Edit Components dialog box to create a new named group.

   “New Group” appears in the Name text box.

4. In the Name text box, type a name for the new group.

5. If you do not want to recalibrate the component, skip to step 12. If your file contains a calibration curve that you want to update, continue with step 6 to recalibrate the component.

   **NOTE:** For information on generating a calibration curve, see Section 4.5, Generating Calibration Curves and Quantitating Unknowns.

6. To calibrate the group using an internal standard, select a name from the ISTD list.

7. In the Group Members list box, click each component that you want to include in the group:

   As you select each component, the software highlights its associated peak in the chromatogram.

8. To calibrate the group with the current data file, select Update Calibration.

   The Level and Amount text boxes and the Calibration Type settings become enabled.

9. In the Level text box, either type the name of the calibration level represented by the data file, or select a level from the list.

10. In the Amount text box, type the sum of the standard amounts for each of the member components of the group.
11. Select Calibration Type:

- **Average**—Adds an entry to the calibration replicate list for the component in the current analysis parameters.
- **Replace**—Deletes all calibration replicates for the current component in the current analysis parameters and replaces them with one replicate for the current data file.

For a new component, Average and Replace act in the same way because there is no current calibration information.

12. Click **Next** or **Prev** to implement the change and move to the next group.

13. Repeat step 3 through step 12 for each named group you want to create.

14. When you are done creating named groups, select **Return** to close the Edit Components dialog box.

**Editing a named group**

To edit a named group:

1. Select **Edit Components** from the Calibration menu.
   
The Edit Components dialog box appears and shows the options for single peak components.

2. Select **Named Group** from the Type menu.
   
The name of the first group appears in the Name text box followed by a list of all components in the method with the group members selected in the list and on the plot.

3. In the Group Members list box, click each **component** that you want to include in or delete from the group.

4. Click **Next** or **Prev** to implement the change and move to the next group.

5. When you are done creating named groups, select **Return** to close the Edit Components dialog box.
Creating and editing a timed group

To create and edit a timed group:

1. With the Edit Components dialog box open, select **Timed Group** from the Type menu.

   The Edit Components dialog box changes to reflect the options for timed groups.

   If the analysis parameters has any existing timed groups, the name of the first timed group appears in the Name text box, and the values for other options are displayed. The search (time) window for the group appears in the plot window.

2. Click **New** to create a new timed group.

   A group window marker that spans the entire run appears in the plot window (Figure 9-21). You define the size of this window by entering the Group Start and End Times. The following example shows a new timed group window.
3. In the Name field, type a **name** for the new group component.

4. To use a time reference peak, select a **name** from the Reference list.

5. If you do not want to recalibrate the component, skip to step 13. If your file contains a calibration curve that you want to update, continue with step 6 to recalibrate the component.
6. To calibrate the group using an internal standard, select a name from the ISTD list.

7. Type or edit the **Group Start Time**.

8. Type or edit the **Group End Time**.
   The group window marker changes dynamically as you adjust the times.

9. To calibrate the component, select **Update Calibration**.
   The Level and Amount text boxes and the Calibration Type settings become enabled.

10. In the Level text box, type the name of a **calibration level**, or select a level from the list.

11. In the Amount text box, type the sum of the **standard amounts** for each of the member components of the group.

12. Select Calibration Type:
   - **Average**—Adds an entry to the calibration replicate list for the component in the current analysis parameters.
   - **Replace**—Deletes all calibration replicates for the current component in the current analysis parameters and replaces them with one replicate for the current data file.

   For a new component, Average and Replace act in the same way because there is no current calibration information.

13. Click **Next** or **Prev** to implement the change and move to the next timed group.
The name for the timed group appears beneath the chromatogram at the midpoint of the timed group window marker.

14. Repeat step 2 through step 13 for each timed group you want to create.

15. When you are done creating timed groups, select Return to close the dialog box.

9.6.6 Displaying Search Windows

To identify a peak as the correct component in a run, you define a search window, which is a time tolerance before and after the expected retention time for the component. This enables the software to identify components despite small variations in retention time from run to run.

The Show Windows command in the Calibration menu displays the search window for each single peak component that is defined in the analysis parameters (Figure 9-22). This allows you to check for any component identification problems caused by incorrect search windows. The Show Windows command is a toggle so you select the command again to hide the search windows.
To hide all search windows for single peak components:

Deselect the **Show Windows** command from the Calibration menu.

The software hides all search windows from the working chromatogram.

Because timed groups do not use search windows, the Show Windows command does not display the window for timed groups. Instead, timed groups have a group marker based on time that defines which peaks are part of the group. You can view timed group windows by entering starting and ending times in the Edit Component dialog box, as described in “Creating and Editing Named And Timed Groups” on page 9-50.
For more information on how the software uses search windows to identify peaks, see Chapter 7, Adjusting Calibration Parameters.
9.6.7 Updating Calibration Information

The Calibrate command in the Calibration menu lets you use the results from the current data file to update the calibration information for a specified level in the current analysis parameters. This applies to every component in the method. To update calibration for individual components, use the Update Calibration check box in the Edit Components dialog box.

To update calibration information:
1. Select **Calibrate** from the Calibration menu to display the Calibrate dialog box (Figure 9-23).

![Figure 9-23 Calibrate Dialog Box](image)

2. In the Calibration Level list, select the appropriate **calibration level** for the current data file from the list of levels defined in the current analysis parameters.

3. Select Mode:
   - **Average**—Adds a new replicate to the existing replicate list at the specified level for each component in the current analysis parameters.
   - **Replace**—Deletes all replicates in the current method file at the specified level and replaces them with one replicate for the current data file.

4. Click **OK**.
9.7 Displaying and Printing Information

The Report Header and Peak Report commands in the Display menu let you view the contents of each report on screen as well as print a copy of the information.

These commands display the report in a format different than when it is printed. The Peak Report command displays the information for each peak detected in the run, including component identification and quantitation, but it does not include group information. Peak Report lets you quickly review the results for any peak by clicking on that peak in the plot. The Peak Report list then scrolls to highlight the data for that peak.

To open the Report Information window:

Select **Peak Report** or **Report Header** from the Display menu.

The Report Information window replaces the reference chromatogram and displays either the peak report or header for the current run, in the format defined by the currently specified report format file (Figure 9-24).
Figure 9-24 Report Information Window

The menu bar also changes to include the following menu and commands:

- **Report menu**—Lets you alternate between viewing report contents and header information; select another report format; and, print full reports and replots.

- **Return command**—Closes the report information window and restores the main application window.
To view report header information:


   The report header appears in a scrollable window. You can scroll through the window to view additional information in the header.

2. To switch to the Peak Report list from this view, select **Peak Report** from the Report menu.

3. Select **Return** to close the report information window.

To view the report information for detected peaks:

1. Select **Peak Report** from the Report menu.

   The report information window shows the results for all detected peaks. The data columns in the window are those defined in the report format associated with the data file (or selected using the New Report Format command).

   The example above shows the default report format. For further information on report data and formats, see Chapter 8, Adjusting Report Format Parameters.

2. Click on the peak for which you want to review information.

   The software highlights the report line for that peak in the report information window.
9.7.1 Printing a Report or Replot

You can print a report or replot from either the Graphic Method Editor or from the Report Information window. You can select to print the report and replot that would be printed at the end of a run, or you can print the plot as currently displayed.

To print a copy of the current report or replot:

1. Do one of the following:
   - In the Graphic Method Editor, select Print Report from the File menu.
   - In the Report Information window, select Print Report from the Report menu.

The Print Options dialog box appears (Figure 9-25).

![Print Options Dialog Box](image)
2. Do one or more of the following:
   - To print the report, select **Report**.
   - To print the complete plot that is defined by the replot parameters in the method, select **Annotated Replot**.
   - To print a copy of the current plot as it is scaled on the screen, select **Current View**.

3. If you are printing the current view, select Portrait or Landscape.
   - **Portrait**—Orients the image on the page so that the time axis is parallel to the width of the page.
   - **Landscape**—Orients the image on the page so that the time axis is parallel to the length of the page.

4. Click **OK**.

5. Make any changes to the option in the second Print dialog box and click **OK**.
9.7.2 Printing Method Information

The Print Method command in the File menu offers the same printing options as the Text Method Editor. You can print the processing and calibration parameters.

To print a copy of the parameters in the method:

1. Select **Print Method** from the File menu to display the Print Options dialog box (Figure 9-26).

![Print Options Dialog Box](image)

2. Select the **parameters** that you want to print and click **OK**. The Print dialog box appears.

3. Make any changes to the options and click **OK**.

**NOTE:** The “Instrument Parameters” and “Audit Trail” features are not supported in this version of software.
9.7.3 Copying Information to the Clipboard

The Copy to Clipboard command in the File menu lets you use a copy of the chromatogram image in another Windows application.

To copy the current chromatogram to the Clipboard:

Select either Copy To Clipboard/Color or Copy To Clipboard/B/W from the File menu.

The software captures the screen image of the working chromatogram and copies it to the Windows Clipboard. The image is either a color or monochrome bitmap.

You can now copy the screen image from the Clipboard into another program or a file.

NOTE: A color bitmap requires many times more memory than a monochrome bitmap.
Performing a Fit Analysis

This chapter includes the following sections:

10.1 What is Fit Analysis? ......................... 10-2
10.2 The Fit Analysis Window ...................... 10-3
10.3 Viewing the Calibration Curve ............... 10-9
10.4 Changing the Calibration Curve Display 10-11
10.5 Changing Fit Parameters .................... 10-14
10.6 Solving For New Amounts and
    Responses ..................................... 10-20
10.7 Using the Data List Spreadsheet ............ 10-22
10.8 Printing and Plotting Calibration Data .... 10-27
10.9 Saving Calibration Data to the Clipboard 10-28
10.1 What is Fit Analysis?

Fit Analysis allows you to plot the calibration curve for any component that has amount and response data in the analysis section of a method file or data file. It lets you vary the data and the curve parameters to see the effects on the fitted curve.

Although Fit Analysis is intended primarily for viewing calibration curves, you can enter data points directly to view regression curves for any type of data.

If you are not familiar with how the software performs calibrations, see Chapter 7, Adjusting Calibration Parameters.

This chapter explains how to use the Fit Analysis function to plot calibration curves for components identified in the calibration section of the analysis parameters.

*NOTE:* Changes made to calibration information using the Fit Analysis function have no effect on the calibration data stored in the calibration section of the analysis parameters.
10.2 The Fit Analysis Window

Fit Analysis runs in its own window and includes a separate set of menus and commands. Fit Analysis also has a spreadsheet function that enables you to examine data. You will learn how to use each of these commands in the sections that follow.

You access the Fit Analysis program from the Text Method Editor.

To open the Fit Analysis program:

**Accessing the Text Method Editor**

1. Access the Text Method Editor by doing one of the following in your BioCAD, VISION, or INTEGRAL software:

   - Display the Method Editor by selecting **Method Editor** from the Windows menu. Open a method file (.MET). Select **Adjust Analysis Parameters** from the File menu.

   - Display the Group Analysis window by selecting **Group Analysis** from the Windows menu. Open a data file (.B*) or group file (.GRO). Select **Adjust Analysis Parameters** from the Individual or Group section from the Analysis menu.

**NOTE:** If the Adjust Analysis Params command does not appear in the Individual section of the Analysis menu, select **Tiled Mode** from the Display menu.
The Adjust dialog box appears (Figure 10-1).

![Figure 10-1 Adjust Dialog Box](image)

2. Select a data channel for which you want to perform Fit Analysis.

3. Click OK to display the Text Method Editor, Method Summary, and Component window (Figure 10-2).

The file (.MET, .B*, or .GRO) you selected in step 1 appears in the title bar, augmented with the selected data channel and an .MTH extension.
The Method Summary displays information about the instrument settings associated with the file that is currently active.

**NOTE:** To view the Method Summary or Component List window, select **Method Summary** or **Component List** from the Window menu. You can control these windows by clicking to minimize, clicking to resize, or clicking to maximize.
4. Select **Fit Analysis (CalPlot)** from the Other menu.

**NOTE:** If you made changes to the analysis parameters in the Text Method Editor before selecting Fit Analysis, the Save As dialog box appears. You can save the changes to the current analysis parameters (.MTH).

The Fit Analysis window opens along with the Component List (Figure 10-3) for the method you selected.

![Component List Dialog Box](image)

**Figure 10-3 Component List Dialog Box**

**NOTE:** If the file you opened in step 1 has no components entered in the calibration parameters, an error message appears. Click **OK** and select **Exit** from the File menu to return to the Text Method Editor. Enter components as described in Chapter 7, Adjusting Calibration Parameters, then repeat step 4.

5. Select a **component** in the Component List dialog box and click **OK**.
The Fit Analysis window (Figure 10-4). If there is insufficient calibration information to construct a curve, an error message appears.

Figure 10-4  Fit Analysis Window
You can change components in two ways:

- Select **Component List** from the Data menu to display the Component List dialog box. Select the component whose calibration curve and data you want to display and click **OK**. Note that you can scroll quickly through the component list by typing the first letter of the desired component.

**OR**

- Step through all of the method calibration curves one at a time by pressing **PgDn** (Next Component from the Data Menu) or **PgUp** (Previous Component from the Data menu).

### Fit Analysis status bar and menus

The Fit Analysis status bar at the bottom of the window shows (starting from the left) the current component, which component number this represents in the analysis parameters, and curve information. The Fit Analysis window has the following menus:

**File menu**

Lets you print the calibration curve and calibration information, change the printer or plotter and printing options, copy the calibration curve to the Clipboard, and close the Fit Analysis window.

**Data menu**

Lets you select the calibration data you want to plot from a list of components and display each component's calibration curve in turn. The Data List command, which opens a spreadsheet window, lets you change the calibration information by editing the data points in the curve (plot). See Section 10.7, Using the Data List Spreadsheet.

**Display menu**

Lets you define the limits for horizontal and vertical plot-scaling manually or automatically and customize plot labels.

**Fit Type menu**

Lets you change X-axis scaling, curve type, and regression weighting; set the plot origin; and, display information about the calibration curve.

**Solve menu**

Calculates the response for a given amount or the amount for a given response.
10.3 Viewing the Calibration Curve

The calibration curve that appears in the Fit Analysis window for each component represents the response produced by each replicate for a component at each calibration level plotted against the replicate amount. In other words, each point on a calibration curve has an amount and response coordinate that corresponds to a different calibration replicate. Likewise, the calibration replicate corresponds to a specific component amount used in a standard sample.

During calibration, the software stores data (peak areas and heights) from the standard run in the calibration section of the method file. Once the program determines what the component’s response is for each replicate, these response values (and amounts) are used to compute the calibration curve. This lets the program quantify unknown component amounts.

The amount is the X-coordinate and the response is the Y-coordinate. The more calibration replicates a component has, the more points will be plotted and used in fitting a calibration curve. You can remove or modify one or more of these points using the Data List command to see the effect on the curve.

Throughout this chapter, the term amount refers primarily to quantity values, which are plotted against response values in calibration curves. However, the way in which these amount values are derived depends on the specific analysis parameters (.MTH) being used. If the analysis parameters use an external standard, the amount value plotted in the calibration curve represents the level amount multiplied by the sample volume. For any given level, the amount value will be either the global sample volume (if no replicates exist), or the sample volume from each replicate. The calibration curve displayed in the Fit Analysis window and the data list spreadsheet use the label “Volume Adjusted Amount” for the amount value.
If the method uses an internal standard, the amount value plotted is the *ratio* of the component level amount, divided by the internal standard amount from the method or from replicates. The value for sample volume, in this case, cancels out.

Likewise, the *response value* plotted in the calibration curve is the absolute response for a method using an external standard and the *response ratio* for a method using an internal standard. The response will be either area or height as determined by the method. The calibration curve displayed in the Fit Analysis window and the data list spreadsheet use the label “Area” for the response value.

For more information on calibration, see Chapter 7, Adjusting Calibration Parameters.
10.4 Changing the Calibration Curve Display

Once you display the calibration curve, you can change how the plot appears by changing the scale to which it is drawn. You can also change the labels that appear on each axis. Make these changes using the Display menu commands.

10.4.1 Setting Limits for the Calibration Curve

The Limits command lets you choose between letting the software calculate plot scale limits or entering the plot scale manually. Allowing the software to calculate limits optimizes the plot display. However, you might want to override the generated values to perform other functions such as viewing the relationship of the curve to the origin.

To manually define the scaling limits for a calibration curve:

1. Select **Limits** from the Display menu to open the Limits dialog box (Figure 10-5).

   Automatically Calculate Limits is selected. The other options are unavailable because the software calculates the scaling limits automatically.
10.4.2 Changing Calibration Curve Labels

The software automatically displays plot labels, including the title (component name), the X-axis (volume adjusted amount), and the Y-axis (area). You can change these labels using the Labels command. The labels you enter will be used for all component plots, unlike the automatically assigned labels, which use the individual component name and appropriate amount and response labels.

The Labels command is most useful when you are plotting manually entered data that is unrelated to component calibration.
To create or change the labels on a calibration curve:

1. Select **Labels** from the Display menu to open the Labels dialog box (Figure 10-6).

   ![Figure 10-6 Labels Dialog Box](image)

   The Automatically Assign Default Labels check box is selected, and the label text boxes are unavailable.

2. To change or modify the labels, deselect Automatically Assign Default Labels.

3. Type a new **title** in the Plot Title text box.

   You can create a label up to 30 characters long.

4. In the X-Axis Label text box, type the information you want to appear as the **X-axis label**.

5. In the Y-Axis Label text box, type the information you want to appear as the **Y-axis label**.

6. Click **OK**.
10.5 Changing Fit Parameters

Fit parameters determine exactly how the calibration curve is fitted to the data. The commands in the Fit Type menu let you change the scaling factor used for the X-axis, change the curve fit type and regression weighting, and set the plot origin.

10.5.1 Changing the Scaling Factor

The data the software uses to create a calibration curve depends on the type of calibration you specify in the calibration parameters: external standard or internal standard.

If you use an external standard in the method, the curve will show the relationship between amount and response values. Response may be either the peak area or the peak height, whichever you indicate in the method.

If you use an internal standard in the method, the calibration curve will show the relationship between the amount ratio and response ratio.

The software offers several alternatives to simply plotting response as a function of amount, or response ratio as a function of amount ratio. For example, you can plot response as a function of the log of the component amount.
To change the scaling factor for the X-axis:

1. Select **Change Scaling** from the Fit Type menu to open the Change Scaling dialog box (Figure 10-7).

![Change Scaling Dialog Box](image).

**Figure 10-7 Change Scaling Dialog Box**

2. Select a new **scaling factor** from the following choices:
   - **1 (no scaling)**—The default, it does not add a scaling factor.
   - **1/x**—Shows response as a function of the reciprocal of the amount.
   - **1/(x*x)**—Shows response as a function of the reciprocal of the square of the amount.
   - **log(x)**—Shows response as a function of the base-10 log of the amount.
   - **1/log(x)**—Shows response as a function of the reciprocal of the log of the amount.

**NOTE:** These scaling alternatives rule out the use of some values for amounts. For example, you cannot use 0.0 with 1/x or 1/(x*x). Also, you cannot use an amount of less than 1.0 with a logarithmic option.

3. Click **OK**.
10.5.2 Fitting and Weighting the Calibration Curve

To compute a calibration curve, the software performs a regression calculation using all replicates for the component at all available calibration levels. The software performs this regression analysis by computing a set of orthogonal polynomials and using them to compute the best least-squares approximation. For a mathematical description of how the software performs this analysis, see Appendix A, Discussion of Data Analysis.

You can change the way the software fits the calibration curve to the data points by selecting a new fit type. You can also weight the calibration curve by selecting one of several weighting options when you create the calibration section of the method. Your selection determines the type of weighting factor the software will apply to the points of the calibration curve. The larger the weighting factor is for a point (based on the selected weighting expression), the more important that point becomes in the curve-fitting calculation.

To select a different fit type for the calibration curve:
1. Select **New Fit** from the Fit Type menu to open the New Fit Parameters dialog box (Figure 10-8).

![Figure 10-8 New Fit Parameters Dialog Box](Image)
2. Select the **Curve Fit Type option** you want to use.

- **Point to Point**—Averages all replicate amount and response data at each calibration level to derive a point. (Each pair of points is connected by a straight line segment.) You can use this curve type with one or more calibration levels.

- **1st Order Polynomial**—Calculates a first-order polynomial (linear) fit using the coefficients of the curve (intercept and slope). A component must have at least two calibration levels to use this type of fit.

- **2nd Order Polynomial**—Calculates a second-order polynomial (quadratic) fit using the curve coefficients. A component must have at least three calibration levels to use this type of fit.

- **3rd Order Polynomial**—Calculates a third-order polynomial (cubic) fit using the curve coefficients. A component must have at least four calibration levels to use this type of fit.

3. Under Origin, select **Include** or **Force** if required.

   If you force the origin, the intercept term is always zero in the calculation. If you include the origin, the point (0,0) is added to the calculation but does not appear in the calibration level list.
4. Select a **Regression Weighting option**.
   - **1 (no weighting)**—This is the default setting and has no effect.
   - **1/x**—Applies the reciprocal of a point’s amount value as the weighting factor.
   - **1/(x^2)**—Applies the reciprocal of the square of a point’s amount value as the weighting factor.
   - **1/y**—Applies the reciprocal of a point’s response value as the weighting factor.
   - **1/(y^2)**—Applies the reciprocal of the square of a point’s response value as the weight factor.

5. Click Replace, Add, or Cancel.
   - **Replace**—Replaces the current calibration curve with the curve specified by the parameters in the dialog box.
   - **Add**—Adds a new curve to the display derived from the fit parameters specified in the dialog box. You can view up to four curves at the same time.
   - **Cancel**—Closes the dialog box without saving the changes.
10.5.3 Displaying Curve Information

The Curve Info command in the Fit Type menu displays the type of curve fit, the weighting factor used, the origin option in effect, and the calculated coefficients for the polynomial curve (if applicable).

To display information on the current calibration curve:

1. Select Curve Info from the Fit Type menu to open the Curve Information dialog box (Figure 10-9).

![Figure 10-9 Curve Information Dialog Box]

2. If the Next button is enabled, click on it to display information on the next calibration curve for that component (if any).

3. Click Close when you have finished viewing calibration curve information.
10.6 Solving For New Amounts and Responses

Solving for new amount and response values allows you to calculate an expected response from an amount value or the amount corresponding to an observed response from a sample.

Calculating an amount value

To calculate an amount value:

1. Select For Amount from the Solve menu to open the Solve For Amount dialog box (Figure 10-10).

![Figure 10-10 Solve For Amount Dialog Box](image)

2. In the Enter A Response text box, type a **new value** for which you want to solve an amount.

3. Click Calculate.

   The amount value appears following the Amount = label and marker lines appear on the plot. You can change the response value and recalculate the result.

4. Click Close.
Calculating a response value

To calculate a response value:

1. Select **For Response** from the Solve menu to open the Solve For Response dialog box (Figure 10-11).

2. In the Enter An Amount text box, type a **new value** for which you want to solve a response.

3. Click **Calculate**.

   The response value is displayed following the Response = label, and marker lines appear on the plot. You can change the amount value and recalculate the result.

4. Click **Close**.
10.7 Using the Data List Spreadsheet

The Data List command in the Fit Analysis window opens a spreadsheet window that lists the data from which the plot is derived. By manipulating information in the Data List spreadsheet, you can test various scenarios without disturbing the calibration settings in the method file. For example, you can delete a data point to see how it affects the curve fit.

To open the Data List spreadsheet:

Select **Data List** from the Data menu.

The Data List dialog box (Figure 10-12) opens and shows the Amount (Vol Adj Amt) and Response (Area) values that created the calibration curve together with the associated level names.

![Data List Dialog Box](image)

*Figure 10-12 Data List Dialog Box*
The Data List dialog box contains the following elements:

- **Edit menu**—Lets you insert, append, copy, move, and delete rows and insert a repeating value in a column.

- **Column labels**—Indicates the type of data that appear in the cells for that column.

- **Row numbers**—Identifies spreadsheet rows. These cannot be changed.

- **Work area**—Shows the area in which you can enter information. The Data List spreadsheet includes three working columns:
  
  - **Amount Ratio (Vol Adj Amt)**—The X-axis value of the data point.
  
  - **Response Ratio (Level Name)**—The Y-axis value of the data point.
  
  - **Level Name**—The name of a calibration level (if any).
10.7.1 Editing Calibration Data in the Data List Dialog Box

To edit calibration data using the spreadsheet:

1. If the Data List dialog box is not already open, select **Data List** from the Data menu in the Fit Analysis window.
2. Select the **cell** whose information you want to revise.
3. Click the mouse inside the cell you want to edit.
4. Type the **new value** (or calibration level).
5. Press **Enter**.

10.7.2 Inserting a Row in the Spreadsheet

To insert new rows into the Data List spreadsheet:

1. Click in a row before which you want to insert the new row.
2. Select **Insert Row** from the Options menu.

When there is only one row in a spreadsheet, this step is unnecessary. The software copies all the data in the selected row to the new row directly beneath it.

10.7.3 Appending a Row to the Spreadsheet

To add a row to the end of the spreadsheet:

Select **Append Row** from the Options menu.

The software appends a new row to the bottom of the spreadsheet. The new row will contain the same data as the row above it.
10.7.4 Copying Rows in a Spreadsheet

The Copy command in the Edit menu creates extra points (duplicates) in the spreadsheet.

To copy a spreadsheet row:
1. Click on the row number (left-most column) of the row or rows you wish to copy.
2. Select Copy Rows from the Options menu.
3. Click anywhere in a row above which you want to paste the copied rows.
4. Select Paste Rows from the Options menu.

10.7.5 Deleting Rows from a Spreadsheet

To delete a spreadsheet row:
1. Click on the row number (left-most column) of the row or rows you wish to delete.
2. Select Delete from the Edit menu.
10.7.6 Entering Repeating Values

The Fill Down command provides a quick way to fill a column, from a designated cell downward, with the same value. You may perform this operation for any column in the spreadsheet, but you must begin by selecting an individual cell.

To insert a repeating value in an entire column:
1. Select a cell whose value you want to copy to all cells below it in the current column.

   **NOTE:** You cannot copy to empty cells. If there are empty cells that you want to copy values to, use the Append command.

2. If necessary, modify the information.
3. Select **Fill Down** from the Options menu.

   The information from the selected cell now appears in every cell in the column, from that row down to the bottom of the spreadsheet. The rows above the selected cell are not affected.

10.7.7 Closing the Data List Dialog Box

When you close the Data List dialog, the software recalculates the plot information based on the changes you have made.
10.8 Printing and Plotting Calibration Data

The following print commands are available under the File menu in the Fit Analysis window:

- **Print**—Allows you to print a copy of the calibration curve as well as a summary of calibration information for each component in the selected method file.

- **Print Preview**—Shows an on-screen version of how your calibration data will look when printed.

To print the calibration plot displayed in the Fit Analysis window and/or a summary of calibration information:

1. In the Fit Analysis window, select **Print** from the File menu.

   The Print dialog box appears (Figure 10-13). The default setting is to print the Calibration Data and the Calibration Plot.

2. Deselect Calibration Data or Calibration Plot to exclude either one.

3. Click **OK** to open the Print Setup dialog box.

4. Click **OK** to print the selected data for the current component.

![Figure 10-13 Print Dialog Box](image)
10.9 Saving Calibration Data to the Clipboard

This feature is not supported in this version of software.
Discussion of Data Analysis

This appendix contains the following sections:

A.1 What is Data Analysis? ......................... A-2
A.2 Overview of the Steps in Data Analysis .............. A-3
A.3 Peak Detection .................................... A-5
A.4 Integration ........................................ A-28
A.5 Component Identification .......................... A-59
A.6 Calibration ......................................... A-61
A.7 Quantitation ...................................... A-76
A.1 What is Data Analysis?

Data analysis is the process by which the software interprets the data obtained from an instrument and stored in a raw data file. The outcome of this interpretation is stored in the result section (.RST) of a data file.

The software analyzes data when you re-analyze an individual data file using the Graphic Method Editor. For more information, see Section 4.4, Interactive Viewing and Analyzing.

**Analyzing single data files**

The software analyzes data from a single data file when you:

- Select the **Analyze and Print** command in the Control Panel. For more information, see Section 4.3.3, Analyzing and Printing in the Control Panel.

- Select the **Analyze and Print After Run** command in the Method Editor. For more information, see Section 4.3.1, Specifying Automatic Analyzing and Printing in the Method Editor.

**Analyzing a group of data files**

The software analyzes data from a group of data files when you select **Analyze Individual** or **Analyze Group** in the Group Analysis window. For more information, see Section 4.3.2, Analyzing Data Files in Group Analysis.
A.2 Overview of the Steps in Data Analysis

There are nine distinct steps in the data analysis process. Some of the steps in data analysis are optional — their occurrence depends on the information you provide in the method. For example, you can omit from the method instructions for adding component names to peaks, generating a report and plot, and running a user program during analysis.

Also, the calibration step is relevant only when the software analyzes the data from a standard sample.

The following is a brief description of each step of data analysis. More detailed information about each step (except report generation, replot generation, and post-analysis programs) is given later in this chapter.

- **Peak Detection**—Scans the data points in a raw data file (or modified raw data file) to find peaks. This step modifies the results section of the data file so that it contains a peak list that consists solely of peak starting and ending points. To edit peak detection parameters, see Chapter 6, Adjusting Processing Parameters.

- **Integration**—Groups peaks into clusters, assigning baselines and summing the areas under the peaks. This step adds to the results section final values for peak starting and ending points, retention times, areas and heights. To edit peak integration parameters, see Chapter 6, Adjusting Processing Parameters.

- **Component Identification (optional)**—Determines the peak identities in the results section by comparing their retention times with a pre-defined list of expected components and retention times specified in the calibration section of the file. This step adds component names to peaks in the result file. See Chapter 7, Adjusting Calibration Parameters.
Appendix A  Discussion of Data Analysis

- **Calibration**—Updates amount and response values for components during the analysis of calibration standards. The software stores calibration data, including the results of the analysis of standard samples, in the calibration section of a file. The calibration step in data analysis also produces a report containing the current calibration data for each component. See Chapter 7, Adjusting Calibration Parameters.

- **Quantitation**—Calculates the amounts of components represented by peaks in the results section. These calculations are based on the peak areas or heights and on the calibration data for the corresponding components. This step adds component amounts to the results section.

- **Report Generation (optional)**—Produces one or more reports containing the results of the analysis. You can specify additional reports in the processing section of the method. See Chapter 6, Adjusting Processing Parameters, and Chapter 8, Adjusting Report Format Parameters.

- **Replot Generation (optional)**—Produces a fully annotated plot of the chromatographic data. The annotations can include peak retention times, peak starting and ending points, and component names. For more information, see Chapter 6, Adjusting Processing Parameters, and Chapter 8, Adjusting Report Format Parameters.

- **Post-Analysis Programs (optional)**—Includes any user programs that the software runs after data analysis. You designate which programs you want to run, and when, in the processing section of the method. For more information, see Chapter 6, Adjusting Processing Parameters.
A.3 Peak Detection

During the peak detection step in data analysis, the software scans the data points in a raw data file (or modified raw data file) to find peaks.

The software saves the point data and point index data it collects in the results section of the data file. A point index is a number indicating the position of a data point in the series of data points within the raw data file.

The following sections describe peak detection in detail.

A.3.1 Peak Detection Parameters

The peak detection parameters include bunching factor, noise threshold, and area threshold.

**Bunching factor**

The bunching factor specifies how many sequential data points in a raw data file are grouped in a *bunch*. During peak detection, the software counts bunches and then averages the voltage values of the points in each bunch. The resulting averages are assigned to bunched points.

The following diagram shows how bunching smooths out raw data, which helps prevent the software from identifying baseline noise as peaks. Small dots represent the raw data, and squares represent bunched points. In the following figure, one bunched point is shown for every five raw points; thus, the bunching factor is 5. Each bunched point is located at the same time position as the last raw point in a bunch.
A bunching factor also compensates for over-sampling: that is, collecting more points than are necessary in a peak. Ideally, peaks will have about 20 points from start to end. This provides the best balance between acceptable processing time and correct peak detection and integration.

If the sampling rate remains constant throughout a run, you might not be able to avoid over-sampling because peak widths can vary, perhaps broadening later in the run. The broader a peak, the more points it is likely to have; thus, it can be over-sampled.

In this situation, where both narrow and broad peaks occur in the same run, you cannot lower the sampling rate. However, you can increase the bunching factor one or more times by using a timed event. You specify the event (increasing the bunching factor) and the time in the run when the event will take place.

Setting the bunching factor too high can lead to small, unresolved peaks being smoothed out completely, so they are undetected. The goal in setting a bunching factor by timed event is to maintain the number of points within the peaks reasonably close to the 20-point optimum.

Too few bunched data points (□) can smooth small peaks, making them invisible to peak detection.
Because bunched points are positioned at the time of the latest point in the bunch, a peak plotted from bunched data tends to shift to the right (see the previous figure). This shift has no adverse effect on peak detection and integration because the bunched data are used only to identify the potential start, top, and end of a peak. After finding the potential peak values, the software reverts back to the raw data points to pinpoint the actual peak start, top, and end. Therefore, there is no loss of resolution in calculating baseline positioning or peak integration.

*Noise threshold*

Expressed in units of microvolts, the noise threshold (NT) is the parameter that enables the software to discriminate between baseline noise and peaks. If the vertical difference between two consecutive bunched data points is greater than the noise threshold, the software recognizes the potential start of a peak. For example, in the following figure, point 4 would be detected as a potential peak start because the distance (b) between points 4 and 5 exceeds the noise threshold. Point 2 would not be detected as a peak start because distance (a) is too small.

The lower the noise threshold, the more sensitive peak detection will be. Conversely, raising the noise threshold decreases sensitivity. If the threshold is too high, however, the software will not be able to detect wanted peaks.

The following figure shows how increasing the noise threshold affects peak detection. The lower the noise threshold, the earlier the peak start is detected, and the later the peak end. The data values at the end taper off to a point that is below the noise threshold.
A higher noise threshold requires a more abrupt rise between data values before a peak start can be detected. By the same token, the peak end is found sooner as differences between consecutive data values quickly reach the threshold.

When the noise threshold is higher, peaks start and end more abruptly.

**Area threshold**

Area threshold is used to discriminate between noise spikes and peaks. Expressed in microvolts, this parameter is used after the noise threshold to confirm the potential start of peaks that pass the noise threshold test.

After passing the noise threshold test, pairs of bunched data points must continue to exceed the noise threshold, and the cumulative sum of the bunched data points on the leading edge must eventually exceed the area threshold for the peak to be confirmed.

For example, the following figure shows a noise spike whose first two points pass the noise threshold test, but subsequent pairs of consecutive bunched points fail the area threshold test. Consequently, the spike does not sustain a leading edge that accumulates enough area under it to exceed the area threshold. The spike is not detected as a peak.
The following figure illustrates a peak that passes the area threshold test. The sum of the bunched area slices on the leading edge exceeds the area threshold, so the peak is detected. There is no direct relationship between area threshold and the smallest peak that can appear on a report. To exclude all peaks smaller than 100 µV-sec, use the Area Reject setting in the Report Format Options dialog box.

\[ \sum A_i < \text{Area threshold} \]

\[ \text{Sum of area slices} > \text{area threshold} \]

*A peak is confirmed when it passes the area threshold test.*
Higher area threshold values make it harder to confirm a peak, and the software might not detect smaller peaks at all, especially those that appear as shoulders on the leading or trailing edges of larger peaks.

A good policy when starting out is to use a low noise threshold and a high area threshold. This maintains a high degree of sensitivity in detecting peak starting and ending points, but still screens out noise spikes. You can visually optimize noise and area threshold settings/values for your data in the Graphic Method Editor. See Chapter 9, Adjusting Analysis Parameters Graphically.

In addition to confirming a peak start, area threshold also helps determine a peak top. See Section A.3.2, The Stages in Peak Detection.

### A.3.2 The Stages in Peak Detection

In order to use timed events and peak detection and integration parameters correctly, you must be familiar with the stages in the peak detection process. A simplified discussion of each stage in peak detection follows.

**Finding the potential peak start**

To find the potential start of a peak, the software examines the difference in value between each bunched data point and the preceding one. If the difference exceeds the current noise threshold value, then a potential peak start point has been found.

**Confirming the peak start**

After a potential peak start is found, the software begins to sum the differences between each bunched point and the last baseline point. Because each bunched point represents an area slice, the sum is the accumulated area for the potential peak, as shown in the figure that follows. The differences between bunched points must also continue to exceed the noise threshold, or the peak start will be canceled.
A peak is confirmed when it passes the area threshold test.

If the accumulated area exceeds the area threshold before a bunched point fails the noise threshold test, then the peak is confirmed.

After a peak is confirmed, the peak detection software scans backward from the potential peak start looking for the lowest raw data point. It scans backward through five bunches of raw data to find this minimum, but will stop the search if it reaches the end of the preceding peak. The lowest raw data point found in this process becomes the actual peak start.

The following figure shows how the software finds the actual start point. In this example, the bunching factor is set to 2, so there are only two raw data points for each bunched point. Therefore, the bunched points do not rise much faster than the raw data. The potential peak start was found at a point well up the side of the peak because previous consecutive pairs of bunched points failed the noise threshold test. It is evident in this figure that, without the backward search, a high noise threshold would drastically alter the peak start value. The same principle applies to peak end values.
Finding the peak top

To find the top of the peak, the software first tries to identify a local maximum bunched point value. When a bunched point is lower than the previous one, the previous point is considered to be the potential peak top. To avoid finding a false peak top because of noise, the software performs a confirmation test by summing the differences between the potential top and subsequent bunched points. If the sum exceeds two-thirds of the area threshold value, the potential peak top is confirmed. However, if a higher bunched point is found before the area test is passed, a new potential top is identified and the area test is restarted.
If the shaded area exceeds two-third of the area threshold, the maximum point becomes the peak top.

Note that the reported retention time for a peak is not simply the time of the point identified as the peak top. The reported retention time is determined from a quadratic fit based on the five highest data points.

Because of this top-of-peak test, the choice of an area threshold value affects both peak confirmation and how shoulders are detected on the leading edge of a larger peak. Shoulders on the leading edge of a larger peak are not detected as peaks unless they have a discernible maximum point and a crest area that is greater than two-thirds of the area threshold.
Appendix A  Discussion of Data Analysis

The shoulder in the first figure could be detected as a peak if the area threshold were lower. However, the shoulder in the second figure could not be detected automatically regardless of the peak detection parameter values that are used because it lacks a maximum. To separate this shoulder as a distinct peak, you must use the timed event S (split peak).

Finding the peak end

There are two indicators of a peak end:

- Two consecutive bunched point differences are less than the noise threshold, or
- The start of another peak is detected

In either case, the lowest bunched point from the last five bunches is considered to be the actual end point of the peak.
Peak Detection

Peak separation criteria

Width Ratio and Valley-To-Peak Ratio are two peak separation criteria that are considered overlapped or separated. This determination will affect how the baseline is drawn beneath the peaks. In peak detection, a peak is defined as overlapped with its neighbor on the right if the pair meet two criteria: the valley-to-peak ratio is greater than 0.01, and the separation is less than 0.2w, where w is the width of the first peak in the pair. (You can change these values in the software as described in Section 9.5.4, Changing Peak Separation and Exponential Skim Criteria.) Peaks defined as overlapped are assigned an overlap flag of 1; those not defined as overlapped receive an overlap flag of 0. A set of overlapped peaks is called a cluster and, by default, shares a common baseline. Peaks that are separated each have an individual segment of the baseline.

The Width Ratio is the ratio of the distance(s) between the end of the first peak and the start of the second peak to the width of the second peak at its base (w). If this ratio is greater than the set value, the peaks are considered to be separated. Otherwise, they are marked as overlapped.

Criteria for overlapping peaks

The Valley-to-Peak Ratio is the ratio of the height of the valley between peaks (v) to the height of the smaller peak (p). If this ratio is less than or equal to the set value, the peaks are considered to be separated.
A.3.3 How Timed Events Affect Peak Detection

The following is a description of how each timed event, or pair of timed events, affects the way the software detects peaks.

A.3.3.1 The Bunching Factor, Noise Threshold, and Area Threshold Events

Using the bunching factor (BF), noise threshold (NT), and area threshold (AT) timed events allows you to override previously set values. These events take effect at the time they are scheduled: they do not work retroactively. For example, in the first figure that follows, the current area threshold is low, which enables the software to confirm the peak before the AT event occurs. The new area threshold value does not affect the confirmation of the peak.

In the second figure, the AT event is scheduled during peak confirmation, so the software uses the new, larger area threshold to determine where the peak actually starts.
For best results, schedule the BF, NT, or AT timed events on the baseline as far away from peaks as possible. If you schedule these events at times too close to a transition from one peak detection stage to another, detection might differ significantly from chromatogram to chromatogram because of small shifts in retention time or random noise. For example, in the previous figure, a slight shift by the peak to an earlier retention time would move the AT timed event past the Confirm stage.

### A.3.3.2 Bunching Factor Event

The BF event helps compensate for changes in peak width over the course of a run. For example, in some applications, peaks tend to broaden as the run progresses. In these cases, scheduling this event at a higher value at least once can help maintain the ideal 20 bunched points per peak.

### A.3.3.3 Noise Threshold Event

The NT event helps compensate for changes in baseline noise. You can increase the noise threshold to decrease peak detection sensitivity or decrease the noise threshold to increase sensitivity. For example, suppose the beginning of a chromatogram is noisy because of fast-eluting contaminants in the solvent, and this noise diminishes later in the run. To optimize peak detection, you would set the default noise threshold high enough to screen out the initial noise and schedule the NT event to decrease the noise threshold at the time when the noise diminishes.
A.3.3.4 Area Threshold Event

In addition to the NT event, the AT event also affects peak detection sensitivity. If you are scheduling an NT event to change the noise threshold, schedule an AT event at the same time to change the area threshold. For example, if you are lowering the noise threshold to gain sensitivity, lower the area threshold as well. Otherwise, the software might not confirm the smaller potential peaks that the lower noise threshold allows it to detect. A general guideline is to set the area threshold to five times the value of the noise threshold.

A.3.3.5 Disable/Enable Peak Detection (−P/+P)

The pair of timed events −P and +P turn peak detection off and on, respectively, allowing you to disable and re-enable peak detection during a run. For example, if valve switching causes noise spikes in the middle of a chromatogram, you can schedule a −P event before the affected region and a +P event after it to avoid the detection of false peaks.

If the software is at the point where it is searching for a peak ending point (for example, after the peak crest) when the −P event occurs, the peak will end at exactly that point and all peak detection will stop. If the software is at any other point in peak detection, the process will stop and the current peak will not be detected.

The +P event has no effect unless peak detection has been disabled by a −P event. Likewise, a −P event has no effect if peak detection is currently disabled. The following figures show the effect of the −P and +P timed events.
Without −P and +P timed events, insignificant peaks are detected.

With −P and +P timed events, peak detection is disabled in this region.
A.3.3.6 Enable/Disable Negative Peak Detection (+N/–N)

The pair of timed events +N and –N turn negative peak detection on and off, respectively. They allow you to enable and disable the detection of negative peaks during a run. By default, the software detects only positive signals, so you must add a +N event to have it detect negative peaks. This event does not affect the detection of positive peaks.

The software detects a potential negative peak if a bunched data point value decreases from the previous bunched point value by more than the noise threshold, and if both points lie below the “theoretical” baseline used to separate positive and negative peaks. It also applies the area threshold to negative peaks.

The –N event takes effect immediately if peak detection is in the Begin or Confirm stages. Otherwise, it is delayed until the end of the current peak is found.

If you schedule a +N event to occur when negative peak detection is already enabled, the event has no effect. Likewise, nothing happens if you schedule a –N event to occur when negative peak detection is disabled.

The following figures show the effect of the +N and –N timed events.
Without the +N and –N events, the negative peak is not detected, and a false positive peak is found.

With the +N and –N events, the negative peak is detected, and then negative peak detection is disabled.
To detect a negative peak that follows immediately after a positive peak, the software must determine the baseline point at which the positive peak ends and the negative peak begins. The same is true for detecting a positive peak that follows a negative peak.

This theoretical baseline is set at the voltage level of the bunched point within whose data range the +N event occurs. The theoretical baseline is not likely to coincide with actual raw data point values when it intersects peaks on the chromatogram, so the software uses the closest actual data. Positive peaks are forced to start and end on raw data points above this baseline, and negative peaks are forced to start and end on raw data points below this baseline. As a result, the areas between the theoretical baseline and peak baselines are excluded from the peak areas. The following figure, deliberately exaggerated for clarity, illustrates this.

This is how the software finds the dividing line between a positive and a negative peak.
A.3.3.7 Inhibit/Allow End-of-Peak Detection (+I/–I)

The pair of timed events +I and –I inhibit and allow the stage in peak detection when the peak end is detected. When +I is in effect, the software does not attempt to determine the ending point of a peak. The –I event re-establishes peak detection for ending points.

It is appropriate to use these events when closely related components of a compound elute as shoulders on the trailing side of the main peak, and you want all of the components to be treated as part of the main peak. In this case, you can schedule the +I event to prevent the software from finding the end of the main peak, and schedule the –I event to allow peak end detection again after the last component. The following figures show the effect of using +I and –I events.

Without the +I and –I events, the peak at 31.58 minutes ends naturally, but the shoulder on its trailing edge goes undetected.
With the +I and –I events, the shoulder is included in the peak.

The +I event forces the software to remain in the Find End stage. The result is that it will neither find a peak end nor detect the start of the next peak until the event is switched off. All data from the time of a +I event to the time of a –I event is perceived as part of the same peak.

The +I event takes effect immediately, but has no impact on processing until peak detection naturally enters the Find End stage. The –I event takes effect immediately, and allows the software to find the first peak end it encounters, based on the current noise threshold.

**A.3.3.8 Locate Maximum Event**

The LM event locates the peak retention time at the maximum data point that falls within the peak rather than attempting to fit a quadratic to the peak crest.
### A.3.3.9 Retention Time and User Forced Peak Events

The RT event forces the retention time of the current peak to be the event time. If it is used within a user forced area with daughter peaks, the optional peak number \( n \) specifies to which peak the RT event is applied.

The RT event can be used in combination with the User Forced Peak event (UFn).

The UFn event allows a baseline to be forced at any arbitrary point within a data file. The events generally occur in pairs — for example, UF1 and -UF1 start a peak at the UF1 time and end the peak at the -UF1 time. If the computer is within a peak and has found a peak crest when the UFn event occurs, an end of peak will be forced so the user peak start can occur. If the crest has not yet been found, then the potential peak will be discarded.

Daughter peaks can be forced within a user peak. For example, the timed events UF1...UF2...UF3...UF4...-UF1 would define three connected daughter peaks (#2, 3, and 4) within the mother peak (#1). In addition to the peak number, you can specify a signal level.

The following figure shows both the Retention Time and the User Forced Peak events.
A.3.3.10 Smooth Peak Ends Event

The SM event smooths the beginning and ending of all peaks that start or end on a baseline. The following figure shows a peak before the SM event is run.

This event applies a Savitsky-Golay smoothing algorithm to a group of n data points at both ends of a peak, where n can be any odd value between 5 and 25, inclusive. The algorithm adjusts the start and end data levels used for the baseline calculation to average baseline values (start and end times are not affected. The start and end point for each peak are put in the “center” of the noise band. The following figure shows the same peak after the SM event has been run.
The SM event is useful when a high noise level, regardless of the signal strength, or a poor signal-to-noise ratio makes baseline resolution a problem. It is especially useful where accurate, reproducible integration is critical.
A.4 Integration

This step of data analysis groups peaks into clusters, assigns baselines, and sums the areas under the peaks. This step adds final values to the result file for peak starting and ending points, retention times, areas, and heights. The following section describes integration.

A.4.1 Baselines Within Clusters

A peak cluster is a single resolved (non-overlapped) peak or a group of contiguous peaks that are found to be overlapped during peak detection.

Identifying peak clusters enables the software to establish preliminary baselines during peak detection according to a simple rule: All peaks in a cluster share a common baseline and resolved peaks have a unique baseline.

A.4.2 Adjustment of Preliminary Baselines

During integration, the software reviews the preliminary baselines to find sections of the chromatogram that cross the baseline. These are called penetrations. If a baseline is forced horizontally by a +HF, HR, or +M timed event, the software ignores any penetrations. In other cases, however, the software makes adjustments to eliminate baseline penetrations. See Section A.3.3, How Timed Events Affect Peak Detection.
A.4.2.1 Baseline Penetration by Chromatogram Valleys

If a cluster consists of more than one peak, the software checks the valley point between each pair of peaks to ensure that its height is above the height of the preliminary cluster baseline. The valley point is the lowest point between the two peaks as determined during peak detection.

If the valley point goes below (penetrates) the cluster baseline, the software ends the cluster at the valley point. The overlap flag for the first peak in the pair is reset to 0. A new cluster baseline is calculated, and the software continues testing for penetration. The following figure shows an example of this type of baseline adjustment.

During integration, the software corrects baseline penetration by chromatogram valleys.
A.4.2.2 Baseline Penetration at the Start or End of a Cluster

In addition to checking each valley point, the software examines all the points of each cluster for baseline penetration.

If any point penetrates the baseline, the start point of the first peak in the cluster is set to the point following the penetrator. If any of the final points penetrates the baseline, the end point of the last peak in the cluster is set to the point preceding the penetrator. A new cluster baseline is calculated, and the software continues testing for penetration. The following figure shows an example of baseline adjustment at the start of a cluster.

The software corrects baseline penetration at the start of a cluster.
A.4.3 Peak Areas

After establishing final baselines, the software determines peak areas. In performing this task, the software works with area slices. An area slice is defined as the area beginning at raw data point \( n \) and extending horizontally backward to point \( (n - 1) \). The start point of the peak does not contribute to the peak’s area.

To determine a peak’s area, the software first sums the area slices from the peak start to the peak end. Initially, these slices extend vertically from the level of point \( n \) to the zero-microvolt level.

Next, the software corrects this sum for the height of the cluster baseline by subtracting the baseline area, which is the area of the trapezoid between the cluster baseline and the zero-microvolt level. The result is the final peak area if the peak is resolved (see the following figure).

 Peak areas are determined by summing area slices and then subtracting the baseline area.
Dropline integration means that the boundaries of overlapped peaks are defined by droplines: vertical lines dropped from a peak's start and end points to the peak baseline such that they are perpendicular to the time axis (see the next figure). The outside vertical edge of the first and last area slices of a peak define the positions of the droplines.

A.4.4 Area Adjustment

For some peaks, additional processing beyond dropline integration is required to obtain a suitable peak area. The system offers two methods to adjust peak areas: exponential skimming and tangential skimming. The necessity for an exponential skim is determined automatically by the software; however, you can also impose an exponential skim by means of a timed event. A tangential skim is never implemented automatically; it can only be imposed by a timed event.
**Exponential skims**

An exponential skim is a curve drawn by using an exponential equation to approximate the trailing edge of a parent peak. The skim passes under one or more peaks that follow the parent. These are called child peaks. The area underneath the skim is subtracted from the child peaks and given to the parent peak. A small area above the skim is subtracted from the parent peak and given to the first child peak. All droplines, beginning at the end of the first child, are adjusted to drop only to the skim. The following figure illustrates an exponential skim.

An exponential skim

To change exponential skim values in the software, see Section 9.5.4, Changing Peak Separation and Exponential Skim Criteria.

**Exponential skim criteria**

Peak Height Ratio, Adjusted Height Ratio, and Valley Height Ratio are exponential skim criteria that determine whether an exponential skim line will be used to calculate the area of a child peak eluting on the trailing edge of a parent peak. The software will not use these parameters if a +X timed event (which always forces an exponential skim) or a −X timed event (which prevents an exponential skim) is in effect.
Appendix A  Discussion of Data Analysis

Peak Height Ratio is the ratio of the baseline-corrected height of the parent peak (Hm) to the baseline corrected height of the child peak (Hd). This ratio must be greater than the set value for the child peak to be skimmed. To disable exponential skimming throughout a run, you can set this parameter to its maximum value (1.0e+06).

\[ \frac{H_m}{H_d} \] must exceed the set value for peak height ratio.
Adjusted Height Ratio is the ratio of the height of the parent above its start point (Lm) to the height of the child above the same point (Ld). This ratio must be greater than the set value for the child peak to be skimmed.

$L_m$ divided by $L_d$ must exceed the set value for adjusted height ratio.
Valley Height Ratio is the ratio of the baseline corrected height of the child peak (Hd) to the height of the valley between the parent and child peaks above the baseline (Hv). This ratio must be less than the set value for the child peak to be skimmed.

\[
\frac{H_d}{H_v} \text{ must be less than the set value for valley height ratio.}
\]
Calculation of exponential skims

Following is the equation used to calculate an exponential skim:

\[ Y = H_b + H e^{-G(t-t_0)} \]

where

- \( Y \) is the height of the exponential skim at time \( t \)
- \( H \) is the height (above the cluster baseline) of the start of the exponential skim
- \( H_b \) is the height of the cluster baseline at the end of the exponential skim
- \( G \) is the decay factor of the exponential
- \( t_0 \) is the time corresponding to the start of the exponential skim

The following figure illustrates this calculation.
A.4.5 How Timed Events Affect Integration

The following is a description of how each timed event or pair of timed events affect the way the software integrates peaks.

A.4.5.1 Force/Discontinue Common Baseline (+CB/–CB)

The +CB event causes the software to assign an overlap flag of 1 to all peaks that occur while the event is in effect. As a result, during integration, the software treats all peaks as though they were clustered even if they do not meet the criteria for being overlapped. The software draws a common baseline for these peaks as shown below.

![Diagram showing baseline placement with and without +CB event]

*Without the +CB event, baseline placement is determined by the peak separation criteria.*
With the +CB event, all peaks share a common baseline.

**NOTE:** Even when the +CB event is in effect, the software checks the artificial cluster for valleys that penetrate the forced baseline. If such valleys are present, it redefines the baseline, where necessary, to eliminate penetration.

The +CB event takes effect at the time it is scheduled and applies to the current peak — the peak on which the event is located, if any. It also applies to subsequent peaks.

The –CB event discontinues the +CB event. The software continues to evaluate each peak against the overlap criteria and assigns overlap flags of 0 or 1, as warranted. This event takes effect immediately and applies to the current peak and subsequent peaks.
A.4.5.2 Force/Discontinue Valley-to-Valley Baselines (+V/–V)

The +V event assigns an overlap flag of 0 to all peaks that occur while the event is in effect. As a result, during integration, all peaks are treated as though they are resolved, even if they meet the criteria for being overlapped. The software draws an individual baseline for each peak extending from valley to valley. No peaks are clustered. The following figures illustrate this concept.

*Without the +V event, some peaks are clustered, having a common baseline.*
With the +V event, each peak has an individual baseline regardless of possible overlapping.

The +V event takes effect at the time it is scheduled and applies to the current peak. It also applies to subsequent peaks.

The −V event discontinues the +V event. The software resumes evaluating each peak against the overlap criteria and assigns overlap flags of 0 or 1 as warranted. This event takes effect immediately and applies to the current peak and subsequent peaks.
A.4.5.3 Force Baseline to Point (BL)

The BL event forces the baseline to the start of the current peak. (The current peak is the one on which the event occurs, or the one that follows the event if it occurs between peaks.)

BL causes the software to assign an overlap flag of 0 to the peak preceding the current peak. As a result, the preceding peak is treated as though it is resolved from the current peak. The software terminates the peak cluster at the end of the preceding peak by ending the cluster baseline there. Because the baseline is forced into this position, the baseline for the current peak is also forced to start at or near the peak start.

If this event occurs when peak detection is in the Begin or Confirm stages, the baseline of the current peak is forced to start at the bunched point representing the data bunch at the event's time. If the event occurs when peak detection is in the Find Top or Find End stages, the baseline is forced to start at the starting point of the current peak.

In the following figure, no BL event has been scheduled. A common baseline has been drawn for the two peaks because they meet the overlap criteria. The lower figure shows the effect of the BL event when it occurs during the Find Top or Find End stages. The preceding peak is assigned a 0 overlap flag and thus has a valley-to-valley baseline. As a result, the baseline of the current peak is forced to begin at the peak starting point.
Without the BL event, the two peaks are clustered and integrated by using drop lines.
With the BL event, a baseline is forced to begin at the peak start.

You can use the BL event to reposition the theoretical baseline used for negative peak detection when a negative peak and a positive peak are contiguous. If the BL event is placed within the negative or positive peak, the theoretical baseline is moved to the level of the peak start. If the BL event is outside either peak, the theoretical baseline is set at the level of the point within whose range the event is scheduled.
A.4.5.4 Force/Discontinue Horizontal Baseline Forward (+HF/−HF)

The +HF event projects a horizontal baseline from the time of the event to the end of the chromatogram or until the event is turned off by a −HF event. When the +HF event is not in use, the software adjusts the baseline to avoid penetration by valleys (as shown between 43 and 46 minutes in the following figure). Conversely, the baseline established by the +HF event always remains horizontal (as shown next).

Without the +HF event, baseline placement is determined by peak separation criteria.
Peaks within the +HF event are treated as a single cluster and share a common, horizontal baseline. The –HF event restores normal baseline treatment.

The +HF event takes effect at the time it is scheduled. The baseline is set at the voltage level and time value of the raw data point nearest the event placement.
In sections of the chromatogram where the +HF event is in effect, peaks cannot have starting or ending points below the baseline. If the baseline intersects a peak, it is not likely to intersect exactly at a raw data point, so the peak starting and ending points usually lie some distance above the projected baseline. As a result, the area between the projected baseline and peak starting and ending points are excluded from the peak area. The following figure, which has been exaggerated for clarity, shows this.

The peak starting and ending points usually lie above the horizontally projected baseline.

You must be careful where you place the +HF event. If the projected baseline is set too high, as in the figure shown on the next page, large areas of peaks will be submerged below the baseline and, therefore, will not be integrated. Some peaks might be submerged entirely and go undetected. To avoid this problem, do not schedule a +HF event on a peak: place it on the baseline just before the start of a peak.
This shows the possible effect of scheduling the +HF event at a point too high on the chromatogram.

The −HF event discontinues the +HF event. The software then resumes evaluating each peak against the overlap criteria and assigns overlap flags of 0 or 1 as warranted.

If the software is searching for a peak ending point when either event is encountered, the current peak will end at the event. Otherwise, the current peak (if any) will be discarded.

You can schedule any number of +HF/−HF event pairs in a chromatogram, but they must not be overlapped. If two +HF events are scheduled in a row, without an intervening −HF event, the second event will be ignored. The lack of an intervening −HF event might even prevent the software from drawing a baseline.
A.4.5.5 Force Horizontal Baseline Backward (HR)

The HR timed event projects a horizontal baseline backward from the time the event is scheduled to the start of the chromatogram. The baseline event is set at the voltage level and time value of the raw data point nearest the event placement. The software does not adjust the baseline to prevent penetration by valleys; thus the baseline remains horizontal.

Where the HR event is in effect, peaks cannot have starting or ending points below the baseline. If the baseline intersects a peak, the intersection is not likely to occur exactly at a raw data point. Therefore, the peak starting and ending points will usually lie some distance above the projected baseline. As a result, the area between the projected baseline and the peak starting and ending points will be excluded from the peak area. This result is because of the algorithm that requires peak boundaries to occur at raw data points, not between them.

Without an HR event, peaks can have separate baselines.
With the HR event, a common horizontal baseline projects backward to the start of the chromatogram.

To achieve the best result, do not schedule the HR event on a peak, but place it on the baseline between peaks or after any peak. This helps avoid baselines that are too high or too low.
A.4.5.6 End Peak Now (E)

The E event establishes a peak end at a selected point. You can use this event in conjunction with the +I and −I events to ensure that a peak ends at the desired point.

If the software is in the Begin or Confirm stages at the time the E event is scheduled, the event will have no effect. Otherwise, the last point of the current bunch becomes the ending point. After this event, the software re-enters the Begin stage. The following figure shows the effect of the E event.

Without the E event, the peak end is found automatically.
With the E event, the peak end is set manually.
A.4.5.7 Start Peak (S)

The S event starts a new peak when the event occurs, regardless of whether a peak would normally be detected and confirmed at this position. Typically, you use this event to force a split between a shoulder of a parent peak.

*Without the S event, the shoulder on the peak at 31.58 minutes is not detected as a separate peak.*
With the S event, the shoulder is detected.

If the software is in the Begin or Confirm stage at the time the S event occurs, the last raw data point of the current bunch (located at the time the event is scheduled) becomes the peak starting point. Also, the software enters into the Find Top stage.

If the software is at the Find Top stage when the S event is scheduled, it forces the present peak to end on the last point of the current bunch, and a new peak is forced to begin.
A.4.5.8 Start Manual Integration/End Manual Integration (+M/−M)

The timed events +M and −M allow you to manually integrate peaks. You place the +M event where you want a peak’s baseline to start and the −M event where you want it to end. The software will draw the baseline between the points on which the events have been placed. If they are not placed exactly on two points, the software will use the points closest to where the events are positioned. Each point represents an area slice extending backward from the point to the preceding point.

A.4.5.9 Force Exponential Skim (+X)

To ensure that the software creates an exponential skim, schedule the +X event anywhere within the parent peak on which you want the skim to start. The +X will have no effect unless you place it between the starting and ending points of a peak: it will have no effect if you place it on the baseline outside a peak.

If you schedule more than one +X event on the same peak, only one event will be recognized. If you place +X events on two adjacent peaks in the same cluster, the software will ignore the second one because it cannot decipher multiple skims when they converge.

If you place +X events on non-adjacent peaks in the same cluster, the software will draw exponential skims. However, what is drawn from the first peak will not extend past the start of the next peak with a +X event.
A.4.5.10 Prevent Exponential Skim (−X)

Scheduling a −X event anywhere on a peak ensures that the software will not create an exponential skim that originates on that peak. This event does not prevent the software from drawing a skim beneath the peak if the skim originated on a preceding peak.

The −X event will have no effect unless placed between a peak’s starting and ending points: it will have no effect if you place it on the baseline outside a peak.

If you schedule more than one −X event on the same peak, only one event will be recognized.

A.4.5.11 Tangential Skim (T)

To create a tangential skim, the software draws a straight baseline from the starting point to the ending point of each child peak of a designated parent peak, as shown in the following figure. Such baselines are drawn for each child peak that occurs before the end of the cluster. The software then checks to see that the new baselines are not penetrated by the child peaks.

Finally, new areas for the child peaks are calculated, and the difference between the old and new areas (the area between the tangent baselines and the cluster baseline) is added to the parent peak.
Peaks before and after a tangential skim.

Unlike an exponential skim, the software never creates a tangential skim automatically. If you want to adjust peak areas by using a tangential skim, you must use a T-timed event. The T event must be placed between a peak's starting and ending points; it will have no effect if you place it on the baseline outside a peak.

If you schedule more than one T event on the same peak, the effect will be the same as having one T event.

Avoid scheduling T events on more than one peak in a cluster. If you place T events on two adjacent peaks in the same cluster, the second one will be ignored.
A.4.6 Calculation of Peak Height and Retention Times

The final step in integration is to determine the retention time and height of each peak. Although peak detection determines a top point, this point is a bunched (averaged) data point and might not be as high as the highest raw data point. Furthermore, even raw data points represent discrete samples of the analog input signal from a chromatograph and might not include the highest possible value in the continuous function. To remedy these shortcomings, the software:

- Finds the highest raw data point lying between the peak start and end points. (If integrating a negative peak, it finds the lowest raw data point.)

- Calculates a quadratic regression based on the highest point and the first two points before and after it. The derivative of the result is found and solved to obtain the maximum of the curve (or minimum for a negative peak). This value is considered to be the absolute peak height, and the time of the maximum is the peak retention time. The actual peak height is the absolute peak height minus the height of the peak baseline at the retention time.
A.5 Component Identification

The component identification step identifies and assigns component names to the peaks in the result file. The following discusses how the software handles overlapping search windows and how you can optimize how the software performs component identification.

A.5.1 Overlapping Search Windows

Overlapping search windows are a source of potential mis-identification of peaks. If windows overlap, a peak can be situated in more than one window at a time. The peak detection software must then determine which component the peak represents.

In such cases, the software might initially identify the peak as being two different components. Then it makes a further determination as to which component will be permanently assigned to the peak and which will be assigned to a different peak.

Another situation arises when one of the overlapping windows is that of a reference component. If a peak in the overlap region meets the selected criterion for the reference component (such as being the tallest peak in the reference component’s window or the closest peak to the expected retention time of the reference component), it will first be identified as the reference component.

If this mis-identified reference component lies within another component search window — even if it is closer to the adjusted retention time of the other component than the expected retention time of the reference component — the peak will retain its identity as the reference component. The software never re-identifies a peak that has already been identified as a reference component.
A.5.2 Optimizing Component Identification

You can optimize component identification by taking the following actions:

- Use at least one reference component to compensate for large shifts in retention times. The reference component should not elute close to other components of interest. Ideally, it will not be a component that you want to quantify; thus you can use a large concentration of it (“spike”) in the sample to ensure a large reference peak.

- Make the search windows for reference components as wide as possible but not wide enough to overlap with the windows of other components. A reference peak will be easy to distinguish from the surrounding peaks if it is made larger.

- Make the search window for non-reference components narrow enough to avoid overlapping with the windows of other components. If you eliminate all overlapping, some peaks might not be identified and some components might not be assigned to a peak, but all identified peaks will be correctly identified unless a drastic shift causes the reference component to be mis-identified.
A.6 Calibration

The software detects, integrates, and identifies peaks in the raw data produced by a standard sample, just as it does in analyzing any other sample. After these processes are complete, the treatment of a calibration run diverges from that for ordinary analyses. During calibration, the software performs the following tasks:

- Enters a calibration replicate into the calibration section of the method for each component calibrated. A replicate is the result data from a calibration injection.

- Averages the replicates for each component and uses these averages to update the response data (area and height values) in the current level.

- Updates component retention time replicate data for the current level.

- Computes or recomputes the calibration curve.

- Produces a report of the calibration.

The first task performed by the software in calibration is to store new calibration data in the method. This task consists primarily of building a new replicate structure. The replicate structure contains a component volume adjusted amount, a component response, internal standard amount ratio and internal standard response ratio (if the internal standard method of calibration is specified), and other data obtained from the current calibration run.
Appendix A Discussion of Data Analysis

Note that it is a volume adjusted amount that is stored in the replicate structure. This is the product of the level amount and the sample volume values set in the method. For External Standard analyses, this allows you to correct for differences in injection volume between standards and samples, or to make concentration-to-amount conversions. In building the replicate data structure the software must also correct for possible differences in the expected component amounts (those currently stored with the calibration level data in the method) and the actual component amounts in the standard sample. Similarly, the software must correct for differences between the expected internal standard amounts and actual internal standard amounts.

A.6.1 Calibration Levels

An unknown component amount can be determined by comparing the response (peak area or height) it produces with the response obtained from a known amount of the same component in a single standard sample. For better accuracy, more than one standard sample is normally used where standard sample contains different amounts (or levels) of the same component. Thus, a calibration level corresponds to a specific component amount used in a standard sample.
A.6.2 Calibration Curves

The response produced by the component at each calibration level plotted against the level amount defines the points of the component’s calibration curve (see the next figure).

Each point on a calibration curve has amount and response coordinates corresponding to different calibration levels.
Each calibration level for a component is assigned a different name. For example, consider the two standard samples, Standard 1 and Standard 2, as follows:

<table>
<thead>
<tr>
<th>Component</th>
<th>Level</th>
<th>Amount</th>
<th>Area</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Methanol</td>
<td>Alpha</td>
<td>10</td>
<td>100,000</td>
<td>50,000</td>
</tr>
<tr>
<td>Ethanol</td>
<td>Alpha</td>
<td>15</td>
<td>250,000</td>
<td>17,000</td>
</tr>
<tr>
<td>Propanol</td>
<td>Alpha</td>
<td>5</td>
<td>120,000</td>
<td>10,000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Component</th>
<th>Level</th>
<th>Amount</th>
<th>Area</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Methanol</td>
<td>Beta</td>
<td>20</td>
<td>180,000</td>
<td>90,000</td>
</tr>
<tr>
<td>Ethanol</td>
<td>Beta</td>
<td>30</td>
<td>370,000</td>
<td>35,000</td>
</tr>
<tr>
<td>Propanol</td>
<td>Beta</td>
<td>10</td>
<td>290,000</td>
<td>25,000</td>
</tr>
</tbody>
</table>
In Standard 1, the calibration level of each component is named “alpha,” and, in Standard 2, the calibration levels are named “beta.” Note that you can assign any name to a level. Level names need not connote a series such as “alpha” and “beta.” For example, “Red” and “Blue” are equally acceptable names.

Calibration level names are assigned individually to each component. A component can have up to 20 calibration levels, but the level names for all components in a standard sample must be the same. For example, it is a good practice to combine an alpha level of methanol in the same standard sample with alpha levels of ethanol and propanol, not beta levels.

The reason for this requirement lies in the nature of a calibration; one calibration (the analysis of one standard sample) provides data at only one calibration level. During analysis of the data, the system stores the data (such as peak areas and heights) in the calibration parameters. The data enter fields reserved for the specified calibration level and no other.

Every component analyzed in a particular type of sample need not be present in each standard. That is, all components need not be represented at every calibration level. For example, if a sample contains ethanol, propanol, and methanol, the following standards could be used for its calibration:
### Standard 3

<table>
<thead>
<tr>
<th>Component</th>
<th>Level</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethanol</td>
<td>Gamma</td>
<td>40</td>
</tr>
<tr>
<td>Propanol</td>
<td>Gamma</td>
<td>12</td>
</tr>
</tbody>
</table>

### Standard 4

<table>
<thead>
<tr>
<th>Component</th>
<th>Level</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Methanol</td>
<td>Zeta</td>
<td>30</td>
</tr>
<tr>
<td>Ethanol</td>
<td>Zeta</td>
<td>50</td>
</tr>
</tbody>
</table>
A.6.3 External Standard Versus Internal Standard Calibration

The software offers a choice between the external standard and the internal standard method of calibration.

A.6.3.1 External Standard Method

When the external standard method is selected, the system relates component amounts with response values to compute the component's calibration curve. The amount and response values at each calibration level contribute a data point to a component's calibration curve. The amount is the $x$ coordinate (the independent variable), and the response is the $y$ coordinate (the dependent variable). Thus, the more calibration levels a component has, the more points will be plotted and used in fitting a calibration curve. For example, suppose a component has the following calibration data:

<table>
<thead>
<tr>
<th>Amount</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10,000</td>
</tr>
<tr>
<td>20</td>
<td>40,000</td>
</tr>
<tr>
<td>30</td>
<td>90,000</td>
</tr>
</tbody>
</table>
Using the external standard method and a quadratic curve fit, the system would generate the data contained in the calibration curve in the following figure.

*External standard calibration curve: amount versus response*
A.6.3.2 Internal Standard Method

Internal standards are compounds introduced in known amounts into chromatography samples — both samples to be analyzed and standard samples. One or more internal standards can be added to a sample.

When the internal standard method is selected, the system relates amount ratios with response ratios to compute the calibration curve. The amount ratio is the amount of component in a standard sample divided by the amount of an internal standard component in the same sample. The response ratio is the area or height of the component divided by the response of an internal standard in the same sample.

The amount and response ratios at each calibration level contribute a data point to a component’s calibration curve. The amount ratio is the $x$ coordinate (the independent variable), and the response ratio is the $y$ coordinate (the dependent variable). For example, suppose a component has the following calibration data:

<table>
<thead>
<tr>
<th>Component</th>
<th>Internal Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Response</td>
</tr>
<tr>
<td>10</td>
<td>10,000</td>
</tr>
<tr>
<td>20</td>
<td>40,000</td>
</tr>
<tr>
<td>30</td>
<td>90,000</td>
</tr>
</tbody>
</table>

Using a quadratic curve fit, the system would generate the calibration curve shown in the following figure.
Internal standard calibration curve: response ratio versus amount ratio
A.6.4 Retention Time Data

You can also use calibration samples to update the expected retention time data for components. The Update Retention Times option can be set to one of the following:

- **N (No)**—The retention time data from the run are not updated in the method.

- **Y (Yes)**—The retention time data from the run are updated in the method. If the calibration is an average, then a retention time replicate is added for the current level. If the calibration is a replace, then the retention time data from the run replace all existing retention time replicates for the current level.

- **R (Reset)**—All existing retention time replicates for all levels are deleted and replaced by the retention time data from this run.
A.6.5 Computation of the Calibration Curve

There are three ways to compute a calibration curve:

- Alternative amount scaling
- Regression Calculation
- Calibration by average calibration factor

**Alternative Amount Scaling**

The software offers alternatives to simply plotting response as a function of amount or response ratio as a function of amount ratio. For example, you can choose to plot response as a function of the log of the component amount. Or, in the case of internal standard calibration, you could plot response ratio as a function of the ratio:

\[
\log \left( \frac{x_{\text{comp}}}{x_{\text{std}}} \right)
\]

where

- \(x_{\text{comp}}\) is the component amount, and
- \(x_{\text{std}}\) is the internal standard amount.

The following is a list of the alternatives for amount scaling:

- \(1/x\) Response is a function of the reciprocal of the amount.
- \(1/x^2\) Response is a function of the reciprocal of the square of the amount.
- \(\log(x)\) Response is a function of the base-10 log of the amount.
- \(1/\log(x)\) Response is a function of the reciprocal of the log of the amount.

Use of these scaling alternatives rules out some values for amount that otherwise would be allowed. Specifically, the amount 0.0 cannot be used with \(1/x\) or \(1/x^2\) scaling. Also, amounts less than 1.0 cannot be used with a logarithmic option; otherwise, an invalid operation will result.
Regression calculation

To compute a calibration curve, the software performs a regression calculation using all replicates for the component at all available calibration levels. If the Include Origin option has been selected in the method, a (0,0) point (amount=0, response=0) is added to the regression data set. The regression is performed by computing a set of orthogonal polynomials and using them to compute the best least-squares approximation with the following equation:

$$p_n^*(x) = \sum_{j=0}^{n} <y, p_j> p_j(x)$$

where

- $p_n^*(x)$ is the best least-squares approximation to the data,
- $p_j(x)$ are the solutions to the orthogonal polynomials at $x$ (the amount)
- $p_j$ are the orthogonal polynomials
- $<y, p_j>$ are the generalized Fourier coefficients at $y$ (the response)
- $n$ is the fit order, which represents the number of polynomials

The notation $<f, g>$ is defined as:

$$<f, g> = \sum_{j=0}^{m} w_j f(x_j) g(x_j)$$

where

- $f$ and $g$ are two functions of $x$
- $w$ is the weighting factor for each data point
- $m$ is the number of data points in the regression

The best least-squares approximation obtained from the regression is a polynomial of the following form:

\[ p_n^* = c_0 + c_1x + c_2x^2 + c_3x^3 \]

The curve coefficients, \( c_0 \) through \( c_3 \), are stored in the method for each component. They define the calibration curve and constitute all the information necessary to plot calibration curves and quantify unknown amounts of the component.

The equation above represents a cubic fit. A quadratic fit will not have the \( c_3 \) term, and a linear fit will have neither the \( c_2 \) nor the \( c_3 \) terms. If the curve is forced through the origin, the \( c_0 \) term will not appear in the equation.

Calibration by average calibration factor

Performing calibrations by using an average calibration factor (ACF) is a technique that is used as a shortcut for performing a linear calibration. Rather than doing a linear regression on the data, this method takes an average of the slope at each calibration point on the curve and uses that average as a single calibration factor. This implies that the intercept of the curve must pass through the origin.

To calculate average calibration factors, the software determines either the ratio of response-to-amount for external standard calibration, or response-ratio to amount-ratio for internal standard calibration, for each replicate. It then sums these ratios and takes the simple average for the average calibration factor, as follows:

\[ ACF = \frac{\sum_{i=1}^{n} \frac{R_{sp_i}}{A_{mi_i}}}{n} \]
where

\( ACF \) is the average calibration factor

\( Rsp_i \) is the response for the \( i \)th replicate of the standard

\( Amt_i \) is the amount for the \( i \)th replicate of the standard

\( n \) is the number of replicates for the standard

For external standard calibrations, the unknown amount is calculated as:

\[
Amt_c = \frac{Rsp_c}{ACF}
\]

where

\( Amt_c \) is the amount for the component,

\( Rsp_c \) is the response for the component, and

\( ACF \) is the average calibration factor for the component

For internal standard calibrations, the unknown concentration is calculated as:

\[
Amt_c = \frac{Rsp_c \times Amt_{ia}}{Rsp_{ia} \times ACF}
\]

where

\( Amt_c \) is the amount for the component

\( Rsp_c \) is the response for the component

\( Rsp_{ia} \) is the response for the internal standard

\( Amt_{ia} \) is the amount of the internal standard

\( ACF \) is the average calibration factor for the component
A.7 Quantitation

The quantitation step involves the following tasks:

- Correction of internal standard amounts
- Determination of initial component amount values for each component by solving the calibration curve for the component, by applying a user-supplied constant calibration factor, by applying an average calibration factor, or by solving the calibration curve of another component specified for this purpose (for example, reference calibration).
- Reversal of the scaling of initial amount values if they have been derived by the application of a scaling alternative (for example, if they are expressed as the log or the reciprocal of the component amount).
- Conversion of amount ratios to amounts or volume adjusted amounts to amounts. If internal standard calibration is specified in the method, initial amounts will be in the form of amount ratios — the ratio of the component amount to the internal standard amount.
- Computation of adjusted amounts by applying the dilution factor, multiplier, divisor, and addend to raw amount values. Raw amounts are those that, if necessary, have had scaling reversed and/or have been converted from amount ratios to amounts.
- Quantitation of unidentified peaks.
Quantitation

Note that component amounts can go through three stages in quantitation: the initial stage when they are first determined from the calibration curve; the raw stage after scaling reversal and/or conversion from amount ratios or volume adjusted amounts to amounts; and, the adjusted stage after the dilution factor, multiplier, divisor, and addend have been applied. The initial stage is synonymous with the raw stage if an initial amount has not been scaled and is not in the form of an amount ratio. A raw amount will be equal to the adjusted amount if the dilution factor, multiplier, and divisor have values of 1.0 and the addend has a value of 0.0.

The following sections explain the quantitation steps in greater detail.
A.7.1 Calculation of Initial Component Amounts

Initial component amounts are calculated in one of three ways: by solving the component's calibration curve (the normal method), by applying a calibration factor (user-supplied or calculated average), or by using the calibration curve of another component (the calibration reference).

To solve a calibration curve for amount, the software uses response in the same form as that used to build the curve. That is, if an external standard calibration was performed, the response used is the peak area or height (whichever has been specified in the method). If an internal standard calibration was performed, the response used is the area ratio or height ratio (component to internal standard).

The initial result of solving a calibration curve is an amount in the same form as that used in building the curve. That is, if an internal standard calibration was performed, the initial amount is an amount ratio. If an alternative amount scaling option was selected, the initial amount is the log of the amount or another variation.

The following sections tell how the software solves the various calibration curve types.

**Calibration curves**

In a point-to-point fit, each pair of points (calibration levels) is connected by a straight line segment. When the response of the component is examined with respect to the calibration levels, four outcomes are possible:

The response lies below the first calibration level, and the curve has been forced through the origin; or, there is only one calibration level, and the response lies below it. In either case, a straight line is drawn to connect the first point (or the only point) with the origin. The initial amount is calculated by solving the equation of this line.
The response lies between two calibration levels. In this case, the equation of the straight line drawn between these levels is used to calculate the initial amount.
The response lies above the last calibration level. If there is more than one calibration level, a straight line is drawn to connect the last two levels and extended beyond the last level. If there is only one calibration level, a straight line is drawn to connect the origin with the level and is then extended beyond the last level. The initial amount is calculated by solving the equation of this line.

\[
A_{\text{ini}} = -\frac{b}{m} (R - b)
\]

where

\begin{align*}
R & \quad \text{is the response} \\
b & \quad \text{is the intercept of the line at the y axis} \\
m & \quad \text{is the slope of the line}
\end{align*}

Note that a slope of 0.0 (a horizontal line) prevents an amount from being calculated; thus, two adjacent calibration levels must not have the same response. A slope of infinity (a vertical line) also prevents an amount from being calculated; thus, two adjacent calibration levels must not have the same amount.
**First order fit**
A first order (linear) curve is specified by the equation:

\[ y = c_0 + c_1x \]

where

- \( c_0 \) is the \( y \) intercept
- \( c_1 \) is the slope of the line

The software calculates the initial amount by using the same equation as used for point-to-point fits. If the slope of the linear curve is 0.0, the equation cannot be solved.

**Second order fit**
A second order (quadratic) curve is specified by the equation:

\[ y = c_0 + c_1x + c_2x^2 \]

This equation can be solved to yield two amount (\( x \)) values, as follows:

\[
\begin{align*}
  x &= \frac{-c_1 + \sqrt{c_1^2 - 4c_2(c_0 - y)}}{2c_2} \\
  x &= \frac{-c_1 - \sqrt{c_1^2 - 4c_2(c_0 - y)}}{2c_2}
\end{align*}
\]
An attempt to solve the equation will have one of four possible results:

- The curve cannot be solved because the square root term is negative. A quadratic curve has a single minimum or maximum. The inability to solve the curve for this reason means that the response \( y \) is either below the minimum or above the maximum. The software will produce an error message signaling that the response is outside the domain of the calibration.

- The curve can be solved, and only one of the two versions of the quadratic equation yields a positive result. This is the optimal case. The positive result is taken as the initial amount, and the negative solution is ignored.

- The curve can be solved, and both solutions yield a positive result. The software chooses the amount value closer to the range of the calibration data.

- The curve can be solved, and both solutions yield a negative result. The software always chooses the larger amount value (the lower absolute value). See “Negative amounts” on page -83.

**Third order fit**  A third order (cubic) equation has the form:

\[
y = c_0 + c_1 x + c_2 x^2 + c_3 x^3
\]

Unlike linear and quadratic equations, cubic equations cannot be conveniently solved directly for \( x \). Instead, the software uses an iterative process based on Newton's method of approximating the root of an equation.

The software first computes the solution for a point-to-point fit as a preliminary estimate. Then, by refining that estimate, it tries to converge on the correct solution.
This method of solving cubic equations has some limitations. Most notable is the inability to continue converging to a solution if an intermediate estimate lies at a minimum or maximum on the curve. Another problem occurs when successive estimates oscillate around the correct value without converging. In both cases, the software issues a warning message after the analysis report, notifying you of the inability to converge on a solution to the curve.

**Negative amounts**

Occasionally, solving a calibration curve can result in a negative amount value. Although there is certainly no such thing as a negative amount of a component in a sample, negative results are caused by a positive $y$ intercept value ($c_0$) when the slope of the curve at the intercept is positive. Any positive response less than the intercept value will correspond with a negative amount.

Physically, a positive intercept can be interpreted to mean that an injection of zero amount of the component causes a positive response. This effect can be caused by instrumental interferences that produce a positive offset (such as stray light in a UV detector). Alternatively, it can arise from calibration data which shows excessive scatter (the positive intercept being merely a consequence of the regression). You can avoid the positive intercept by forcing the curve through the origin. If an amount of zero truly yields a positive response $R$, then, mathematically, any response less than $R$ (even if positive) must correspond with a negative amount.
Appendix A  Discussion of Data Analysis

A more probable calibration curve has a negative \( y \) intercept. This indicates that at a point below a certain positive amount value, there is no response from the chromatograph detector. This amount is the detection limit for the equipment.

![Graph showing detection limit and no response below a certain amount]

**Constant calibration factor** Component amounts are normally determined by solving a calibration curve as described above. However, you have the option to enter into the method a constant calibration factor to be used to calculate a component’s amount. If you choose this alternative, the software does not create a calibration curve. Instead, it divides the component’s response \( R \) by the calibration factor \( F \) to obtain an initial amount \( A_{ini} \):

\[
A_{ini} = \frac{R}{F}
\]

**Reference calibration** Another alternative to using a component’s own calibration curve to determine an unknown amount of it in a sample is to use the curve of another designated component. You choose this alternative by selecting the option Calibrate by Reference when you enter the component information. At that time, you also designate the appropriate reference component. The software calculates a raw amount for the component as though it were the reference component, except that the response of the component and not that of the reference component is used in the calculation.
A.7.2 Reversal of Scaling Options

The method can specify alternative scaling for the amount or amount ratio scale of a component's calibration curve. For example, the response can be plotted versus the log of the amount, rather than the sample amount. In such cases, the initial amount value obtained by solving the calibration curve is in scaled form, and the scaling must be reversed for quantitation.

The operation of transforming scaled amount values is the inverse of that used to scale amount values during calibration:

<table>
<thead>
<tr>
<th>Scaling Operation</th>
<th>Inverse Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/x</td>
<td>1/x</td>
</tr>
<tr>
<td>1/x^2</td>
<td>(1/x)^1/2</td>
</tr>
<tr>
<td>log(x)</td>
<td>10^x</td>
</tr>
<tr>
<td>1/log(x)</td>
<td>1/(10)^x</td>
</tr>
</tbody>
</table>

A negative initial amount \((x)\) will prevent \(1/x^2\) scaling from being reversed because it is impossible to calculate the square root of a negative number. An initial amount of 0.0 is considered to indicate an error during the solution of the calibration curve. The software will leave it at 0.0 and not attempt to reverse the scaling. You cannot reverse scaling if \(x\) is exactly one or much less than one. The software displays a message if it cannot reverse the scaling.
A.7.3 Conversion of Amount Ratios to Raw Amounts

If a component's calibration curve is based on the internal standard method of calibration, the initial amount value obtained by solving the curve and reversing scaling, if necessary, is actually the amount ratio (component amount to internal standard amount).

Amount ratios are converted to raw amounts $A_{raw}$ as follows:

$$A_{raw} = A_{ini} \times I_{adj}$$

where

$A_{ini}$ is the initial component amount ratio

$I_{adj}$ is the internal standard amount as corrected during quantitation.
A.7.4 Computation of Adjusted Amounts

The final step in computing a component amount is to calculate an adjusted amount $A_{adj}$. This is done by applying the dilution factor, multiplier, and divisor to raw amounts. The software uses the following equation:

$$A_{adj} = \frac{A_{raw} \times f \times m}{d}$$

where

$A_{raw}$ is the raw component amount

$f$ is the dilution factor

$m$ is the multiplier

$d$ is the divisor

A.7.5 Quantitation of Unidentified Peaks

The method specifies how the software quantifies unidentified peaks. Three methods are available: using a constant calibration factor, using the calibration of the nearest component, or using the calibration of the nearest reference component.

**Constant calibration factor**

In creating a method, you can enter a constant calibration factor for possible quantitation of unidentified peaks. If the method specifies that this factor is to be used (rather than the calibration of the nearest component or reference component), the software divides a peak’s area by the constant calibration factor to yield a raw amount. Then the adjusted amount is calculated as described in Section A.7.4, Computation of Adjusted Amounts.
Unidentified peaks can be quantified by using the calibration curve of a neighboring peak — the nearest identified component or the nearest reference component, whichever is selected in the method. The software finds the appropriate neighboring peak and calculates a raw amount for the unidentified peak as if it were the neighbor (except the response of the unidentified peak is used in the calculation). Then the software calculates an adjusted amount as described in Section A.7.4, Computation of Adjusted Amounts.
This appendix contains the following sections:

B.1 Contacting Technical Support ......................... B-2
B.2 Obtaining Technical Documents ...................... B-8
B.3 Obtaining Customer Training Information .. B-10
## B.1 Contacting Technical Support

### Overview
You can contact Applied Biosystems for technical support:

- By e-mail
- By telephone or fax
- Through the Applied Biosystems web site

**NOTE:** For information on obtaining technical documents such as Applied Biosystems user documents, MSDSs, and certificates of analysis, see “Obtaining Technical Documents” on page -8.

### By E-mail
You can contact technical support by e-mail for help in the product areas listed below.

<table>
<thead>
<tr>
<th>Product/Product Area</th>
<th>E-Mail Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genetic Analysis (DNA Sequencing)</td>
<td><a href="mailto:galab@appliedbiosystems.com">galab@appliedbiosystems.com</a></td>
</tr>
<tr>
<td>Sequence Detection Systems and PCR</td>
<td><a href="mailto:pcrlab@appliedbiosystems.com">pcrlab@appliedbiosystems.com</a></td>
</tr>
<tr>
<td>Protein Sequencing, Peptide, and DNA Synthesis</td>
<td><a href="mailto:corelab@appliedbiosystems.com">corelab@appliedbiosystems.com</a></td>
</tr>
<tr>
<td>Biochromatography</td>
<td><a href="mailto:tsupport@appliedbiosystems.com">tsupport@appliedbiosystems.com</a></td>
</tr>
<tr>
<td>Expedite™ (89000) DNA Synthesis System</td>
<td></td>
</tr>
<tr>
<td>PNA</td>
<td></td>
</tr>
<tr>
<td>Pioneer™ Peptide Synthesis System</td>
<td></td>
</tr>
<tr>
<td>Proteomics Solution 1™ (PS1) System</td>
<td></td>
</tr>
<tr>
<td>ICAT™ reagent</td>
<td></td>
</tr>
<tr>
<td>FMAT™ 8100 HTS System</td>
<td></td>
</tr>
<tr>
<td>Mariner™ Mass Spectrometers</td>
<td></td>
</tr>
<tr>
<td>Voyager™ Mass Spectrometers</td>
<td></td>
</tr>
<tr>
<td>CytoFluor® 4000 Fluorescence Plate Reader</td>
<td></td>
</tr>
<tr>
<td>LC/MS (Applied Biosystems/MDS Sciex)</td>
<td><a href="mailto:support@sciex.com">support@sciex.com</a></td>
</tr>
<tr>
<td>Chemiluminescence (Tropix)</td>
<td><a href="mailto:tropix@appliedbiosystems.com">tropix@appliedbiosystems.com</a></td>
</tr>
</tbody>
</table>
To contact Applied Biosystems Technical Support in North America, use the telephone or fax numbers in the table below.

**NOTE:** To schedule a service call for other support needs, or in case of an emergency, dial **1.800.831.6844**, then press 1.

<table>
<thead>
<tr>
<th>Product/Product Area</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABI PRISM® 3700 DNA Analyzer</td>
<td><strong>1.800.831.6844</strong>, then press 8&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.59 81</td>
</tr>
<tr>
<td>DNA Synthesis</td>
<td><strong>1.800.831.6844</strong>, press 2, then press 1&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.59 81</td>
</tr>
<tr>
<td>Fluorescent DNA Sequencing</td>
<td><strong>1.800.831.6844</strong>, press 2, then press 2&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.59 81</td>
</tr>
<tr>
<td>Fluorescent Fragment Analysis (including GeneScan&lt;sup&gt;®&lt;/sup&gt; applications)</td>
<td><strong>1.800.831.6844</strong>, press 2, then press 3&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.59 81</td>
</tr>
<tr>
<td>Integrated Thermal Cyclers (ABI PRISM&lt;sup&gt;®&lt;/sup&gt; 877 and Catalyst 800 instruments)</td>
<td><strong>1.800.831.6844</strong>, press 2, then press 4&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.59 81</td>
</tr>
<tr>
<td>ABI PRISM® 3100 Genetic Analyzer</td>
<td><strong>1.800.831.6844</strong>, press 2, then press 6&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.59 81</td>
</tr>
<tr>
<td>Peptide Synthesis (433 and 43x Systems)</td>
<td><strong>1.800.831.6844</strong>, press 3, then press 1&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.59 81</td>
</tr>
<tr>
<td>Protein Sequencing (Procise&lt;sup&gt;®&lt;/sup&gt; Protein Sequencing Systems)</td>
<td><strong>1.800.831.6844</strong>, press 3, then press 2&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.59 81</td>
</tr>
<tr>
<td>Product/Product Area</td>
<td>Telephone</td>
<td>Fax</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------</td>
<td>----------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>PCR and Sequence Detection</td>
<td>1.800.762.4001, then press:</td>
<td>1.240.453.46</td>
</tr>
<tr>
<td>1 for PCR⁸</td>
<td></td>
<td>13</td>
</tr>
<tr>
<td>2 for TaqMan® applications and Sequence Detection Systems including ABI PRISM® 7700,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7900, and 5700⁶</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 for the 6700 Automated Sample Prep System⁵</td>
<td></td>
<td></td>
</tr>
<tr>
<td>or 1.800.831.6844, then press 5⁵</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Voyager™ MALDI-TOF Biospectrometry Workstations</td>
<td>1.800.899.5858, press 1, then press 3⁶</td>
<td>1.508.383.78</td>
</tr>
<tr>
<td>• Mariner™ ESI-TOF Mass Spectrometry Workstations</td>
<td></td>
<td>55</td>
</tr>
<tr>
<td>• Proteomics Solution 1™ (PS1) System</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• ICAT™ reagent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Biochromatography (BioCAD®, SPRINT™, VISION™, and INTEGRAL® Workstations and Poros®</td>
<td>1.800.899.5858, press 1, then press 4⁶</td>
<td>1.508.383.78</td>
</tr>
<tr>
<td>Perfusion Chromatography Products)</td>
<td></td>
<td>55</td>
</tr>
<tr>
<td>Expedite™ (8900) Nucleic Acid Synthesis Systems</td>
<td>1.800.899.5858, press 1, then press 5⁵</td>
<td>1.508.383.78</td>
</tr>
<tr>
<td>Peptide Synthesis (Pioneer™ and 9050 Plus Peptide Synthesizers)</td>
<td>1.800.899.5858, press 1, then press 5⁵</td>
<td>1.508.383.78</td>
</tr>
<tr>
<td>PNA Custom and Synthesis</td>
<td>1.800.899.5858, press 1, then press 5⁵</td>
<td>1.508.383.78</td>
</tr>
</tbody>
</table>
Contacting Technical Support

By telephone or fax (outside North America)

<table>
<thead>
<tr>
<th>Product/Product Area</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>FMAT™ 8100 HTS System CytoFluor® 4000 Fluorescence Plate Reader</td>
<td>1.800.899.5858, press 1, then press 6&lt;sup&gt;b&lt;/sup&gt;</td>
<td>1.508.383.78 55</td>
</tr>
<tr>
<td>Chemiluminescence (Tropix)</td>
<td>1.800.542.2369 (U.S. only), or 1.781.271.0045&lt;sup&gt;c&lt;/sup&gt;</td>
<td>1.781.275.85 81</td>
</tr>
<tr>
<td>LC/MS (Applied Biosystems/MDS Sciex)</td>
<td>1.800.952.4716</td>
<td>1.508.383.78 99</td>
</tr>
</tbody>
</table>

a. 5:30 A.M. to 5:00 P.M. Pacific time.
b. 8:00 A.M. to 6:00 P.M. Eastern time.
c. 9:00 A.M. to 5:00 P.M. Eastern time.

To contact Applied Biosystems Technical Support or Field Service outside North America, use the telephone or fax numbers below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eastern Asia, China, Oceania</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Australia (Scoresby, Victoria)</td>
<td>61 3 9730 8600</td>
<td>61 3 9730 8799</td>
</tr>
<tr>
<td>China (Beijing)</td>
<td>86 10 64106608 or 86 800 8100497</td>
<td>86 10 64106617</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>852 2756 6928</td>
<td>852 2756 6968</td>
</tr>
<tr>
<td>Korea (Seoul)</td>
<td>82 2 5936470/6471</td>
<td>82 2 5936472</td>
</tr>
<tr>
<td>Malaysia (Petaling Jaya)</td>
<td>60 3 79588268</td>
<td>603 79549043</td>
</tr>
<tr>
<td>Singapore</td>
<td>65 896 2168</td>
<td>65 896 2147</td>
</tr>
<tr>
<td>Taiwan (Taipei Hsien)</td>
<td>886 2 2358 2838</td>
<td>886 2 2358 2839</td>
</tr>
<tr>
<td>Thailand (Bangkok)</td>
<td>66 2 719 6405</td>
<td>662 319 9788</td>
</tr>
</tbody>
</table>
### Appendix B Technical Support and Training

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Europe</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Austria (Wien)</td>
<td>43 (0)1 867 35 75 00</td>
<td>43 (0)1 867 35 75 11</td>
</tr>
<tr>
<td>Belgium</td>
<td>32 (0)2 532 4484</td>
<td>32 (0)2 582 1886</td>
</tr>
<tr>
<td>Denmark (Naerum)</td>
<td>45 45 58 60 00</td>
<td>45 45 58 60 01</td>
</tr>
<tr>
<td>Finland (Espoo)</td>
<td>358 (0)9 251 24 250</td>
<td>358 (0)9 251 24 243</td>
</tr>
<tr>
<td>France (Paris)</td>
<td>33 (0)1 69 59 85 85</td>
<td>33 (0)1 69 59 85 00</td>
</tr>
<tr>
<td>Germany (Weiterstadt)</td>
<td>49 (0) 6150 101 0</td>
<td>49 (0) 6150 101 101</td>
</tr>
<tr>
<td>Italy (Milano)</td>
<td>39 (0)39 83891</td>
<td>39 (0)39 8389492</td>
</tr>
<tr>
<td>Norway (Oslo)</td>
<td>47 23 12 06 05</td>
<td>47 23 12 05 75</td>
</tr>
<tr>
<td>Portugal (Lisboa)</td>
<td>351.(0)22.605.33.14</td>
<td>351.(0)22.605.33.15</td>
</tr>
<tr>
<td>Spain (Tres Cantos)</td>
<td>34.(0)91.806.1210</td>
<td>34.(0)91.806.12.06</td>
</tr>
<tr>
<td>Sweden (Stockholm)</td>
<td>46 (0)8 619 4400</td>
<td>46 (0)8 619 4401</td>
</tr>
<tr>
<td>Switzerland (Rotkreuz)</td>
<td>41 (0)41 799 7777</td>
<td>41 (0)41 790 0676</td>
</tr>
<tr>
<td>The Netherlands (Nieuwerkerk a/d IJssel)</td>
<td>31 (0)180 392400</td>
<td>31 (0)180 392409 or 31 (0)180 392499</td>
</tr>
<tr>
<td>United Kingdom (Warrington, Cheshire)</td>
<td>44 (0)1925 825650</td>
<td>44 (0)1925 282502</td>
</tr>
<tr>
<td><strong>European Managed Territories (EMT)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Africa, English speaking (Johannesburg, South Africa)</td>
<td>27 11 478 0411</td>
<td>27 11 478 0349</td>
</tr>
<tr>
<td>Africa, French speaking (Paris, France)</td>
<td>33 1 69 59 85 11</td>
<td>33 1 69 59 85 00</td>
</tr>
<tr>
<td>India (New Delhi)</td>
<td>91 11 653 3743</td>
<td>91 11 653 3138</td>
</tr>
<tr>
<td>Poland, Lithuania, Latvia, and Estonia (Warszawa)</td>
<td>48 22 866 4010</td>
<td>48 22 866 4020</td>
</tr>
</tbody>
</table>
To contact Technical Support through the Applied Biosystems web site:

1. Go to www.appliedbiosystems.com
2. Click Services & Support at the top of the page, then click Frequently Asked Questions.
3. Click Contact Support in the contents list at the left of the screen.
4. Click your geographic region for the product area of interest.
5. In the Personal Assistance form, enter the requested information and your question, then click Ask Us RIGHT NOW.
6. In the Customer Information form, enter the requested information, then click Ask Us RIGHT NOW.

Within 24 to 48 hours, you will receive an e-mail reply to your question from an Applied Biosystems technical expert.

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>For all other EMT countries not listed (Central and southeast Europe, CIS, Middle East, and West Asia)</td>
<td>44 1925 282481</td>
<td>44 1925 282509</td>
</tr>
<tr>
<td>Japan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Japan (Hacchobori, ChuoKu, Tokyo)</td>
<td>81 3 5566 6230</td>
<td>81 3 5566 6507</td>
</tr>
<tr>
<td>Latin America</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Caribbean countries, Mexico, and Central America</td>
<td>52 55 35 3610</td>
<td>52 55 66 2308</td>
</tr>
<tr>
<td>Brazil</td>
<td>0 800 704 9004 or 55 11 5070 9654</td>
<td>55 11 5070 9694/95</td>
</tr>
<tr>
<td>Argentina</td>
<td>800 666 0096</td>
<td>55 11 5070 9694/95</td>
</tr>
<tr>
<td>Chile</td>
<td>1230 020 9102</td>
<td>55 11 5070 9694/95</td>
</tr>
<tr>
<td>Uruguay</td>
<td>0004 055 654</td>
<td>55 11 5070 9694/95</td>
</tr>
</tbody>
</table>
B.2 Obtaining Technical Documents

Overview
You can obtain technical documents, such as Applied Biosystems user documents, MSDSs, certificates of analysis, and other related documents for free, 24 hours a day. You can obtain documents:

- By telephone
- Through the Applied Biosystems web site

To order documents by telephone:

1. From the U.S. or Canada, dial 1.800.487.6809, or from outside the U.S. and Canada, dial 1.858.712.0317.
2. Follow the voice instructions to order documents (for delivery by fax).

NOTE: There is a limit of five documents per fax request.

Ordering documents by telephone

To view, download, or order documents through the Applied Biosystems web site:

1. Go to www.appliedbiosystems.com/
2. At the top of the page, click Services & Support at the top of the page, then click Documents on Demand.
3. In the search form, enter and select search criteria, then click Search at the bottom of the page.
4. In the results screen, do any of the following:
   - Click to view a PDF version of the document.
   - Right-click , then select Save Target As to download a copy of the PDF file.
   - Select the Fax check box, then click Deliver Selected Documents Now to have the document faxed to you.
• Select the Email check box, then click Deliver Selected Documents Now to have the document (PDF format) e-mailed to you.

**NOTE:** There is a limit of five documents per fax request, but no limit on the number of documents per e-mail request.
B.3 Obtaining Customer Training Information

To obtain Applied Biosystems training information, go to www.appliedbiosystems.com, click Services & Support at the top of the screen, then click Training.
Absolute window—See Search window.

Addend—A user-defined value, which may be positive, negative, or zero, that is added to raw component amounts. The addend, dilution factor, multiplier, and divisor constitute the conversion factors for calculating adjusted component amounts from raw amounts.

Adjusted amount—In quantitation, this is the final calculated amount obtained from the raw amount through the use of the dilution factor and the conversion factors.

Adjusted expected retention time—If a component has a reference component, the component’s expected retention time is corrected by the percent that the reference peak deviates from its expected retention time. When corrected in this manner, a component’s expected retention time is called the adjusted expected retention time. It is based on the assumption that if the reference peak shifts by a certain percentage of its expected retention time, a peak representing a related component will also shift by the same percentage.

Annotation—The labeling of chromatograms, on the screen or on printed output, with baselines, peak retention times and/or peak names.

Area/Amount ratio—The ratio of a peak’s area or height to the raw amount it represents. For a component with a linear response, this is equivalent to the calibration factor for the peak.

Area/Height ratio—The ratio of a peak’s area to its height. This data item can be included in peak reports or summary reports.

Area percent—The ratio of a peak’s area to the sum of all peak areas listed in the main report. Expressed as a percentage, the sum in this calculation includes only the areas of peaks listed in the main report. It does not include peak areas of unidentified peaks if these peaks are not reported. Thus, the percentages in an area percent column will always add up to 100.

Area reject—The minimum peak area you want included in the main report and any group reports. Any peak with an area less than this minimum peak area is not included.

Area threshold—A parameter in the processing section of the method that discriminates between noise and peaks. After a pending peak has passed the noise threshold test, the cumulative sum of bunched area slices must exceed the area threshold value before the peak crest is detected; otherwise the peak is rejected as noise.
**Average calibration factor**—In this type of calibration, the ratio of response to amount is calculated for each replicate at all of the calibration levels, and is averaged together to give an average calibration factor. The amount in an unknown sample is calculated by dividing the response by the average calibration factor.

**Axis labels**—See Labels.

**.B* file**—Data file generated by running a method file (.MET). Data file extensions are either .BIO or .B##. The .B## extension represents sequential numbers used when you select the Auto file extension feature or run a template or multi-method.

**Baseline code**—See Baseline type.

**Baseline timed events**—Commands defined in the analysis section of a file that affect peak detection and/or integration at specific times during a run.

**Baseline type**—A two-letter code that may be printed as part of the analysis report, indicating how a peak’s baseline was drawn. The first letter indicates the baseline treatment at the peak start, and the second letter indicates the baseline treatment at the peak end. The baseline codes are:

- **B**—Resolved peak: The peak starts or ends at the baseline.
- **V**—Unresolved peak: The peak is overlapped with the next and/or previous peak. The peak starts or ends at a valley above the baseline, and a dropline is drawn from the valley to the baseline to allow integration.
- **E**—The peak starts or ends with an exponential skim. A parent peak separated from a child peak by an exponential skim has a baseline type of either BE or VE. The child peak’s baseline type is either EB or EV. Successive child peaks do not have the E code because they do not begin at the start of the skim.
- **T**—The peak starts or ends with a tangential skim.

**Bracket calibration**—A form of calibration where standards are analyzed both before and after a group of samples, and the average of the calibration information is used to quantify the samples.

**Bunching**—The process during peak detection that averages the voltage values of a number of successive data points. The resulting averages constitute a “bunched point.” Bunching smooths the raw data so that baseline noise does not cause the system to find too many potential peak starts. Bunching also compensates for over-sampling. See also Bunching factor.
**Bunching factor**—A parameter in the processing section of the method that specifies how many sequential data points in the raw data file will be grouped in a bunch. It can range from 1 to 99. Bunching factors should be based on the narrowest peak you want the system to detect. See also Bunching.

**Calibration**—The stage in data analysis that updates amount and response values for components during the analysis of calibration standards. Calibration information is then stored in the method file, and calibration curves are recalculated. There are two methods of calibration:

- **External Standard (EXTD) calibration** — The Data Analysis software plots component amounts against response values to compute the calibration curve.

- **Internal Standard (ISTD) calibration** — The Data Analysis software plots component amount ratios against response ratios (with the internal standard) to compute the calibration curve.

**Calibration curve**—Shows the relationship between a component’s responses at different calibration levels and the corresponding amounts. This helps the system to quantify component amounts in unknown samples. See also Calibration and Curve fit type.

**Calibration curve fit**—See Curve fit type and Fit type.

**Calibration factor**—A constant value you enter that is used to calculate component amounts. The component’s peak response is divided by the calibration factor value to obtain the raw component amount.

**Calibration level**—Corresponds to a specific component amount used in a standard sample. Each standard sample contains the same component, but at different calibration levels. The response produced by the component at each calibration level is plotted against the level amount and defines the points on which the component’s calibration curve is based. A component can have up to 100 calibration levels, but the level names for all components in a standard sample must be the same.

**Calibration mode**—Specifies the procedure the Data Analysis software uses when calibrating the method. There are two basic calibration modes:

- **Average** — A calibration replicate is added to each component that has a level defined with the selected name.

- **Replace** — Any existing calibration replicates for the selected level are deleted from the component list, and a single new replicate that corresponds to the peak data is added.
**Calibration range**—An optional report data item that indicates whether the peak response is within the calibrated range for the component or not. A minus sign (–) indicates that the peak response lies below the calibrated range. A plus sign (+) indicates that the peak response lies above the calibrated range. A blank represents a response within range.

**Calibration reference**—See Reference component.

**Calibration replicates**—A repetitive analysis of the same calibration standard. Replicates allow you to calculate average calibration information. Results from replicates are stored in the method. See also Calibration mode.

**Child peak**—A minor peak skimmed off the major, or parent, peak when exponential or tangential skimming is employed.

**Cluster**—A group of unresolved peaks that normally share a common baseline segment.

**Component**—An identified peak or groups of peaks. There are three types of components:

- **Single peak component** — A component identified as a single peak in the run.
- **Named group** — Two or more single-peak components that are grouped together in order to be calibrated and reported as a single entity. Members of a named group can appear anywhere in the chromatogram; they do not have to be located contiguously. A single peak component can be a member of more than one named group.
- **Timed group**—A group of contiguous peaks whose retention times fall within a defined time window. Each peak is detected and integrated individually; the group area and height are the sum of the individual peak areas and heights. Peaks need not be identified to be included in a timed group.

**Component amount**—The amount of a component present in a calibration standard. Each calibration level defined for a component references a different amount. See also Calibration level.

**Component identification**—The process of determining the identity of peaks in the result file by comparing their retention times with a predefined list of expected components and retention times found in a calibration file. This assigns component names to peaks in the result file.

**Component list**—The list of components defined in a method.
**Component name**—The name given to a peak, or group of peaks, to be identified in an analysis.

**Curve fit type**—Determines how the calibration curve is generated from the data points. The curve fit type is the principal parameter in determining the curve fit, and is therefore sometimes simply referred to as fit type. See also Weighting.

Current types include:

- **Point-to-point**—Averages all replicate amount and response data at each calibration level to derive a point. Each pair of points is connected by a straight line segment. You may use this fit type with one or more calibration levels.

- **First-order polynomial**—Calculates a first-order (linear) polynomial fit using the curve coefficients (intercept and slope). To use this type of fit, a component must have at least two calibration levels (or one plus the origin).

- **Second-order polynomial**—Calculates a second-order (quadratic) polynomial fit using the curve coefficients. To use this type of fit, a component must have at least three calibration levels (or two plus the origin).

- **Third-order polynomial**—Calculates a third-order (cubic) polynomial fit using the curve coefficients. To use this type of fit, a component must have at least four calibration levels (or three plus the origin).

**Custom expression**—An expression created in the Report Format Editor that calculates a non-standard data value. Such expressions include symbols for mathematical operators and codes representing the data values available in the result file. In a summary report, custom expressions let you include summary information that is the result of a calculation performed automatically when the report is generated.

**Custom labels**—See Labels.

**Data analysis**—The process by which data in a data file are interpreted, utilizing parameters from a method, to produce chromatographic results.

**Delta retention time**—The difference between the expected retention time of a component (as specified in the calibration section of the method) and the actual retention time of the identified peak. Delta retention time is expressed as a percentage of the expected retention time.

The delta retention time T (applying to identified peaks only) is calculated as follows:

\[
T = \frac{t_{\text{exp}} - t_{\text{act}}}{t_{\text{exp}}} \times 100
\]

where \( t_{\text{exp}} \) is a peak's expected retention time and \( t_{\text{act}} \) is the peak's actual retention time.
**Dilution factor**—A value that accounts for the dilution of the sample prior to injection. For example, if a sample is diluted 100:1, the dilution factor would be 100. The software multiplies raw amounts by this factor. If a sample is not diluted, or if you do not want to make this correction, use 1 as the dilution factor. The dilution factor, divisor, multiplier and addend constitute the conversion factors for calculating adjusted component amounts from raw amounts.

**Divisor**—A positive or negative user-defined value, which cannot be zero. The Data Analysis software divides raw component amounts by this value. The divisor, dilution factor, multiplier, and addend constitute the conversion factors for calculating adjusted component amounts from raw amounts.

**Droplines**—Vertical lines drawn from an overlapped peak’s start point and/or end point to the peak baseline, defining the boundaries of the peak’s area.

**Expected retention time**—The time during a run when the peak corresponding to the component is expected to elute. The component search window is centered on the expected retention time.

**Exponential skim**—A curve drawn by using an exponential equation to approximate the trailing edge of a parent peak. The skim passes under one or more child peaks. The area underneath the skim is subtracted from the child peak(s) and given to the parent peak.

**Exponential skim criteria**—Parameters in the processing section of the method that determine whether or not an exponential skim will be used to determine the area of a peak on the trailing edge of another peak.

**External standard (EXTD) calibration**—See Calibration.

**First-order polynomial curve**—See Curve fit type.

**Fit type**—The way in which the Data Analysis software fits the calibration curve to the data points. You change the fit type by altering the fit parameters, such as the weighting factor and origin. Because curve fit type is the principal parameter, it is often referred to simply as fit type. See also Curve fit type.

**Full scale**—The height of the plot window (in mV).

**.GRO file**—Group file automatically created by running a template or multi-method, or manually created in the Group Analysis window. A group file contains a list of data files.
**Global calibration information**—Parameters that apply to all components in the method (such as ISTD or EXTD calibration) or to all unidentified peaks (such as quantitation type).

**Graphic editing**—The process of modifying parameters and viewing their effects on the data analysis by manipulating the chromatogram itself. This lets you optimize method parameters for a routine analysis (in the Graphic Method Editor).

**Group report**—A tabulation of results for components that are members of groups. A separate (optional) group report is created for each group established in the analysis section of a file. A report for a given group contains information only for peaks that belong to the group. It contains the same data types as the main report and has the same format. Percent and normalized percent calculations are based only on the peaks within the group that are reported.

**Integration**—See Peak integration.

**Internal standard (ISTD) amount**—The actual total amount of internal standard components in the sample or calibration standard. The Data Analysis software multiplies each internal standard component amount in the calibration section of the method by this factor to correct differences between the actual amount of internal standards used and the amounts of internal standards specified in the calibration section of the method. If calibration and quantitation are not based on internal standards, the ISTD amount is not used, but is still available for use in custom expressions in the report.

**Internal standard (ISTD) amount ratio**—The ratio of the component amount to the related internal standard amount. This data type applies only to peaks that have been identified and quantified based on the internal standard method. The amount ratio is always based on raw amounts, never on adjusted amounts.

**Internal standard (ISTD) calibration**—See Calibration.

**Internal standard (ISTD) component**—A known amount of a compound introduced into a chromatographic analysis. This amount is applied to both samples to be quantified and calibration standard samples. One or more internal standards can be added to a sample.
**Internal standard (ISTD) response ratio**—The ratio of a peak's response to the response of the related internal standard component. This data type applies only to peaks that have been identified and quantified based on the internal standard method.

**k-prime (k')**—The capacity ratio of a peak. This expresses how many times longer the compound took to pass through the chromatography column, retarded by the stationary phase, than it would have if it was completely unretained. It is calculated as the ratio of the retention time of the peak (corrected for the void time) to the void time:

\[ k' = \frac{RT_{\text{obs}} - RT_{\text{unretained}}}{RT_{\text{unretained}}} \]

**Labels**—There are four types of labels that can be added to printed, plotted and/or displayed chromatograms:

- **Axis labels** — The labels that describe the axes and the title of chromatogram reprints.
- **Plot labels** — The retention time, component name, and timed events, which can appear on reprints and in the Graphic Method Editor.
- **Tick labels** — The time values along the X-axis and the mAU (response) values along the Y-axis of the chromatogram. The size of the actual tick marks on the axes does not change. Tick marks appear in printed chromatograms and chromatograms in the Strip Chart Recorder, Group Analysis window, and the Graphic Method Editor.

**Level amount**—The amount of the component in the calibration standard at that level.

**Level name**—The name of the calibration level.

**.MET file**—Method file created in the Method Editor. A method file specifies instrument settings and conditions during a separation run.

**.MTH section**—Analysis parameters, which include processing (peak detection, integration, report/replot printing) and calibration parameters. Each method file (.MET), data file (.B*), and group file (.GRO) contains three .MTH sections (one for each data channel).

**Maximum adjusted amount**—A variable that can be used in custom expressions in the Report Format Editor and Summary Format Editor. It equates to the largest adjusted amount value in the data set. For a single report, it is the largest value for all peaks in the report. For a summarized data set, it is the largest value for all components and all report files.

**Maximum peak area**—A variable that can be used in custom expressions in the Report Format Editor. It equates to the largest peak area value in the data set. For a single report, it is the largest value for all peaks in the report. For a summarized data set, it is the largest value for all components and all report files.
**Maximum peak height**—A variable that can be used in custom expressions in the Report Format Editor. It equates to the largest peak height value in the data set. For a single report, it is the largest value for all peaks in the report. For a summarized data set, it is the largest value for all components and all report files.

**Missing component**—Components that are listed in the calibration file but are not associated with a peak in the chromatogram.

**Named group**—See Component.

**Noise threshold**—A parameter in the processing section of the method that discriminates between baseline noise and peaks. If the difference between two consecutive bunched data points is greater than the noise threshold, The Data Analysis software recognizes the potential start of a peak. The lower the noise threshold, the more sensitive and susceptible to noise peak detection will be. Raising the noise threshold decreases sensitivity.

**Normalization**—The process of expressing a peak area or amount as a percentage of the total area or amount for all peaks. A normalization factor can be used to set the total to a value other than 100%.

**Normalization factor**—A factor used in calculating normalized area percent and normalized amount percent values. The normalized area and amount percent values for all reported peaks add up to the normalization factor, which is set to 100% by default.

**Overlap flag**—A marker in the result file that identifies whether a peak is overlapped or resolved from its neighbors. During integration, overlap flags are used to determine how baseline is drawn under the peak or peak cluster. See also Peak separation criteria.

**Parent peak**—In exponential or tangential skimming, this is the major peak from whose trailing edge the minor (child) peaks are skimmed.

**Peak area**—The measured area of a peak (in microvolt-seconds) in the chromatogram, after the baseline has been drawn and integration performed.

**Peak cluster**—A group of contiguous peaks that are found to be overlapped during peak detection. All peaks in a cluster share a common baseline, whereas all resolved peaks have an individual baseline.

**Peak confirmation**—The stage in the peak detection process when the accumulated area for an emerging peak is tested against the area threshold value. The peak is confirmed when the accumulated area exceeds the area threshold.
Peak detection—The process of scanning the data points in a raw data file (or modified raw data file) to find peaks. Peak detection parameters provide the criteria for rejecting noise and baseline drift and recognizing the start of true peaks. They also enable the Data Analysis software to determine the points at which the tops and ends of peaks are located. This produces a preliminary result file containing a peak list of peak start and end points. The principal parameters are the bunching factor, noise threshold, and area threshold.

Peak end—The end of a peak is marked when either of the following occurs: two consecutive bunched points decrease less than the noise threshold, relative to the preceding bunched point; or a bunched point increases over the preceding bunched point by an amount greater than the noise threshold. The latter case indicates the start of another peak.

Peak height—The height, above the peak baseline, of the peak crest, measured in microvolts. The exact peak crest is determined from a quadratic curve fit through the raw points that are above 75% of maximum level (with a minimum of five points).

Peak integration—Sets the final positions of baselines for clustered peaks and separates these peaks with droplines. It also determines peak areas and adjusts them, if necessary, by exponential or tangential skimming, and calculates peak heights and retention times. This step adds final values for peak start and end points, retention times, areas, and heights to the result file.

Peak number—An index assigned to each peak detected in a run. This number can be included in the report.

Peak separation criteria—Tests to determine if two peaks are resolved or part of a cluster. If the distance between the two peaks is less than 0.2 times the width of the second peak, and if the height of the valley (above the baseline) is greater than 0.01 times the height of the smaller of the two peaks (above the baseline), the peaks are considered to be overlapping. If the separation is greater than this, they are not overlapping. See also Overlap flag.

Peak start—Once a peak is confirmed, the Data Analysis software scans backward from the potential peak start through five bunches of raw data to find the lowest raw data point. The search stops when it reaches the end of the preceding peak. The lowest raw data point found in this process becomes the actual peak start.
Penetration—When part of the chromatogram (such as a valley point) crosses below the initial drawn baseline. This can occur during the integration process. The Data Analysis software usually adjusts the drawn baseline to prevent such penetration; however, it does allow penetration for horizontally projected baselines.

Percent amount—The adjusted amount for a peak expressed as a percentage of the sum of the adjusted amounts for all the peaks listed in the main report. The values in a percent amount column always add up to 100 because the amounts for peaks excluded from the main report are not added into the sum.

Plot—The display of a chromatogram on the screen or output to a printer. The printed version of a chromatogram is frequently referred to as a replot.

Plot orientation—The way in which plots are arranged on a page. There are two kinds of plot orientation:

Landscape — The plots are drawn with the time axis parallel to the long dimension of the page, and the peak tops point toward the right side of the page.

Portrait — The plots are drawn with the time axis parallel to the narrow dimension of the page, and the peak tops point toward the top of the page.

Plot scale—The time and voltage scales for a displayed chromatogram.

Plot style—In graphic editing, you have the choice of three different plot styles. “Normal” chromatograms are plotted as a series of line segments connecting each raw data point. Chromatograms can also be plotted as a series of unconnected raw data points, or they can be plotted as a series of raw data and bunched points. You set the plot style in the Configuration function.

Point-to-point calibration curve—See Curve fit type.

Post-run processing—The steps in data analysis that are performed at the end of each run. They consist of peak detection, integration, component identification, calibration, quantitation, report generation, replot generation and the execution of user programs.

Quantitation—The process of calculating the amounts of the components in chromatography samples. These calculations are based on the peak areas or heights and on the calibration data for corresponding components. This process adds component amounts to the results section of a data file.

.RPT section—Report Format parameters, which specify what information to include in a printed report. Each method file (.MET), data file (.B*), and group file (.GRO) contains three .RPT sections (one for each data channel).
Raw amount—The amount of a component represented by a peak, as calculated from the calibration curve or by applying a response factor. Unlike adjusted amount, this amount does not take into account the dilution factor, multiplier, divisor, or addend. If necessary, raw amounts have had scaling reversed, have been converted from amount ratios to amounts, and have sample volume adjustments made.

Reference chromatogram—A section of the screen, in the Graphic Method Editor, which normally displays the whole chromatogram, as opposed to the current expanded working chromatogram.

Reference component—There are two kinds of reference components:

Retention Reference — A component whose retention time is used to adjust the expected retention time of other components, and/or to calculate a relative retention value for them.

Calibration Reference — A component whose calibration data is used by one or more other components.

Reference peak—See Retention Reference under Reference component.

Regression calculation—To compute a calibration curve, the Data Analysis software performs a regression calculation using all replicates for the component at all available calibration levels. The regression is performed by computing a set of orthogonal polynomials and using them to compute the best least-squares approximation.

Regression weighting—See Weighting.

Relative retention time (RRT)—The retention time of a peak compared to that of a specified retention reference component.

RT is calculated as

$$RRT = \frac{RT_{obs} - RT_{unretained}}{RT_{ref peak} - RT_{unretained}}$$

Relative window—See Search window.

Replicates—See Calibration replicates.

Replot—A printed chromatogram that reflects the analysis of a data file. It can be labeled with peak retention times, baselines, component names, and timed event symbols. The X and Y axes are marked with a user-entered label, and header information appears at the top of the page.

Resolved peak—See Baseline type.

Response ratio—See Internal standard (ISTD) response ratio.
**Response value**—The Y-axis value of a data point. For a peak, the response is its area and/or height.

**Retention reference component**—See Reference component.

**Retention time (RT)**—In an analysis report, this is the actual elution time of the peak (in minutes), as measured from the start of the run. For a component in the calibration section of the method, this is the expected elution time of the peak.

**RMS noise**—A measure of average noise, calculated as the root mean square value, in the processed region.

**Sample volume**—The actual amount of calibration standard or sample withdrawn from the vial for injection. In external standard analyses, this value is used to correct peak area or height values if the actual sample volume differs from the default value defined in the calibration section of the method. This parameter is applied to both standard and unknown samples. If no correction is required, the default value of 1.0 can be left unchanged.

**Scale**—The height (in mV) of the plot window.

**Scale factor**—A factor used to change the default scaling of a replot, which sets the largest peak to full scale. The new full scale value is the default scale divided by the scale factor. Thus, if the scale factor is greater than 1, the plotted peaks increase in size; if the scale factor is less than one, the peaks are plotted smaller.

**Search window**—The time tolerance before and after the expected retention time of a component. A peak whose retention time falls within this tolerance can be identified as that component. This allows components to be identified despite small variations in retention time from run to run. The search window is constructed as the sum of two parts:

- **Absolute window** — A time period, expressed in seconds, before and after the expected retention time of the component. The absolute part of the search window can be used to compensate for shifts in the chromatogram that affect all peaks alike. If you expect the retention time for a component to vary by ±5 seconds, you would assign an absolute window of 5 seconds to the component.

- **Relative window** — The relative part of the search window, expressed as a percentage of the component’s expected retention time, causes the window width to increase as the retention time of the component increases. This helps compensate for the greater uncertainty that frequently occurs for peaks eluting later in the run. If you expect the peaks produced by an analysis to vary by ±5% of the retention time, you would assign a relative window of 5 to the component.

**Second-order polynomial curve**—See Curve fit type.

**Single-peak component**—See Component.
**Tangential skim**—Use of a straight baseline segment, rather than an exponential curve, when skimming minor (child) peaks off the trailing edge of a tailing major (parent) peak. A tangential skim is never created automatically by the system. It must be accomplished by a “T” timed event placed between the peak’s start and end points.

**Third-order polynomial curve**—See Curve fit type.

**Threshold values**—See Area threshold and Noise threshold.

**Timed event**—See Baseline timed events.

**Timed group**—See Component.

**Total amount**—A variable that can be used in custom expressions in the Report Format Editor. It equates to the sum of the adjusted amounts in the data set. For a single report, it is the sum for all peaks in the report.

**Total area**—A variable that can be used in custom expressions in the Report Format Editor. It equates to the sum of the peak areas in the data set. For a single report, it is the sum for all peaks in the report.

**Total height**—A variable that can be used in custom expressions in the Report Format Editor. It equates to the sum of the peak heights in the data set. For a single report, it is the sum for all peaks in the report.

**Unidentified peak**—A peak present in the chromatogram, but not matched to a component identified by name in the calibration section of the method.

**Unidentified peak quantitation**—The way in which unidentified peak amounts in the analysis may be calculated. The three ways to calculate this amount are:

- Component amounts are calculated based on the constant calibration factor you enter.
- Each unidentified peak is calculated using the same options as the nearest component, where the amounts are calculated as if the unidentified peak is the same as the component.
- Each unidentified peak is calculated using the same options as the nearest reference peak, where the amounts are calculated as if the unidentified peak is the same as the reference peak.

**Unknown peak**—See Unidentified peak.

**Unresolved peak**—See Baseline type.

**User program**—A program you develop or designate to use data from a file generated by the Data Analysis software. It can be run during or after data analysis.
**User value**—A numeric constant associated with a component in the method. Up to five user values may be defined for each component, for use in custom expressions.

**Valley point**—The lowest point between two unresolved (overlapped) peaks, as determined during peak detection. It can be either the ending point of the first peak, or the starting point of the second peak.

**Void time**—The elution time of an unretained peak. This is used in the calculation of k’ or corrected relative retention values.

**Weighting**—The weighting options in the analysis section of a file allow you to assign different significance (weight) to calibration points during the regression calculation, according to their amount or response values. Your selection determines the form of the weighting factor to be applied to the points of a calibration curve.

The options are:

1—No weighting (default option).

1/X—The reciprocal of a point’s amount value is used.

1/Y—The reciprocal of a point’s response value is used.

1/(X*X)—The reciprocal of the square of a point’s amount value is used.

1/(Y*Y)—The reciprocal of the square of a point’s response value is used.

See also Curve fit type and Fit type.
Index

A

A/D mV Range in report header 8-24
Absolute Scaling 6-28
Absolute window 7-20, 9-46
Absorbance Ratio report column not supported 8-13
Add Component command 7-16
Adjust Analysis Params command 6-4, 7-4
Adjust Analysis Plot command 9-4, 9-6
Adjust Report Format command 8-5
Adjusted Height Ratio 9-36, A-35
Adjusting parameters
  analysis (.MTH) 6-4, 7-4, 9-3
  calibration 7-4, 9-3
  in Graphic Method Editor 9-3
  in Report Format Editor 8-4
  in Text Method Editor 6-4, 7-4
  processing 6-4, 9-3
  report format (.RPT) 8-4
AIA Metafile not supported 8-27
Amount ratios
  converting to raw amounts A-86
  definition 7-12
Amount values
  definition 10-9
  prohibited 10-15
  solving for 10-20, A-86
Analysis
  see also Automated Analysis
  background 4-8
  batch 4-11
  in Control Panel 4-14
  in Graphic Method Editor 4-16
  in Group Analysis 4-11
  in Method Editor 4-9
  interactive 4-16
  of standards 4-27
  of unknowns 4-42
  overview 4-2
  preparing for 4-3
  reanalyzing a data file 4-16
  using group parameters 4-11
  using individual parameters 4-11
Analysis parameters (.MTH)
  see also Calibration parameters
  see also Graphic Method Editor
  see also Processing parameters
  see also Text Method Editor
  adjusting 6-4
  adjusting graphically 9-3
  copying from another file 4-4
  copying from GRO to MET 4-7, 4-40
  default file 6-10, 7-8
  definition 1-3, 1-6, 1-7, 9-2
  not saved as stand-alone files 1-9
  replacing 4-4, 4-6
Analysis Parameters file (.ANP) 1-13
Analysis reports see Report format parameters (.MTH)
Analytical method
  data files generated by 3-3
  description 3-2
  viewing data for 3-7
Analyzing data 4-1
ANP file see Analysis Parameters file (.ANP)
Append Row command 10-24
Applied Biosystems
  world wide web address xiv
Area Reject in report header 8-25
Area response 7-23
Area threshold  
and peak detection A-16  
definition A-8  
setting 6-13, 9-29  
timed event 6-16, A-18  
valid range 6-16  
Area, see Peak area  
Asymmetry calculation 5-12  
AT timed event, see Area threshold timed event  
Audit Trail not supported 6-9  
Automated Analysis  
AFC 2000 3-2  
analytical method 3-2, 3-7  
crude samples 3-5  
data files (.B* and .B##) 3-3, 3-4  
definition 3-2  
file naming 3-9  
fraction information in file titles 3-10  
fractionated samples 3-7  
group files (.GRO) 3-4, 3-6  
preparative method 3-2, 3-5  
process flowchart 3-3  
using multi-methods with 3-6  
using templates with 3-6  
viewing results 3-5  
Autosampler in report header 8-24  
Autoscaling, chromatograms 6-23  
Auto-Zero Plot Offset 6-28  
Average calibration factor 7-33, 7-48, A-74  
drawing manually 9-37  
drift (slope) 9-30  
Events command 9-27  
forcing A-25  
forcing to point A-42  
horizontal backward A-49  
horizontal forward A-45  
intercept 9-30  
penetrations A-29  
printing 2-24  
RMS noise, displaying 9-30  
subtracting 2-28  
theoretical, repositioning A-44  
Timed Events command 6-15  
valley-to-valley A-40  
Baseline to Point timed event A-42  
Batch analyzing 4-11  
Batch Reprocess window not supported 1-16  
BF timed event, see Bunching Factor timed event  
BioCAD menu 5-17  
BL timed event, see Baseline to Point timed event  
Blank column in reports 8-14  
Blend Values at Peak fields 5-10  
Bunched data points, displaying 9-13  
Bunching Factor  
and peak detection A-16  
definition A-5  
setting 6-12, 9-31  
timed event 6-16, A-17  
valid range 6-16  
Calculations  
asymmetry 5-12  
peak width 5-12  
plate count 5-12  
Calib Method in report header 8-25
Calibrate command 7-62
Calibrate dialog box 9-60
Calibration
  by reference 7-49
  commands, overview 9-39
  component 7-16, 7-49
  components, controlling 9-39
  components, overview A-61
  defaults, setting 7-8, 7-32
  definition A-61
  external standard 7-12, A-67
  external vs internal standard A-67
  factor 7-14, 7-24, A-74, A-84
  internal standard 7-12, 7-23, A-69
  manual 7-61
  overview A-61
  parameters
    entering 7-4
    reference A-84
    standard, options 7-12
    types 7-24, 7-46, 9-48
    updating 7-61, 9-60, A-71
Calibration curves
  see also Fit Analysis
  areas, generating 4-13
  changing display of 10-11
  changing fit parameters 10-14
  component amounts,
    determining A-78
  computing, overview A-72
  copying from another method 4-4
  copying from group file 4-6, 4-7, 4-40
  creating 7-24
  defining 7-51
  defining scaling limits for 10-11
  displaying information in Fit Analysis 10-19
  experimenting with different settings, see Fit Analysis
  fit types 7-50, 10-17, A-78
  fitting and weighting 10-16
  generating 4-21
  labels, changing 10-12
  levels, entering 4-30
  limits, setting in Fit Analysis 10-11
  negative amounts A-83
  outliers 7-11, 7-14
  overview 10-9, A-63
  parameters 7-25, 7-35, 7-49
  plotting 10-2
  printing and plotting 10-27
  result files for 4-13
  scaling factor 7-26, A-85
  viewing in Fit Analysis 10-9
  weighting 7-27
Calibration data
  copying 10-28
  editing 10-24
Calibration levels
  adding 7-37, 7-52
  changing 7-52
  definition 7-37
  deleting 7-52
  guidelines 7-37, 7-51
  overview 7-51, A-62
Calibration menu 9-39
Calibration parameters
  adjusting 7-4, 9-3
  changing for a range of components 7-60
  component, see Component curve fit type 7-26, 10-17
  definition 1-3, 7-2, 7-3, 9-2
  global 7-9, 7-13
  printing 9-66
  regression weighting 10-18
  reject outliers 7-11
  replacing 4-4, 4-6, 7-3
  scaling 7-26
  setting 7-46
  types 7-3
  weighting 7-27
Calibration replicates
  definition 7-61
  deleting 7-64
  excluding 7-64
Capacity factor 5-9, 7-10
Category, in Microsoft Excel 5-21
CB timed event, see Common Baseline timed event
Cell values, duplicating 10-26
Certificates of analysis
  obtaining B-8
Change Calibration Info command 7-58
Change Component Info command 7-58
Change Scaling command 10-15
Change Scaling dialog box 10-15
Channel A, B, C 1-13
Chart types in Excel
  chromatogram 5-25
  column/line (bar) 5-21
  modifying 5-28
  XY 5-18
Charted variable, in Microsoft Excel 5-21
Chromatograms
  autoscaling 6-23
  axes settings 2-20
  baseline subtraction 2-28
  bunched data points, displaying 9-13
  changing display 2-14, 9-12, 9-13
  changing titles 2-23
  comparing 2-14
  copying to Clipboard 9-67
  displaying events 2-21
  displaying in Graphic Method Editor 4-16, 9-2, 9-10
  displaying in Group Analysis 2-14
  editing scaling parameters 9-15
  expanding 9-16
  exporting 5-13
  opening in Excel 5-25
  plot scale, changing 9-15
  plotting exported 5-25
  plotting in Excel 5-25
  printing 2-24, 9-61
  raw data points, displaying 9-13
  reducing 9-16
  reference, see Reference chromatogram
  rescaling 6-23
  viewing 2-14
  viewing after Automated Analysis 3-5, 3-7
  working 9-10
  zooming 2-22, 9-16
Chromatograms, comparing
  overlay mode 2-16
  stacked 2-18
  tiled mode 2-14
Clipboard, copying chromatograms to 9-67
Column efficiency 5-12
Column Information dialog box 8-14
Column Information fields 5-7
Column/line chart 5-21
Columns, report
  adding 8-13
  blank 8-14
  columns not supported 8-13
  custom expression 8-14
  deleting 8-15
  editing 8-16
  moving 8-17
  types 8-13
Commands not supported
  Graphic Method Editor 9-9
  Report Format Editor 8-9
  Text Method Editor 6-10, 7-8
Common Baseline timed event A-38
Comparing chromatograms
  overlay mode 2-16
  stacked mode 2-18
  tiled mode 2-14
Component
  adding 7-39, 7-42
  amounts
    calculating 7-24, 7-46
    calculating initial A-78
    determining unknown 7-51
    not printed in reports 4-39
    calibrating by reference 7-24, 7-49
    calibrating, overview A-61, A-67
    changing several simultaneously 7-58
    defaults, customizing 7-28
    deleting 7-57
    editing 7-39, 7-53, 9-42, 9-43, 9-45
    identification
      adding component information to
        method 7-42
      defaults, entering 7-31
      definition A-59
      optimizing A-60
    identifying 7-42
    information
      adding/editing 7-40, 9-45
      changing 7-58, 9-42
      not printed in reports 4-37
    internal standard 7-23
    lists
      adding a peak component to 7-43
      adding named group to 7-44
      adding timed group to 7-45
      creating 9-40
      definition 9-40
      merging with peak list 9-41
    loading from files 7-54
    matching peak(s) 7-16
    merging 7-54, 7-56
    names, form of 9-41
    parameters, overview 7-3, 7-15
    peak, setting as default type 7-31
    reference 7-21
    search window 7-20
    selecting multiple 7-44
    setting identification defaults 7-31
    types
      named group 7-18, 9-50
      overview 7-42
      single-peak 7-17
      timed group 7-19, 9-50
Component Defaults dialog box 7-15, 7-28, 7-33
Component List command 10-8
Component List dialog box 10-6, 10-8
Component List window 6-6, 7-6, 7-15
Components dialog box 4-30, 7-15, 7-28, 7-39, 7-42, 7-49, 7-64
Conductivity monitor
  displaying signal 2-14
  monitoring fluctuations 2-17
  printing signal 2-24
Configuration (.CFG), copying from
  GRO to MET 4-7, 4-41
Connect2 not supported 1-17
Constant calibration factors 7-33, 7-46
Control Panel
  accessing Data Analysis module
    from 1-10
  analyzing from 4-14
  changes in version 3.0 software 1-14
  printing reports from 4-14
Conventions xiii
Copy To Clipboard command
  in Fit Analysis, not supported 10-28
  in Graphic Method Editor 9-67
Correct amounts during calibration not supported 7-11
Crude samples, viewing results for 3-5
Cubic curve A-82
Curve Info command 10-19
Curve Information dialog box 10-19
Curves, calibration see Calibration curves
Custom expressions
  adding to report 8-14
  creating 8-18
  definition 8-18
  dialog box 8-21
  Editor dialog box 8-20
  example 8-18
  guidelines 8-19
  multiple 8-22
  overview 8-18
Customer training, information B-10
Customized component defaults 7-28
Customizing windows in Group Analysis 2-20
Cycle in report header 8-25

Data Acquisition Time in report header 8-24
Data Analysis
  definition A-2
  overview A-3
  software, parts of 1-2
Data Analysis module
  accessing 1-14
  accessing from Control Panel 1-10
  accessing from Group Analysis 1-12
  accessing from Method Editor 1-11
  ANP file not supported 1-13
  differences from Turbochrom 1-16
  old version, using 1-14
  opening files in 1-9
  overview 1-3, 1-10
  restrictions 1-9
  temporary files 1-8, 1-13
  version 3.0 changes 1-13
Data channels
  A, B, C 1-13
  exported from Group Analysis 5-3, 5-13
  in version 3.0 software 1-13
  number of channels viewable 1-13
  selecting 6-5
Data files (.B*)
  adding to a group file 2-12
  adjusting calibration parameters 7-4
  adjusting processing parameters 6-4
  adjusting report format parameters 8-5
  analyzing 1-15, 4-2
  Automated Analysis 3-2
  cannot open in Data Analysis 1-14
  contents 1-5, 1-7
  deleting from a group file 2-13
  error codes for 2-27
  event log for 2-27
  exporting to Excel 5-3
  naming conventions, Automated Analysis 3-9
  opening 1-9, 1-14
  replacing parameters 4-4, 4-6, 4-41
  samples shipped with system 2-3
  selecting in a group file 2-10
  unselecting in a group file 2-11
  updating for version 3.0 1-14
  viewing after Automated Analysis 3-5, 3-7
  viewing method for 2-25
Data files, Automated Analysis
  file name nomenclature 3-9
  title nomenclature 3-10
  types generated 3-4
  viewing analytical 3-7
  viewing preparative 3-5
Data List command 10-22, 10-24
Data List dialog box 10-22, 10-26
Data List spreadsheet
  appending rows 10-24
  copying rows 10-25
  deleting rows 10-25
  editing data 10-24
  entering repeating values 10-26
  inserting rows 10-24
  overview 10-22
Data rate
  of exported chromatograms 5-13
  reported as Sampling Rate 8-24
Data reprocessing 9-28
Default
  analysis parameters 6-10, 7-8
  chromatogram titles 2-23
  component information, setting 7-28
  report format parameters 8-9
DEFAULT.MTH 6-10, 7-8
DEFAULT.RPT 8-9
Delay Time in report header 8-24
Delete All Components command 7-57
Delete Column 8-15
Delete Component command 7-57
Delete Events command 9-27
Detection, see Peak detection
DIF files 5-17
Dilution Factor in report header 8-25
Display Settings dialog box 2-21
Documentation feature not supported 6-9
Duplicate Columns dialog box 8-22

Edit Chart Title dialog box 2-23
Edit Components command 7-16, 7-39, 7-64, 9-42, 9-45, 9-49, 9-51
Edit Components dialog box 9-42, 9-44
Efficiency, column 5-12
E-mail address, Technical Publications xiv
End Peak Now timed event A-51
End Time in report header 8-25
End-of-Peak Detection timed event A-23
Equations
  adjusting expected retention times 7-21
  amount scaling A-72
  first order (linear) curve fit A-81
  k' value 7-10
  relative retention value 7-10
  search window, total size of 7-20
  second order (quadratic) curve fit A-81
  third order (cubic) curve fit A-82
Error log, see Event log
Error messages
  insufficient calibration information 10-7
Event log
  displaying 2-27
  printing 2-27
Events, see Timed events
Examples
  baseline penetrated by chromatogram valley A-29
  calibration level names A-64
  chromatogram plots 9-13
  custom expressions 8-18
  data file name 1-8
  distance between peaks exceeds noise threshold A-7
  external standard calibration curve A-68

E timed event, see End Peak Now timed event
internal standard calibration curve A-69
peak detection timed event, effect of A-19
relationship of noise threshold to peak detection A-7
timed events
  effect of -N and +N A-20
  retention time and user forced peak A-25
unrepresented components A-65
Excel, see Microsoft Excel
Exponential skim
  algorithm A-37
  automatic A-32
  criteria 6-13, A-33
  forcing A-55
  preventing A-56
  timed event A-55, A-56
Export Chromatogram dialog box 5-14
Exporting
  chromatograms 5-13
  data channels exported 5-3, 5-13
  data files 5-3
  from Group Analysis 5-3
  group of data files 5-3
  location of files 5-6
  overview 5-2
  results exported 5-7
  selecting fields to export 5-5
  to Microsoft Excel 5-3
Extensions see File names and extensions 1-4
External standard
  calibration 10-14, A-67
  definition 7-12
File names and conventions
  see also Method files (.MET)
  see also Data files (.B*)
  see also Group files (.GRO)
  overview 1-8
File names and extensions augmented 1-8
  Automated Analysis 3-9
  examples 1-8
  in Graphic Method Editor 4-19, 9-5, 9-7
  in Report Format Editor 8-6
  in Text Method Editor 6-5, 7-5
  overview 1-4, 1-8
  temporary 1-8, 1-13
File structure overview 1-4
File/Level/Type list 7-63
Fill Down command 10-26
First order fit type 7-26, A-81
Fit Analysis
  see also Fit parameters
  amount 10-20
  calibration curve, changing 10-11
  calibration curve, viewing 10-3, 10-9
  Copy To Clipboard command not supported 10-28
  data list 10-22
  fit type 10-16
  labels, changing 10-12
  menus 10-8
  menus and commands 10-8
  opening 10-3
  overview 10-2
  printing 10-27
  response 10-20
  status bar 10-8
  weighting 10-18
  window 1-3, 10-7
Fit Analysis command 10-6
Fit parameters
   changing 10-14
   overview 10-14
   selecting 7-25
Flow Rate Information fields 5-8
Fluctuations, monitoring 2-17
Footer, report 8-11
For Amount command 10-20
For Response command 10-21
Force Baseline to Point timed event A-42
Fractionated samples, viewing results for 3-7

G
Global calibration parameters
   editing 7-13
   options 7-12
   overview 7-9
Global Information command 7-13
Global Information dialog box 7-9, 7-13
Gradient, monitoring reproducibility 2-17
Graphic editing 9-2
Graphic Method Editor
   see also Timed events
   accessing 4-17, 9-3
   adjusting parameters 4-16, 9-3
   analyzing 4-16
   calibration commands 9-39
   chromatogram, expanding 9-17
   commands not supported 9-9
   component groups 9-50
   component information 9-39
   copy to clipboard 9-67
   display options 9-12
   file name in Status bar 4-19, 9-5, 9-7
   file name in Title bar 4-19, 9-5, 9-7
   menus and commands 9-10, 9-11
   overview 1-3, 9-2, 9-10
   plot scale, changing 9-15
   printing report from 9-64
   reanalyzing data 4-16, 9-49
   search windows 9-57
   timed event codes 6-16
   timed events, setting 9-24
GRO files, see Group files (.GRO)
Group Analysis
   accessing Data Analysis module from 1-12
   analyzing from 4-11
   baseline subtraction 2-28
   changes in version 3.0 software 1-14
   changing chromatogram titles 2-23
   comparing chromatograms 2-14
   creating group files 2-11
   customizing window 2-20
   determining files analyzed 4-13
   display colors 2-14, 2-16, 2-18
   editing group files 2-13
   examining multi-methods 2-5
   examining templates 2-4
   exporting a chromatogram 5-13
   exporting chromatograms 5-13
   exporting data files 5-3
   group analysis 4-11
   Group Subtract 2-28
   individual analysis 4-11
   number of files displayed 2-12
   opening 2-6
   opening group files 2-6
   overlay mode 2-16
   overview 1-2, 1-10, 2-2
   printing from 2-24
   stacked mode 2-18
   subtracting baseline 2-28
   tiled mode 2-14
   using 2-20
   viewing Automated Analysis data 3-5, 3-6
   viewing Event log 2-27
viewing method 2-25  
zooming 2-22  
Group files (.GRO)  
  adding data files automatically 2-3, 2-9  
  adding data files manually 2-3, 2-11, 2-12, 2-13  
  adjusting calibration parameters 7-4  
  adjusting processing parameters 6-4  
  adjusting report format parameters 8-5  
contents 2-3  
copying parameters to MET file 4-7  
creating 2-3, 2-11  
deleting data files from 2-13  
editing 2-13  
generated by Automated Analysis 3-4, 3-5  
in Group Analysis 2-3  
maximum number allowed 2-12  
number displayed 2-12  
opening 1-9, 2-6, 4-11  
replacing parameters 4-4  
samples shipped with system 2-3  
saving CFG and MET information to stand-alone MET 4-40  
selecting data files in 2-10  
viewing after Automated Analysis 3-4, 3-6  
Group Subtract 2-28  
Group window marker 9-54  

H  
Header dialog box 8-11  
Header, report  
  creating 8-11  
  fields blank 8-24  
  fields contain erroneous information 8-24  
fields not supported 8-24  
information included in 8-24  
viewing information 9-63  
Height response 7-23  
HF timed event, see Horizontal Baseline timed event  
Hiding reference chromatogram 9-23  
Hints  
  monitoring fluctuations in signals 2-17  
  selecting files in groups 2-11, 2-13  
  selecting multiple items in Excel 5-19  
  zooming in Group Analysis 2-22  
Horizontal Baseline timed event  
  backward A-49  
  forward A-45  
How to use this guide xi  
HR timed event, see Horizontal Baseline timed event  

I  
I timed event, see End-of-Peak Detection timed event  
Identify Peaks Before Calibrating not supported 4-34  
Identifying components, see Components, identifying  
Insert Row command 10-24  
Inst Method in report header 8-25  
Instrument Name in report header 8-24  
Instrument Parameters not supported in method printing 9-66  
Instrument Serial # in report header 8-24  
INTEGRAL menu 5-17
Integration
  algorithms different in version 3.0 software 1-15
  and timed events A-38
  manual timed event A-55
  overview A-28
  parameters 6-11
  timed events, see Timed events
Integration command 6-11, 6-12
Internal standard
  calibration 7-12, 10-14, A-69
ISTD see Internal standard

K
  k' 5-9, 7-10

L
  Labels command 10-12
  Labels dialog box 10-13
  Lambda Max report column not supported 8-13
  Levels, adding calibration 7-52
  Limits command 10-11
  Limits dialog box 10-11
  LIMS not supported 1-17
  Line chart 5-23
  Linear curve A-81
  LINK not supported 1-17
  LM timed event, see Locate Maximum timed event
  Load from Method File dialog box 7-55
  Load From Peak List command 9-40
  Load/Method File command 7-55
  Loading components from files 7-54
  Locate Maximum timed event A-24
  Lock zoom 2-22

M
  M timed event, see Manual Integration timed event
  Macros in Microsoft Excel 5-17
  Manual calibration 7-61
  Manual Calibration dialog box 4-32, 7-62
  Manual Integration timed event A-55
  Mathematical operations in reports 8-18
  Merge command 7-54
  Merge From Peak List command 9-40, 9-41
  Merging components from files 7-54
  MET files see Method files (.MET)
  Metafile not supported 8-27
  Method
    analytical 3-2, 3-7
    name in report header 8-24
    preparative 3-2, 3-5
    viewing from Group Analysis 2-25
  Method Editor
    accessing Data Analysis module from 1-11
    analyzing from 4-9
    changes in version 3.0 software 1-14
  Method files (.MET)
    adjusting calibration parameters 7-4
    adjusting processing parameters 6-4
    adjusting report format parameters 8-5
    contents 1-5, 1-6
    creating from a group file 4-7, 4-40
    opening 1-9
    replacing parameters 4-4
    to acquire unknowns 4-40
    viewing from Group Analysis 2-25
Method Summary window 6-6
Microsoft Excel
   availability from Applied Biosystems 5-2
   bar chart 5-21
   blank worksheet 5-15
   chromatogram chart 5-25
   column/line chart 5-21
   example 5-29
   exporting data files to 5-3
   location of exported files 5-6
   macros 5-17
   modifying charts 5-28
   plotting 5-18
   using 5-15
   version required 5-2
   XY chart 5-18
Mobility report column not supported 8-13
Monitor Values at Peak fields 5-11
Move Column command 8-17
Move Column dialog box 8-17
MSDSs, obtaining B-8
MTH see Analysis parameters (.MTH)
Multi-method
   data files generated by Automated Analysis 3-4
   using Group Analysis to examine 2-4, 2-5
   using to acquire standards 4-22
   viewing Automated Analysis data 3-6

N
N timed event, see Negative Peak Detection timed event
Named Group command 9-51
Named group components
   adding to component list 7-44
   creating and editing 9-51

O
Offsets, preventing 7-50
Open a Group to Analyze dialog box 3-8
Open dialog box 4-17, 9-4
Opening data files (.B*) 1-9, 1-14
Operator in report header 8-24
Optimizing method 2-4, 2-5
Optional Reports command 6-19
Origin options 7-27
Outliers, rejecting during calibration 7-11
Overlapped
   peaks A-15
   search windows A-59
Overlay mode 2-16

P
P timed event, see Peak Detection timed event
Parameters
   see Analysis parameters (.MTH)
   see Calibration parameters
   see Component parameters
   see Fit parameters
   see Peak detection parameters
   see Peak integration parameters
   see Processing parameters
   see Replot parameters
   see Report format parameters (.RPT)
   see Scaling parameters
Paste Rows command 10-25
Peak
   area, determining A-31
   asymmetry 5-12
   components
      adding 7-43, 9-45
      editing 9-45
      setting as default type 7-31
   detection, see Peak detection
   forcing daughter A-25
   height ratio 9-36, A-34
   heights, calculating A-58
   information exported 5-5
   integration parameters 6-8, 6-11
   list, definition 9-40
   list, merging 9-41
   merging list with component list 9-41
   naming unidentified 9-41
   overlapped A-15
   preventing undetected A-47
   quantitating unidentified A-87
   re-identifying 9-49
   relationship to search window 7-20
   retention times
      calculating A-58
      compensating for shifts in 7-21
   selecting for identification 9-39
   separation 6-13, A-15
   table, printing 9-63
   width calculation 5-12
   width, displaying 9-33
Peak Area Information fields 5-11
Peak detection
   see also Timed events
   and timed events A-16
   disabling A-18
   enable/disable A-18
   negative A-20
   parameter overview A-5
   parameters, adjusting 6-11
   parameters, list of 6-8
   sensitivity, increasing A-17, A-18
   stages in A-10
Peak Detection timed event
   Enable/Disable A-18
   End-of-Peak A-23
   Negative Peak A-20
   Peak End A-51
   Peak Start A-53
Peak Height Ratio 9-36, A-34
Peak Identification fields 5-9
Peak Info 5-5
Peak Library Search report column not supported 8-13
Peak Purity Index report column not supported 8-13
Peak Retention Information fields 5-9
Peak Separation/Expo Skim dialog box 9-35
Peak Width Information fields 5-12
pH monitor
displaying signal 2-14
monitoring fluctuations 2-17
printing signal 2-24
Plate count 5-12
Plates/m 5-12
Plot
display, changing 9-13
labels, changing 10-12
printing 9-64
scale
methods of calculating 10-11
selecting 6-26
settings for reports 6-21
Plot Settings dialog box 6-21
Plotting data 5-18, 9-13
Point-to-Point fit 7-26, A-78
Preface xi
Preparative method
data files generated by 3-3
description 3-2
viewing multi-method or template 3-6
viewing single run 3-5
Pressure trace
displaying 2-14
printing 2-24
Previous Component command 10-8
Print Options dialog box 9-64, 9-66
Printing
calibration curves from Fit Analysis 10-27
calibration parameters 9-66
chromatograms 2-24
chromatograms with baselines 2-24, 9-61
Event log 2-27
from Control Panel 4-14
in Group Analysis 2-24
optional reports 6-19
options for reports 8-23
peak table 9-63
processing parameters 9-66
processing parameters, instrument parameters not supported 9-66
quantitation 4-43, 4-44, 4-47
replot 6-23
report format file content 8-28
reports 2-24, 9-64
reports after analyzing 4-11
reports automatically after a run 4-9
reports with results and chromatogram on one page 8-28
reports without chromatogram 6-24
results 9-63
selecting optional reports for 6-19
Proc Method in report header 8-25
Process dialog box 6-7, 6-15, 6-19
Baseline Timed Events tab 6-15
Integration tab 6-7, 6-12
Optional Reports tab 6-20
Replot tab 6-24
User Programs tab 6-30
Processing parameters
adjusting 6-4, 9-3, 9-24
adjusting for calibration 4-24
definition 1-3, 6-2, 6-3, 9-2
entering in method 6-7
in report header 8-25
instrument parameters not supported 9-66
overview 6-3
printing 9-66
replacing 4-4, 4-6, 6-3

Q

Quadratic curve A-81
Quantitation
  after calibration curves
  generated 4-42
  automatic 4-43
  before calibration curves
  generated 4-45
  component parameters 7-15
  creating method for 4-40
  general procedure 4-22
  manual 4-43
  overview A-76
  printing 4-43, 4-44, 4-47
  unidentified peaks 7-11, A-87
  units parameter, definition 7-10
  unknowns 4-21, 4-42

R

Rack/Vial in report header 8-24
Ratios
  Adjusted Height 9-36, A-35
  Amount 7-12
  Peak Height 9-36, A-34
  Response 7-12
  Valley Height 9-36, A-36
  Valley-To-Peak 9-35
  Valley-to-Peak A-15
  Width 9-35, A-15
Raw Data File in report header 8-25
Raw data points, displaying 9-13
RAW file
  definition 4-19
  displayed 9-5, 9-7
  not saved as stand-alone files 1-9
  Red search window, significance of 9-48
  Reference calibration A-84
  Reference chromatogram
    defined 9-10
    hiding 9-23
    manipulating 9-22
    reducing 9-21
    showing 9-23
  Reference Chromatogram command 9-10
  Reference components
    calibrating by 7-34, 7-49
    overview 7-21
  Regression calculations 10-16
  Re-Identify command 9-49
  Reject outliers during calibration 7-11
  Related documents xiv
  Relative window 7-20, 9-46
  Renaming chromatograms 2-23
  Replace Analysis/Report Format dialog box 4-5
  Replacing parameters 4-4, 4-6
  Replicates
    definition A-61
    dialog box 7-64
    excluding 7-64
    rejecting outliers 7-11
  Replot parameters
    defined 6-8
    editing 6-23
  Report Format Editor
    accessing 8-5
    adjusting parameters 8-4
    commands not supported 8-9
    file name in title bar 8-6
    menus and commands 8-4
    opening data files in 8-9
    overview 1-3, 8-4
  Report Format Options dialog box 8-23
Report format parameters (.RPT)
  adjusting 8-4
  columns 8-12
  copying from another file 4-4
  custom expressions 8-18
  default file 8-9
  default, editing 8-9
  definition 1-3, 1-6, 1-7, 8-2, 8-3
  designing, general procedure 8-5
  headers and footers 8-10
  not saved as stand-alone files 1-9
  options 8-23
  overview 8-3
  printing content of file 8-28
  replacing 4-4, 4-6, 8-3
  stand-alone files for optional reports 8-3
  title 8-10

Report Information window
  illustrated 9-62
  opening 9-61
  printing from 9-64

Reports
  amount does not print 4-39
  blank column 8-14
  chromatogram 2-24
  chromatogram, printing on same page as results 8-28
  chromatogram, suppressing printing 6-24
  columns not supported 8-13
  component information does not print 4-37
  header fields blank 8-24
  header fields contain erroneous information 8-24
  header fields not supported 8-24
  method (.MET) name in header 8-24
  optional 6-8, 6-19
  printing 2-24
  printing after analyzing 4-11
  printing after analyzing from
    Control Panel 4-14
    printing automatically after a run 4-9
    printing from Group Analysis 2-24
    setting up 8-4

Reprocess Results window not supported 1-16

Rescale Plot dialog box 9-5, 9-7, 9-15

Response
  methods of plotting 10-14
  ratios, definition 7-12
  values
    definition 10-10
    solving for 10-20

Result File in report header 8-25

Results
  see also Results, viewing
different in version 3.0 software 1-15
  exported 5-7
  exporting 5-3
  printing 9-63

Results files (.RST)
  creating for a calibration curve 4-12, 4-15, 4-27
  nomenclature 4-13, 4-27
  storage location 4-13, 4-27

Results sections (.RST) of data files 1-7

Results, viewing
  analytical method 3-7
  Automated Analysis, multi-method
    or template 3-6
  Automated Analysis, single run 3-5
  chromatograms 2-24
  in Group Analysis 2-24, 3-5
  preparative method 3-5, 3-6

Retention time
  calculating A-58
  replacing A-71
shift, compensating for 7-21
timed event A-25
updating A-71
Retention volume 5-9
RMS noise, displaying 9-30
RPT see Report format parameters (.RPT)
RST see Results files (.RST)
see Results sections (.RST)
RT timed event, see Retention Time timed event
Run Identification fields 5-7
S
S timed event, see Start Peak timed event
Sample Amount in report header 8-24
Sample files 2-3
Sample Information fields 5-8
Sample Number in report header 8-24
Sample volume parameter 7-10
Sampling Rate contains data rate information in report header 8-24
not supported 9-33
Sampling Rate/Bunching Factor dialog box 9-33
Scaling alternative amount, overview A-72
chromatograms 6-23
factors 7-26, 10-14, 10-15
options 7-26, A-85
types 6-27, 7-26, A-85
Search window calculating total size 7-20
definition 7-20
displaying 9-57
overlapping a 7-21
overlapping, overview A-59
setting up 7-20
Second order fit type 7-26, A-81
Select Data Files to Analyze dialog box 2-10
Send Tagged Results to LIMS not supported 7-11
Sensitivity, increasing A-17
Sequence Editor not supported 1-16
Sequence File in report header 8-25
Series identifier 5-19, 5-22
Series, in Microsoft Excel 5-21
Single peak components, definition 7-17
Skims exponential A-55, A-56
tangential A-56
SM timed event, see Smooth timed event
Smooth timed event A-26
Software changes to version 3.0 1-13
differences from Turbochrom 1-16
overview 1-2, 1-10
version in report header 8-24
Solve For Amount dialog box 10-20
Solve For Response dialog box 10-21
Spectral Library Confirmation report column not supported 8-13
Spectral Standard Confirmation report column not supported 8-13
Spreadsheet Peak Field Selection dialog box 5-5
Spreadsheet Run Field Selection dialog box 5-4
Spreadsheeting, see Microsoft Excel
Stacked Bar chart 5-23
Stacked mode 2-18
Start Peak timed event A-53

Data Analysis Software User Guide Index-17
INDEX

Study in report header 8-24
Subtracting a baseline 2-28
Synchronize With Data Analysis not supported 6-31

T

T timed event, see Tangential Skim timed event
Tangential Skim timed event A-56
Technical documents, obtaining B-8
Technical support, contacting
   Eastern Asia, China, Oceania B-5
   Europe B-6
   Japan B-7
   Latin America B-7
   telephone or fax in North America B-3
Template, selecting for report 6-19
Templates
data files generated by Automated Analysis 3-4
   using Group Analysis to examine 2-4, 2-5
   viewing Automated Analysis data 3-6
Temporary files 1-8, 1-13
Text files
   commands for loading components 7-54
   creating from report 8-27
   T## created by exporting chromatogram 5-14, 5-25
Text Method Editor
   accessing 6-4, 7-4
   adjusting parameters 7-4
   analysis parameters, adjusting 6-4
   calibration parameters, adjusting 7-4
   commands not supported 6-10, 7-8
   file name in title bar 6-5, 7-5
   opening data files 6-10, 7-8
   overview 1-3, 6-2, 7-2
   see also Timed events 6-4
Third order fit type 7-26, A-82
Thresholds
   Area 9-29, A-8
   Noise 9-29, A-7
Tiled mode 2-14
Timed events
   adding 6-15
   Baseline Force to Point (BL) A-42
   Bunching Factor (BF) A-17
   codes 6-16
   Common Baseline (CB) A-38
   deleting 6-18, 9-27
   deleting baseline 9-27
   editing 6-18
   End Peak Now (E) A-51
   End-of-Peak (I) A-23
   Exponential Skim (X) A-55
   Horizontal Baseline Backward (HR) A-49
   Horizontal Baseline Forward (HF) A-45
   Locate Maximum (LM) A-24
   Manual Integration (M) A-55
   Negative Peak (N) A-20
   Noise threshold (NT) A-17
   Peak Detection Enable/Disable (P) A-18
   Retention Time (RT) A-25
   setting 9-24
   setting graphically 9-24
   Smooth (SM) A-26
   Start Peak (S) A-53
   Tangential Skim (T) A-56
   User Forced (UF) A-25
   Valley-to-Valley Baseline (V) A-40
   values 6-16
Timed group components
- adding to component list 7-45
- creating 9-54
- defaults 7-32
- definition 7-19, 9-50
- editing 9-54
Title dialog box 8-10
Title, report 8-10
Turbochrom software 1-3, 1-16
Type menu command 9-44

U
- UF timed event, see User Forced timed event
- Unidentified peak quantitation options 7-11
- Unknowns, see Quantitation
- Update calibration, see Calibration, updating
- User Forced timed event A-25
- User Programs, running during data analysis 6-29
- User# in report header 8-25

V
- V timed event, see Valley-to-Valley Baseline timed event
- Valley Height Ratio 9-36, A-36
- Valley-to-Peak Ratio 9-35, A-15
- Valley-to-Valley Baseline timed event A-40
- Vertical Scaling 6-27
- Viewing results, see Results
- VISION menu 5-17
- Void time 7-10
- Voltage +/- Range report column not supported 8-13

Volume Injected in report header 8-24
Volume units parameter, definition 7-10

W
- Weighting factor definition 7-27
  options 7-27
  selecting 10-16
- Width Ratio 9-35, A-15
- Width, peak, calculation 5-12
- Wildcards 2-12
- Window
  - see Absolute window
  - see Relative window
  - see Report Information window
  - see Search window
- WK* files 5-17
- Working chromatogram
  - defined 9-10
  - reducing 9-21
- World wide web address, Applied Biosystems Biosystems xiv

X
- X timed event, see Exponential Skim timed event
- XY chart 5-18
- XY Plot dialog box 5-19

Z
- Zooming
- Graphic Method Editor 9-16
- Group Analysis 2-22
Headquarters
850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free (In North America): +1 800.345.5224
Fax: +1 650.638.5884

Worldwide Sales and Support
Applied Biosystems vast distribution and service network, composed of highly trained support and applications personnel, reaches into 150 countries on six continents. For sales office locations and technical support, please call our local office or refer to our web site at www.appliedbiosystems.com or to the Technical Support and Training appendix in this document.

www.appliedbiosystems.com

Applied Corporation is committed to providing the world’s leading technology and information for life scientists. Applied Corporation consists of the Applied Biosystems and Celera Genomics businesses.

Printed in the USA, 06/2001
Part Number 602309-02 Rev. A

an Applied business